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In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer 
hacking.

WARNING: 

This equipment will be inoperable when mains power fails.

IMPORTANT: 

1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 
or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.
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Preface

Thank you for purchasing the DocuPrint CM215 series.

This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the print, copy, scan, and fax functions.

Please read this guide to achieve the best performance from this printer.

This guide assumes you are familiar with computers and the basics of network operation and 
configuration.

After reading this guide, keep it safe and handy for future reference.

Fuji Xerox Co., Ltd.
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Types of Manuals

Paper Manuals

Manuals Included on the Software Pack CD-ROM

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer 
including the initial settings of the Fax and Scan functions. (The fax 
feature is available only on the DocuPrint CM215 f/CM215 fw.)

Also describes how to setup wireless network. (Wireless LAN function is 
available only on the DocuPrint CM215 fw.)

Lifting Your Printer Describes how to lift and hold your printer.

User Guide (this guide) Describes how to get ready to print and set various features. It also 
covers the operator panel menus, troubleshooting tips, and 
maintenance information.

Troubleshooting Guide Describes the troubleshooting tips for printer problems such as paper 
jams.

This guide can be opened from the Launcher.

Product Features Describes the product features.

This guide can be opened from the installer.

Show Me How Describes the error recovery procedures for the printer.

This can be opened from the SimpleMonitor.
Types of Manuals 13



Using This Guide

This section describes the organization and conventions of this manual.

Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and how to turn on the printer.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and 
Software Installation

Describes the basic information about how to connect the printer to 
your computer and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Copying Describes how to copy documents and the adjustment features.

7 Scanning Describes how to set and use the Scan features.

8 Faxing (DocuPrint CM215 
f/CM215 fw Only)

Describes how to set and use the Fax features. The Fax features are 
available only on the DocuPrint CM215 f/CM215 fw.

9 Using the Operator Panel 
Menus and Keypad

Describes the setting items available on the operator panel, their 
setup procedures, and how to use the numeric keypad.

10Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

11 Maintenance Describes how to clean the printer, how to replace toner cartridges, 
and how to see the printer status.

12Contacting Fuji Xerox Describes support information.
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Conventions
• In this guide, personal computers and workstations are collectively called “computers”.

• The following terms are used throughout this guide:

IMPORTANT: 

• Important information that must be read and followed.

NOTE: 

• Additional information that merits emphasis.

See also: 

• References within this guide.

• Orientation of documents or paper is described in this guide as follows:

, , Long Edge Feed (LEF): Loading the document or paper with the long edge into the 
machine as shown in the illustration below.

, , Short Edge Feed (SEF): Loading the document or paper with the short edge into the 
machine as shown in the illustration below.

• The screen shots and illustrations in this guide are those of the DocuPrint CM215 fw unless there 
is a note. Some of the items in the screen shots and illustrations may not be displayed or 
available depending on your printer model.

• Some features are not available on some models.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
Using This Guide 15



Safety Notes

Before using this product, read “Safety Notes” carefully for safety use.

This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:

• Any unauthorized alteration including an addition of new functions or connection to external devices 
may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
16 Safety Notes



Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:

• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
Safety Notes 17



For the DocuPrint CM215 f/CM215 fw, switch off and unplug the product when it (i.e., fax 
function) is not used over weekends or long holidays.

Please note that it cannot receive fax message during switch-off.

Once a month, switch off this product and check if

• the power cord is plugged firmly into an electrical outlet;

• the plug is not excessively heated, rusted or bent;

• the plug and electrical outlet are free of dust; and

• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
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Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:

• Near radiators or any other heat sources

• Near volatile flammable materials such as curtains

• In the hot, humid, dusty or poorly ventilated environment

• In the place receiving direct sunlight

• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 15.0 Kg 
(DocuPrint CM215 f/CM215 fw) / 14.3 Kg (DocuPrint CM215 b). Otherwise, if tilted, the product 
may fall over and cause injuries.
Safety Notes 19



Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

DocuPrint CM215 f/CM215 fw:

DocuPrint CM215 b:

879 mm

702 mm

200 mm

200 mm

100 mm

100 mm

100 mm

114 mm

114 mm

937 mm

131 mm

848 mm

691 mm

200 mm

200 mm

100 mm

100 mm

100 mm

114 mm

114 mm

937 mm
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Others

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

The illustrations show the DocuPrint CM215 f/CM215 fw.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 

• Temperature: 10 – 32 °C

• Humidity: 10 – 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

10° 10°

10° 10°

Left

Front

Right

Back

Left

Front

Right

Back
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.

• The product emits smoke or its surface is unusually hot.

• The product emits unusual noise or odor.

• The power cord is cracked or worn down.

• A circuit breaker, fuse or any other safety device becomes activated.

• Any liquid is spilled into the product.

• The product is soaked in water.

• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not put any of the followings on the product:

• Liquid container such as flower vases or coffee cups

• Metal parts such as staples or clips

• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners 
to avoid catching fire and explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.

Do not attempt to remove a paper deeply jammed inside the product, particularly a paper 
wrapped around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. 
Switch off the product immediately and contact your local Fuji Xerox representative.
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Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.

Ventilate well during extended operation or mass copying. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room. 

Provide proper ventilation to ensure the comfortable and safe environment.
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Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge 
or toner bottle.

It may catch fire by electric sparks inside a vacuum cleaner and cause explosion.

Use a broom or a wet cloth to wipe off the spills.  If you spill a large volume of toner, contact 
your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water 
and consult a physician immediately.

When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be 
careful not to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes 
and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Warning and Caution Labels
Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" 
or "High Voltage" marks on.

The illustrations show the DocuPrint CM215 fw.
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Environment

• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 
cartridges and drums (photoreceptors) to make recycle parts, recycle materials or energy 
recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. 
Return them to your local Fuji Xerox representative.
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Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (UL, CB)
This product is certified by the following agency using the safety standards listed.

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. This 
product generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
product does cause harmful interference to radio or television reception, which can be 
determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between this product and the receiver.

• Connect this product into an outlet on a circuit different from that to which the receiver is 
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.

Agency Standard

TUV-Rheinland IEC60950-1:ed. 2
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Illegal Copies and Printouts

Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency

• Banknotes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
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Security Precautions for Using Wireless LAN 
Products

One of the advantages of wireless LAN is that connections are possible anywhere within the range of 
the radio waves. This is possible because instead of cables, wireless LAN uses radio waves to 
connect computers and wireless access points.

On the other hand, the radio waves get through obstructions (such as walls) within the range to reach 
every place, so the following problems may occur if security is not set up.

• Transmissions Can Be Accessed Covertly
It is possible for criminal outsiders to intentionally intercept the transmissions to covertly access the 
information in the transmissions.

• IDs, passwords, credit card numbers, and other personal information

• Content of mail

• Unauthorized Access
Criminal outsiders may access private or company networks without authorization to do the following.

• Steal personal or secret information (information leak)

• Impersonate someone and send false information (impersonation)

• Alter intercepted transmissions and distribute them (falsification)

• Infect computers with a virus to destroy data or systems (vandalism)

You can reduce the possibility of these problems by doing the setting up security for your wireless LAN 
product.

Wireless LAN cards and wireless access points conventionally have security arrangements to prevent 
these types of problems.

We recommend that customers fully understand the problem of using the product without security and 
that they determine to and take the responsibility for setting up security for their product.
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Product Features

This section describes the product features and indicates their links.

Manual Duplex Print

The Duplex print feature allows you to print two 
or more pages on the front and back sides of a 
single sheet of paper manually. This feature 
helps reduce paper consumption.

For more information, see "Manual Duplex 
Printing" on page 147.

N-Up (2-in-1 Copy)

The N-Up copy feature allows you to print 
multiple pages on a single sheet of paper. This 
feature helps reduce paper consumption.

For more information, see "N-Up" on page 186.

Scanning to a USB Storage Device

You do not need a computer to connect your 
USB storage device to save the scanned data. 
Insert your USB storage device in the port on 
the printer, and save the scanned data directly 
to your USB storage device.

For more information, see "Scanning to a USB 
Storage Device" on page 226.

Priority Sheet Inserter (PSI)

Print media loaded on the PSI is given 
precedence over those loaded on the 
multipurpose feeder (MPF). Using the PSI 
allows you to use other types or sizes of print 
media preferentially over the regular print media 
loaded on the MPF.

For more information, see "Loading Print Media 
in the Priority Sheet Inserter (PSI)" on 
page 142.
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Printing Through Wireless Connection 
(Wireless Print) (DocuPrint CM215 fw Only)

The Wireless LAN feature on your printer allows 
you to install the printer at any location, and 
enables printing without a wired connection to 
your computer.

The Wireless LAN feature is unavailable 
depending on the region you purchased.

For more information, see "Wireless Connection 
(DocuPrint CM215 fw Only)" on page 75.

Fuji Xerox Imaging Technology

This printer reproduces smooth lines and gradations by 1200 x 2400 dpi high-resolution LED print 
heads and Micro Accurate Control Screen (MACS) Technology.

In addition, the color registration of each toner is corrected  with ultra high precision through a 
digital process by Image Registration Control Technology (IReCT).

Conventional technology

Jagged line

Enhanced image

Smooth line
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may 
change without prior notice.

NOTE: 

• Some features are not available on some models.

This chapter includes:

• "Copy Function" on page 34

• "Print Function" on page 37

• "Scan Function" on page 38

• "Fax Function (DocuPrint CM215 f/CM215 fw Only)" on page 40

• "Direct Fax Function (DocuPrint CM215 f/CM215 fw Only)" on page 41
Specifications 33



Copy Function

Type Console

Memory 128 MB

HDD —

Color Capability Full color

Scanning Resolution DocuPrint CM215 f/CM215 fw:

Document glass: 600 × 600 dpi

Automatic document feeder: 600 × 300 dpi

DocuPrint CM215 b:

Document glass: 600 × 600 dpi

Printing Resolution Output resolution: 1200 × 2400 dpi

Data processing resolution: 600 × 600 dpi

Halftone/Printable Colors 256 color gradation for each color (16,700,000 colors)

Warm-up Time 31 seconds or less*
*: The values are based on a room temperature of 22 °C and on the factory 

default setting.

IMPORTANT: 
• It may take longer due to the image quality adjustment.

Original Paper Size DocuPrint CM215 f/CM215 fw:

Document glass: The maximum size is 215.9 × 297 mm for both 
sheets and books.

Automatic document feeder: The maximum size is 215.9 × 355.6 
mm.

DocuPrint CM215 b:

Document glass: The maximum size is 215.9 × 297 mm for both 
sheets and books.

Output Paper Size Multipurpose feeder:

Maximum: Legal

Minimum: 76.2 × 127 mm (3 × 5")

Priority sheet inserter:

Maximum: Legal

Minimum: 76.2 × 190.5 mm (3 × 7.5")

Image loss width: Top edge, 4 mm or less; bottom edge, 4 mm or 
less; left and right edges, 4 mm or less

Output Paper Weight Multipurpose feeder/Priority sheet inserter:

60 – 163 gsm

IMPORTANT: 
• Use paper recommended by Fuji Xerox. Copying may not be 

performed correctly depending on the conditions.

First Copy Output Time Monochrome: 24 seconds (for A4 /monochrome mode)

Color: 40 seconds (for A4 /color mode)

Reduction/Enlargement Size-for-Size: 1:1 ± 1.3%

Preset %: 1:0.500, 1:0.707, 1:0.816, 1:1.225, 1:1.414, 1:2.000

Variable %: 1:0.25 – 1:4.00 (1% increments)
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Continuous Copy Speed DocuPrint CM215 f/CM215 fw:

Document glass: 

Monochrome:

A4: 15 sheets/minute

Color:

A4: 12 sheets/minute

Automatic document feeder:

Monochrome:

A4: 10 sheets/minute

Color:

A4: 2 sheets/minute

DocuPrint CM215 b:

Document glass: 

Monochrome:

A4: 15 sheets/minute

Color:

A4: 12 sheets/minute

IMPORTANT: 
• The speed may be reduced due to image quality adjustment.

• The performance may be reduced depending on the paper type or 
paper tray.

Paper Tray Capacity Standard:

150 sheets (Multipurpose feeder) + 10 sheets (Priority sheet 
inserter)

Maximum paper capacity:

160 sheets (standard)

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Continuous Copy 99 images

NOTE: 
• The machine may pause temporarily to perform image 

stabilization.

Output Tray Capacity DocuPrint CM215 f/CM215 fw:

Center output tray:

Approximately 100 sheets (A4 )

Document output tray:

Approximately 15 sheets (A4 )

DocuPrint CM215 b:

Center output tray:

Approximately 100 sheets (A4 )

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Power Supply AC 220 – 240 V ± 10%/110 – 127 V ± 10%, 5/7 A for both 50/60 Hz ± 
3 Hz
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Power Consumption DocuPrint CM215 f/CM215 fw:

Maximum power consumption:

810 W

Low Power mode:

11 W or less

Sleep mode:

2 W or less

Standby mode:

55 W or less

DocuPrint CM215 b:

Maximum power consumption:

950 W 

Low Power mode:

16 W or less 

Sleep mode:

7 W or less 

Standby mode:

65 W or less

Dimensions DocuPrint CM215 f/CM215 fw:

Width 410 × Depth 389* × Height 337.5 mm

DocuPrint CM215 b:

Width 410 × Depth 389* × Height 318 mm
*: When the front cover is closed.

Machine Weight DocuPrint CM215 f/CM215 fw:

15.0 kg

DocuPrint CM215 b:

14.3 kg

IMPORTANT: 

• The weight of paper is not included.

• The weight of the toner cartridges are included.

Space Requirement DocuPrint CM215 f/CM215 fw:

Width 879 × Depth 936.5* mm

DocuPrint CM215 b:

Width 848 × Depth 936.5* mm 
*: When the front cover and rear cover are open.
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Print Function

Type Built-in

Continuous Print Speed Same as the Copy Function

Print Resolution Output resolution: 1200 × 2400 dpi

Data processing resolution: 600 × 600 dpi

PDL — (Host-based)

Protocol 

(DocuPrint CM215 f/CM215 fw 
only)

DocuPrint CM215 f:

Ethernet (standard): TCP/IP (LPD, Port9100, WSD)

DocuPrint CM215 fw:

Ethernet (standard): TCP/IP (LPD, Port9100, WSD)

IEEE802.11b/g (standard) 

NOTE: 

• WSD stands for Web Services on Devices.

• WSD is available only on Windows Vista®, Windows® 7 or 
Windows® 8.

Operating System Standard: GDI driver

Microsoft® Windows® XP,

Microsoft® Windows Server® 2003,

Microsoft® Windows Server® 2008,

Microsoft® Windows Vista®,

Microsoft® Windows® 7,

Microsoft® Windows® 8,

Microsoft® Windows® XP x64,

Microsoft® Windows Server® 2003 x64,

Microsoft® Windows Server® 2008 x64,

Microsoft® Windows Vista® x64,

Microsoft® Windows Server® 2008 R2,

Microsoft® Windows® 7 x64,

Microsoft® Windows® 8 x64,

Microsoft® Windows Server® 2012,

Mac OS X 10.4/10.5/10.6/10.7/10.8

IMPORTANT: 

• For information about the latest supported OS, contact our 
Customer Support Center.

Connectivity DocuPrint CM215 f:

Standard: Ethernet (100BASE-TX/10BASE-T), USB 2.0 (Hi-
Speed)

DocuPrint CM215 fw:

Standard: Ethernet (100BASE-TX/10BASE-T), USB 2.0 (Hi-
Speed), IEEE802.11b/g

DocuPrint CM215 b:

Standard: USB 2.0 (Hi-Speed)
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Scan Function

Type Color scanner

Original Paper Size Same as the Copy Function

Scanning Resolution 1200 × 1200 dpi, 600 × 600 dpi, 300 × 300 dpi, 200 × 200 dpi

Scanning Halftone Monochrome : 8 bit

Color : 24 bit

Scanning Speed

(DocuPrint CM215 f/CM215 fw 
only)

Monochrome : 10 sheets/minute

Color : 2 sheets/minute

IMPORTANT: 

• The scanning speed varies depending on documents.

Connectivity DocuPrint CM215 f:

Standard: Ethernet 100BASE-TX/10BASE-T, USB 1.1/2.0

DocuPrint CM215 fw:

Standard: Ethernet 100BASE-TX/10BASE-T, USB 1.1/2.0, 
IEEE802.11b/g 

DocuPrint CM215 b:

Standard: USB 1.1/2.0
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Scan to PC Protocol (DocuPrint CM215 f/CM215 fw only): TCP/IP (SMB, FTP)

Operating System:

Microsoft® Windows® XP,

Microsoft® Windows Vista®,

Microsoft® Windows Server® 2003,

Microsoft® Windows Server® 2008,

Microsoft® Windows® 7,

Microsoft® Windows® 8,

Microsoft® Windows® XP x64,

Microsoft® Windows Vista® x64,

Microsoft® Windows Server® 2003 x64,

Microsoft® Windows Server® 2008 x64,

Microsoft® Windows Server® 2008 R2,

Microsoft® Windows® 7 x64,

Microsoft® Windows® 8 x64,

Microsoft® Windows Server® 2012,

Mac OS X 10.4/10.5/10.6/10.7/10.8

IMPORTANT: 

• For information about the latest supported OS, refer to the Fuji 
Xerox Web site.

File Format:

TIFF

JPEG

PDF (v 1.6)

Scan to e-mail

(DocuPrint CM215 f/CM215 fw 
only)

Protocol: TCP/IP (SMTP, POP3)

File Format:

Monochrome binary:

TIFF, JPEG, PDF

Gray scale/full color:

TIFF, JPEG, PDF
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Fax Function (DocuPrint CM215 f/CM215 fw Only)

Send Document Size Document glass:

Maximum: A4/Letter

Automatic document feeder:

Maximum: Legal

Recording Paper Size Maximum: Legal

Minimum: A4/Letter

Transmission Time 3 seconds

IMPORTANT: 

• When transmitting an A4 size 700-character document in the 
standard quality (8 x 3.85 lines/mm) and high speed mode (28.8 
kbps or above: JBIG). This is only the transmission speed for 
image information and does not include the controlling time for the 
communication. Note that the actual transmission time depends 
on the content of documents, the machine that the recipient uses, 
and the status of the communication line.

Transmission Mode ITU-T Super G3/G3 ECM/G3

Scanning Resolution Standard:

203 × 98 dpi (8 × 3.85 dots/mm)

Fine:

203 × 196 dpi (8 × 7.7 dots/mm)

Super Fine:

203 × 392 dpi (8 × 15.4 dots/mm)

Ultra Fine:

406 × 392 dpi (16 × 15.4 dots/mm)

Coding Method MH, MR, MMR, JBIG

Transmission Speed G3:33.6/31.2/28.8/26.4/24.0/21.6/19.2/16.8/14.4/12.0/9.6/7.2/4.8/2.4
kbps

No. of Fax Lines PSTN, PBX. Leased line (3.4KHz/2-wire)

RJ-11, 1 line
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Direct Fax Function (DocuPrint CM215 f/CM215 fw 
Only)

Document Size A4, Letter, Folio, Legal

Transmission Speed Same as the Fax Function

Transmission Resolution Standard: 

203 × 98 dpi (8 × 3.85 dots/mm)

High Quality: 

203 × 196 dpi (8 × 7.7 dots/mm)

Superfine: 

203 × 392 dpi (8 × 15.4 dots/mm)

Super-High Image Quality: 

406 × 392 dpi (16 × 15.4 dots/mm)

Applicable Lines Same as the Fax Function

Operating System Microsoft® Windows® XP,

Microsoft® Windows Vista®,

Microsoft® Windows Server® 2003,

Microsoft® Windows Server® 2008,

Microsoft® Windows® 7,

Microsoft® Windows® 8,

Microsoft® Windows® XP x64,

Microsoft® Windows Vista® x64,

Microsoft® Windows Server® 2003 x64,

Microsoft® Windows Server® 2008 x64,

Microsoft® Windows Server® 2008 R2,

Microsoft® Windows® 7 x64,

Microsoft® Windows® 8 x64,

Microsoft® Windows Server® 2012,

Mac OS X 10.4/10.5/10.6/10.7/10.8

IMPORTANT: 

• For information about the latest supported OS, refer to the Fuji 
Xerox Web site.
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2
Basic Operation

This chapter includes:

• "Main Components" on page 44

• "Turning On the Printer" on page 51

• "Setting Initial Settings on the Operator Panel" on page 52

• "Printing a Panel Settings Page" on page 53

• "Power Saver Mode" on page 54
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Main Components

This section provides an overview of your printer.

This section includes:

• "Front View" on page 44

• "Rear View" on page 46

• "Automatic Document Feeder (ADF) (DocuPrint CM215 f/CM215 fw Only)" on page 47

• "Operator Panel" on page 48

Front View
DocuPrint CM215 f/CM215 fw

1 Output Tray Extension 2 Center Output Tray

3 Operator Panel 4 Automatic Document Feeder (ADF)

5 Document Feeder Tray 6 Document Output Tray

7 Toner Access Cover 8 Print Head Cleaning Rod

9 Power Switch 10 Front Cover

11 Paper Width Guides 12 Slide Bar

13 Length Guide 14 Multipurpose Feeder (MPF)

15 USB Drive 16 Priority Sheet Inserter (PSI)

3 4 5 76 8

11

16 15 14 13 12 11 10 9

1 2
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DocuPrint CM215 b

1 Output Tray Extension 2 Center Output Tray

3 Operator Panel 4 Document Cover

5 Toner Access Cover 6 Document Glass

7 Print Head Cleaning Rod 8 Power Switch

9 Front Cover 10 Paper Width Guides

11 Slide Bar 12 Length Guide

13 Multipurpose Feeder (MPF) 14 USB Drive

15 Priority Sheet Inserter (PSI)

3 4 5 6
10

15 14 13 12 11 10 9 8

1 2

7
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Rear View
DocuPrint CM215 f/CM215 fw

DocuPrint CM215 b

1 ADF Cover 2 Ethernet Port

3 USB Port 4 Wall Jack Connector

5 Phone Connector 6 Rear Cover Handle

7 Power Connector 8 Rear Cover

9 Transfer Roller 10 Paper Chute

11 Paper Feed Roller 12 Transfer Belt

13 Levers

1 USB Port 2 Rear Cover Handle

3 Power Connector 4 Rear Cover

5 Transfer Roller 6 Paper Chute

7 Paper Feed Roller 8 Transfer Belt

9 Levers

13

12

11
10

9

8 7

1

2

3

4

5

6

9

8

7
6

5

4 3

1

2
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Automatic Document Feeder (ADF) (DocuPrint CM215 
f/CM215 fw Only)

1 ADF Cover

2 Document Guides

3 ADF Glass

4 Document Glass

5 Document Feeder Tray

6 Document Cover

1 2 3

5

4

6
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Operator Panel
The operator panel has a 4-line by 28-character liquid crystal display (LCD), light-emitting diodes 
(LED), control buttons, one-touch buttons, and numeric keypad, which allow you to control the printer. 
(The one-touch buttons are available only on the DocuPrint CM215 f/CM215 fw.)

1* One-touch buttons Calls up the stored fax number registered in the Address 
Book. The first eight fax numbers in the Address Book are 
assigned to the buttons in row order, starting from the top 
corner.

2 Copy button/LED Moves to the top level of the Copy menu.

3 Scan button/LED Moves to the top level of the Scan menu.

4   buttons Moves a cursor or highlight up or down.

5   buttons Moves a cursor or highlight left or right.

6* Job Status button/LED Moves to the top level of the Job Status menu.

7 System button/LED Moves to the top level of the System menu.

8 Numeric keypad DocuPrint CM215 f/CM215 fw
• Enters characters and numbers.

DocuPrint CM215 b
• Enters numbers.

9* Redial/Pause button • Re-dials a telephone number.

• Inserts a pause during dialing.

10* Speed Dial button Calls up a stored telephone number.

11  (Clear All) button Resets the current setting, and returns to the top level of 
each service menu.

12  (Energy Saver) button/LED Lights up in the Sleep mode. Press this button to exit the 
Sleep mode.

13  (Stop) button Cancels the current processing or pending job.

14  (Start) button Starts a job.

15  (Error) LED Lights up when the printer has an error.

16  (Data) LED Lights up for incoming, outgoing, or pending jobs.

17* C (Clear) button Deletes characters and numbers.

OK

9

C

8

0 #

7

4 65

1 32　
Wi-Fi

WPS

1 2　

3 4　

5 6　

7 8　

32 4 5 6* 7 8 9* 10* 11 12

1314151617*19*20212324*2526 22

1*

18

*: This button/LED is available only on the DocuPrint CM215 f/CM215 fw.
**: This button/LED is available only on the DocuPrint CM215 fw.

27**28**
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NOTE: 

• Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to 
press the  button to save the current entry or setting. 

• For the DocuPrint CM215 f/CM215 fw, see "Using the Numeric Keypad" on page 320 for details on how to use 
the numeric keypad to enter alphanumeric characters.

Status of Wi-Fi LED (DocuPrint CM215 fw Only)
This section describes when the  (Wi-Fi) LED lights up or blinks.

See also: 
• "Wireless Problems (DocuPrint CM215 fw Only)" on page 364

18 # button

(DocuPrint CM215 f/CM215 fw only)

Enters characters "(space) & ( )".

C (Clear) button

(DocuPrint CM215 b only)

Deletes numbers.

19* Address Book button Pressing this button at the Fax menu, moves to the top 
level of the Address Book menu.

20  button Confirms the entry of values.

21  (Back) button Returns to the previous screen.

22 LCD Panel Displays various settings, instructions, and error messages.

23 Print button/LED Moves to the top level of the Print menu.

24* Fax button/LED Moves to the top level of the Fax menu.

25 Color Mode button Switches the color mode.

26 B&W/Color LED Lights up to indicate which color mode is selected.

27**  (WPS) button Starts Wi-Fi Protected Setup® (Push Button Configuration).

28**  (Wi-Fi) LED Lights up when wireless connection is established, and 
blinks in certain conditions.

*: This button/LED is available only on the DocuPrint CM215 f/CM215 fw.
**: This button/LED is available only on the DocuPrint CM215 fw.

 (Wi-Fi) LED Wi-Fi

settings*

Printer Status Error Message

Off N/A Connected to the network via 
Ethernet cable; Wi-Fi settings 
are not available when an 
Ethernet cable is connected to 
the printer.

—

Off — —

On The printer enters the Power 
Saver mode

—

On On Wireless link established —

Blinking 
normal

On Searching for wireless LAN 
access point or router

—

Blinking 
slowly

On Searching/Connecting with WPS 
access point or router during 
wireless operation

—
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Blinking 
fast

On No wireless LAN access point or 
router on which the WPS 
operation is being performed 
found within the specified time

Wireless Error

016-920 System Setup 
Fail

WPS Connection failure; Security 
setting of the wireless LAN 
access point or router is WEP, 
which is unsupported on WPS.

Wireless Error

016-921 System Setup 
Fail

*: You can enable/disable the Wi-Fi settings. For more information, see "Wi-Fi (DocuPrint CM215 fw 
Only)" on page 282.

 (Wi-Fi) LED Wi-Fi

settings*

Printer Status Error Message
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Turning On the Printer

IMPORTANT: 

• Do not use extension cords or power strips.

• The printer should not be connected to an uninterruptible power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer (see "Rear View" on 
page 46).

2 Connect the other end of the cord to the power source.

3 Turn on the printer.

NOTE: 

• When you turn on the printer for the first time, follow the on-screen instructions on the LCD panel to 
configure the initial settings of your printer.

See also: 

• "Setting Initial Settings on the Operator Panel" on page 52
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Setting Initial Settings on the Operator Panel

You need to set the printer language, clock date, and time when you turn on the printer for the first 
time. (Clock date and time are available only on the DocuPrint CM215 f/CM215 fw.)

When you turn on the printer, a wizard appears on the LCD panel. Follow the step below to set the 
initial settings.

NOTE: 

• If you do not start configuring the initial settings, Select Function appears on the LCD panel in three 
minutes. After that, you can set the following initial setup by enabling Power On Wizard on the operator 
panel if needed.
For more information about the operator panel, see "Understanding the Printer Menus" on page 274.

• For the DocuPrint CM215 f/CM215 fw

1 Select the language you want to use on the operator panel, and then press the  button. 

2 Press the  button to start setting the region.

3 Select your region, and then press the  button.

4 Select the appropriate time zone, and then press the  button.

5 Specify the current date, and then press the  button.

6 Specify the current time, and then press the  button.

7 Press the  button for fax setup.

If you want to skip the fax setup, press the  (Start) button.

8 Enter your fax number, and then press the  button.

9 Enter a name, and then press the  button.

10 Press the  button to complete the initial settings on the operator panel.

• For the DocuPrint CM215 b

1 Select the language you want to use on the operator panel, and then press the  button. 
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Printing a Panel Settings Page

The Panel Settings page shows current settings for the operator panel menus. 

Using the Operator Panel

NOTE: 

• The reports and lists are all printed in English.

1 Press the System button.

2 Select Report / List, and then press the  button.

3 Select Panel Settings, and then press the  button.

The Panel Settings page is printed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Microsoft® Windows® 7 as an example.

NOTE: 

• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click the Panel Settings button.

The Panel Settings page is printed.
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Power Saver Mode

The printer has a power saving feature which reduces power consumption during periods of inactivity. 
This feature operates in two modes: Low Power mode and Sleep mode. As delivered, the printer 
switches to the Low Power mode five minutes after the last job is finished. The printer then switches to 
the Sleep mode after another six minutes of inactivity. When the printer is in the Low Power mode, the 
LCD backlight turns off. In the Sleep mode, the  (Energy Saver) button lights up. The LCD panel 
goes blank and displays nothing.

The factory default settings of five minutes (Low Power mode) and six minutes (Sleep mode) are 
changeable within the range of 5 to 30 minutes (Low Power mode) and 1 to 6 minutes (Sleep mode). 
The printer returns to the ready-to-print state in about 25 seconds when re-activated.

Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a job from a computer. To 
manually exit the Low Power mode, press any button on the operator panel. To exit the Sleep mode, 
press the  (Energy Saver) button. 

NOTE: 

• When the printer is in the Sleep mode, all buttons on the operator panel except for the  (Energy Saver) 
button do not function. To use the buttons on the operator panel, press the  (Energy Saver) button to exit 
the Power Saver mode.

See also: 
• "Setting the Time for the Power Saver Mode" on page 318
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3
Printer Management Software

Use the Software Pack CD-ROM that is shipped with your printer to install a combination of software 
programs, depending on your operating system.

This chapter includes:

• "Print and Scan Drivers" on page 56

• "CentreWare Internet Services (DocuPrint CM215 f/CM215 fw Only)" on page 57

• "Printer Setting Utility (Windows Only)" on page 58

• "SimpleMonitor (Windows Only)" on page 59

• "Launcher (Windows Only)" on page 60

• "Address Book Editor (DocuPrint CM215 f/CM215 fw Only)" on page 62

• "Express Scan Manager" on page 63

• "Setup Disk Creation Tool (Windows Only)" on page 64

• "DocuWorks (Windows Only) (DocuPrint CM215 f/CM215 fw Only)" on page 65
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Print and Scan Drivers

To access all of your printer’s features, install the print and scan drivers from the Software Pack CD-
ROM.

• The print driver enables your computer and printer to communicate and provides access to your 
printer features. 

• The scan driver enables you to scan images directly to your personal computer and place 
scanned images directly into an application via USB or the network. (The network feature is 
available only on the DocuPrint CM215 f/CM215 fw.)

The scan driver is installed with your print driver. It is available for Microsoft® Windows® and Mac OS 
X.

See also: 
• "Configuring Printer and Installing Software on Windows" on page 89

• "Configuring Printer and Installing Software on Mac OS X" on page 120
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CentreWare Internet Services (DocuPrint CM215 
f/CM215 fw Only)

This section provides information on the CentreWare Internet Services.

The CentreWare Internet Services is a hypertext transfer protocol (HTTP)-based web page service 
that is accessed through your web browser.

Using the CentreWare Internet Services you can confirm the printer status, and change the printer 
configuration options easily. Anyone on your network can access the printer using the CentreWare 
Internet Services. In administrative mode you can change the configuration of the printer, set up your 
fax directories, and manage your printer settings without leaving your computer.

NOTE: 

• Users who are not given passwords by the administrator can still view the configuration settings in user mode. 
They will not be able to save or apply any changes to the current configuration and settings.

• For details on the menu items of the CentreWare Internet Services, refer to the Help on the CentreWare 
Internet Services.

Creating an Administrative Password

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 

• The default ID and password are “11111” and “x-admin” respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the 
administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

Setting to 0 does not limit the number of login attempts.

9 Click Apply. 

Your new password has been set and anyone with the administrator name and password can log 
in and change the printer configuration and settings.
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Printer Setting Utility (Windows Only)

The Printer Setting Utility is installed with your print driver.

The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the 
system settings by using the Printer Setting Utility.

The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and 
Diagnosis tabs.

NOTE: 

• The Password dialog box appears the first time you try to change settings on the Printer Setting Utility when 
Panel Lock is set on the printer. In this case, enter the password you specified, and click OK to apply the 
settings.
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SimpleMonitor (Windows Only)

The SimpleMonitor is installed with your print driver.

You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon 
on the taskbar at the bottom right of the screen. The Printer Selection window appears, which 
displays the printer name, printer connection port, printer status, and model name. Check the column 
Status to know the current status of your printer. 

Settings button: Displays the Settings window and allows you to modify the SimpleMonitor settings.

Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears.

The Printer Status window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.

By default, the Printer Status window launches automatically when an error occurs. You can specify 
the conditions for starting the Printer Status window in Printer Status Window Properties.

To change the pop-up settings for the Printer Status window:

1 Right-click the SimpleMonitor printer icon on the taskbar at the bottom right of the screen.

2 Select Printer Status Window Properties.

The Printer Status Window Properties window appears.

3 Select the type of the pop-up and then click OK.

You can also check the toner level of your printer and the job information on the Printer Status 
window.
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Launcher (Windows Only)

The Launcher is installed with your print driver.

Using the Launcher-Btype window, you can open the Printer Status window, Printer Setting Utility, 
Troubleshooting Guide, Address Book Editor, and Express Scan Manager. (The Address Book Editor 
is available only on the DocuPrint CM215 f/CM215 fw.)

The following procedure uses Windows 7 as an example.

To open the Launcher-Btype window:

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Launcher.

The Launcher-Btype window appears.

The Address Book Editor is available only on the DocuPrint CM215 f/CM215 fw.
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2 The Launcher-Btype window provides several buttons; Status Window, Printer Setting Utility, 
Troubleshooting, Address Book Editor, and Express Scan Manager. (The Address Book 
Editor is available only on the DocuPrint CM215 f/CM215 fw.)

To exit, click the X button at the top-right of the window.

For details, click the Help button/icon of each application.

Status Window Opens the Printer Status window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 59

Printer Setting Utility Opens the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 58

Troubleshooting Opens the Troubleshooting Guide, which allows you to resolve issues 
by yourself.

Address Book Editor

(DocuPrint CM215 f/CM215 fw 
only)

Opens the Address Book Editor, which allows you to add and edit 
Address Book entries.

See also: 
• "Address Book Editor (DocuPrint CM215 f/CM215 fw Only)" on 

page 62

Express Scan Manager Opens the Express Scan Manager.

See also: 
• "Express Scan Manager" on page 63
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Address Book Editor (DocuPrint CM215 f/CM215 fw 
Only)

The Address Book Editor is installed with your print driver. It is available for Windows and Mac OS X.

The Address Book Editor provides a convenient interface for modifying the printer’s Address Book 
entries. With it you can add:

• Fax entries

• E-Mail entries

• Server entries

When you start the software, the Address Book Editor reads the printer’s Address Book. You can add, 
edit, and delete entries. After making changes, you can then save the updated Address Book to the 
printer or to your computer. 
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Express Scan Manager

The Express Scan Manager is installed with your print driver. It is available for Windows and Mac OS 
X.

The Express Scan Manager handles scan jobs sent from the printer to your computer via USB. When 
scan jobs are sent from the printer to the computer, the Express Scan Manager automatically 
manages the scan jobs.

Before scanning to your computer, start the Express Scan Manager and configure the output 
destination of the scanned image files.

Select Open the image file check box to display scanned files saved in the specified destination after 
scanning.

NOTE: 

• When you separately install the Express Scan Manager from the Software Pack CD-ROM, you also need to 
install the scan driver from the Software Pack CD-ROM.

See also: 
• "Scanning From the Operator Panel - Scan to Application" on page 195
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Setup Disk Creation Tool (Windows Only)

The Setup Disk Creation Tool program located in the MakeDisk folder of the Utilities folder on the 
Software Pack CD-ROM and the print driver located on the Software Pack CD-ROM are used to 
create driver installation packages that contain custom driver settings. A driver installation package 
can contain a group of saved print driver settings and other data for things such as:

• Print orientation and multiple-up (document settings) 

• Watermarks 

If you want to install the print driver with the same settings on multiple computers running on the same 
operating system, create a setup disk in a media or in a server on the network. Using the setup disk 
that you have created will reduce the amount of work required when installing the print driver.

• Install the print driver for your printer on the computer on which the setup disk is to be created.

• The setup disk can only be used on the operating system on which the disk was created or 
computers running the same operating system. Create a separate setup disk for each of the 
operating systems.
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DocuWorks (Windows Only) (DocuPrint CM215 
f/CM215 fw Only)

When installing the DocuWorks, run the appropriate EXE file in the DocuWorks document handling 
software.

Windows supports the DocuWorks and the DocuWorks Viewer Light.

The DocuWorks is available only for Windows.

NOTE: 

• For more information on the DocuWorks, refer to the readme file on the DocuWorks document handling 
software.
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4
Printer Connection and Software 
Installation

This chapter includes:

• "Overview of Printer Connection and Software Installation" on page 68

• "Connecting Your Printer" on page 71

• "Setting the IP Address (for IPv4 Mode) (DocuPrint CM215 f/CM215 fw Only)" on page 83

• "Configuring Printer and Installing Software on Windows" on page 89

• "Configuring Printer and Installing Software on Mac OS X" on page 120
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Overview of Printer Connection and Software 
Installation

Read this section to know the overall steps required for each connection method to complete the 
printer connection and software installation.

Select one of the following connection methods.

• USB connection

• Ethernet connection (DocuPrint CM215 f/CM215 fw only)

• Wireless connection (DocuPrint CM215 fw only)

NOTE: 

• If the Software Pack CD-ROM is not available, you can download the latest driver from our Web Site: 
http://www.fujixeroxprinters.com/ 

USB Connection

• For Windows

1 Connect the printer and the computer with the USB cable. 

Refer to "USB Connection" on page 73.

2 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Using Installer to Set Up Connection and Install Software" on page 91.

• For Mac OS X

1 Connect the printer and the computer with the USB cable. 

Refer to "USB Connection" on page 73.

2 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 120.
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Ethernet Connection (DocuPrint CM215 f/CM215 fw Only)

• For Windows

1 Connect the printer to a wired network. 

Refer to "Ethernet Connection (DocuPrint CM215 f/CM215 fw Only)" on page 74.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer’s IP 
Address" on page 84.

• You can also manually set the printer's IP address by using the operator panel. Refer to 
"Assigning an IP Address Manually" on page 85.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Windows" on page 89.

• For Mac OS X

1 Connect the printer to a wired network. 

Refer to "Ethernet Connection (DocuPrint CM215 f/CM215 fw Only)" on page 74.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer’s IP 
Address" on page 84.

• You can also manually set the printer's IP address by using the operator panel. Refer to 
"Assigning an IP Address Manually" on page 85.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 120.
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Wireless Connection (DocuPrint CM215 fw Only)

• For Windows

1 Connect the printer to a wireless network. 

Refer to "Wireless Connection (DocuPrint CM215 fw Only)" on page 75.

Perform the following steps as necessary.

If you set up wireless connection using the installer on the Software Pack CD-ROM, the following 
steps are not necessary.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer’s IP 
Address" on page 84.

• You can also manually set the printer's IP address by using the operator panel. Refer to 
"Assigning an IP Address Manually" on page 85.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Windows" on page 89.

• For Mac OS X

1 Connect the printer to a wireless network. 

Refer to "Wireless Connection (DocuPrint CM215 fw Only)" on page 75.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer’s IP 
Address" on page 84.

• You can also manually set the printer's IP address by using the operator panel. Refer to 
"Assigning an IP Address Manually" on page 85.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 120.
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Connecting Your Printer

The interface cables of your printer must meet the following requirements:

Connection Type Connection Specifications

Ethernet

(DocuPrint CM215 f/CM215 fw 
only)

10 Base-T/100 Base-TX compatible

USB USB2.0 compatible

Wireless
(DocuPrint CM215 fw only)

IEEE 802.11b/802.11g

Wall Jack Connector

(DocuPrint CM215 f/CM215 fw 
only)

RJ11

Phone Connector

(DocuPrint CM215 f/CM215 fw 
only)

RJ11

1 Ethernet Port

(DocuPrint CM215 f/CM215 fw only)

2 USB Port

3 Wall Jack Connector

(DocuPrint CM215 f/CM215 fw only)

4 Phone Connector

(DocuPrint CM215 f/CM215 fw only)

1

3

2

4
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Available Features for Each Connection Type
Connect the printer via USB, Ethernet, or Wireless. A USB connection is a direct connection and is not 
used for networking. Ethernet and wireless connections are used for networking. Hardware and 
cabling requirements vary for the different connection methods. Ethernet cable and wireless LAN 
access point (Registrar) or router are not included with your printer and must be purchased separately.

The available features for each connection type are shown in the following table.

• DocuPrint CM215 f/CM215 fw

Connection Type Available Feature

USB When connected via USB, you can:

• Instruct print jobs from a computer.

• Scan and print an image into an application.

• Scan and print an image to a folder on the computer.

• Use the Address Book Editor to manage Address Book entries.

• Use the Express Scan Manager to handle scan jobs sent from the 
printer to your computer.

• Use the Printer Setting Utility to view, specify or diagnose the 
system settings. (Microsoft® Windows® only)

• Use the SimpleMonitor to check the printer status. (Windows only)

Ethernet When connected via Ethernet, you can:

• Instruct print jobs from a computer on the network.

• Scan and print an image to a computer on the network.

• Scan and print an image to an FTP server.

• Scan to email.

• Use the CentreWare Internet Services to view the printer status or 
specify the printer settings.

• Use the Printer Setting Utility to view, specify or diagnose the 
system settings. (Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)

Wireless
(DocuPrint CM215 fw only)

When connected via Wireless, you can:

• Instruct print jobs from a computer on the network.

• Scan and print an image to a computer on the network.

• Scan and print an image to an FTP server.

• Scan to email.

• Use the CentreWare Internet Services to view the printer status or 
specify the printer settings.

• Use the Printer Setting Utility to view, specify or diagnose the 
system settings. (Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)
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• DocuPrint CM215 b

Connecting Printer to Your Computer

USB Connection
To connect the printer to a computer via USB:

1 Make sure that the printer is turned off and unplugged from the power source.

2 Connect the smaller USB connector into the USB port at the rear of the printer and the other end 
of the cable into a USB port of the computer.

NOTE: 

• Do not connect the printer USB cable to the USB slot available on the keyboard.

Connection Type Available Feature

USB You can:

• Instruct print jobs from a computer.

• Scan and print an image into an application.

• Scan and print an image to a folder on the computer.

• Use the Express Scan Manager to handle scan jobs sent from the 
printer to your computer.

• Use the Printer Setting Utility to view, specify or diagnose the 
system settings. (Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)

USB port
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Ethernet Connection (DocuPrint CM215 f/CM215 fw Only)
To connect the printer to a computer via Ethernet:

1 Make sure that the printer is turned off and all cables have been disconnected.

2 Connect one end of the Ethernet cable into the Ethernet port at the rear of the printer, and the 
other end to an Ethernet port of a router or hub.

NOTE: 

• Connect the Ethernet cable, only if you need to setup a wired connection. Connecting the Ethernet cable 
stops some features or functions for Wireless network.

Ethernet port
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Wireless Connection (DocuPrint CM215 fw Only)
This section describes how to connect the printer to a computer via wireless network.

Confirm that the Ethernet cable has been disconnected from the printer and the  (Wi-Fi) LED is 
blinking before configuring the wireless connection.

IMPORTANT: 

• The Wireless LAN feature is not available in all locations. Please check with your local Fuji Xerox 
representative for availability of wireless in your location.

• If you are using a method other than WPS to configure your wireless network settings, be sure to get the SSID 
and security information from a system administrator before starting the setup procedure.

• Be sure to configure necessary settings on the wireless LAN access point (Registrar) or router before starting 
the printer setup. For information on the access point or router settings, refer to the manual supplied with the 
product.

The specifications of wireless setting function are described below:

Item Specification

Connectivity Wireless

Connectivity Standard IEEE 802.11b/802.11g compliant

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps 

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps 

Security 64 (40-bit key)/128 (104-bit key) WEP, WPA-PSK (TKIP, AES), 
WPA2-PSK (AES) (IEEE 802.1x attestation function of WPA 1x non-
corresponds), Mixed Mode PSK

Certifications Wi-Fi, WPA2.0 (Personal)

Wi-Fi Protected Setup® (WPS)* Push Button Configuration (PBC), Personal Identification Number 
(PIN)

*: WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed Mode 
PSK, WPA-PSK-AES, WPA2-PSK-AES, WPA-PSK-TKIP, Open (No Security)
Printer Connection and Software Installation 75



You can select a method to configure a wireless setting from the following:

Using the installer on the Software Pack CD-ROM (Windows Only) (Recommended for initial setup)

Refer to "Launching the Printer Setup Screen" on page 91.

WPS-PBC (  (WPS) button)*1

Refer to "WPS-PBC (WPS Button)" on page 77.

WPS-PBC (Operator Panel Menu)*1

Refer to "WPS-PBC (Operator Panel Menu)" on page 78.

WPS-PIN*2

Refer to "WPS-PIN" on page 79.

Auto SSID Setup

Refer to "Auto SSID Setup" on page 80.

Manual SSID Setup

Refer to "Manual SSID Setup" on page 81.

*1: WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register 

devices required for wireless configuration, by starting WPS-PBC on the printer with the  (WPS) 
button or operator panel menu, and then pressing the button provided on the wireless LAN access point 
(Registrar) or router. This setting is available only when the access point supports WPS-PBC.

*2: WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and 
register devices required for wireless configuration, by entering PIN assignments in the printer and 
computer. This setting, performed through access point, is available only when the access point of your 
wireless router supports WPS.
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• WPS-PBC (WPS Button)
You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) by pressing the  (WPS) 
button.

NOTE: 

• WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC.

• Before starting WPS-PBC with the  (WPS) button, confirm the position of the WPS button (button name 
may vary) on the wireless LAN access point (Registrar) or router. For information about WPS operation on the 
wireless LAN access point (Registrar) or router, refer to the manual supplied with the product.

• The  (Wi-Fi) LED lights up or blinks to indicate the printer's wireless connection status. For more 
information, see "Status of Wi-Fi LED (DocuPrint CM215 fw Only)" on page 49.
If a problem occurs or error messages are displayed on the LCD panel, see "Wireless Problems (DocuPrint 
CM215 fw Only)" on page 364.

1 Press and hold the  (WPS) button on the printer for two seconds.

Confirm that the  (Wi-Fi) LED starts to blink slowly and Press WPS Button on Router 
appears on the LCD panel.

2 Start the WPS operation on the wireless LAN access point (Registrar) or router within two 
minutes.

When the WPS operation is successful and the printer is rebooted, wireless LAN connection 
setting is completed.

OK

9

C

8

0 #

7

4 65

1 32　
Wi-Fi

WPS

1 2　

3 4　

5 6　

7 8　
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• WPS-PBC (Operator Panel Menu)
You can start WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) from the operator panel.

NOTE: 

• WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC.

• Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless 
LAN access point (Registrar) or router. For information about WPS operation on the wireless LAN access 
point (Registrar) or router, refer to the manual supplied with the product.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select WPS, and then press the  button.

5 Select Push Button Control, and then press the  button.

6 Select Yes, and then press the  button.

7 Confirm that the  (Wi-Fi) LED starts to blink slowly and Press WPS Button on Router 
appears, and then start the WPS-PBC on the wireless LAN access point (Registrar) or router 
within two minutes.

When the WPS operation is successful and the printer is rebooted, wireless LAN connection 
setting is completed.
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• WPS-PIN
The PIN code of WPS-PIN can only be configured from the operator panel.

NOTE: 

• WPS-PIN is available only when the wireless LAN access point (Registrar) or router supports WPS-PIN.

• For WPS operation on the wireless LAN access point (Registrar) or router, refer to the manual supplied with 
the product.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select WPS, and then press the  button.

5 Select PIN Code, and then press the  button.

6 Write down the displayed 8-digit PIN code, or select Print PIN Code and press the  button 
to print the PIN code.

7 Select Start Configuration, and then press the  button.

8 Confirm that Please Wait... WPS AP Searching appears.

9 Select the SSID of the access point you want to connect to, and then press the  button.

10 Confirm that Please Wait... Wireless Setting appears.

11 Enter the PIN code displayed on step 6 into the wireless LAN access point (Registrar) or router.

When the WPS operation is successful and the printer is rebooted, wireless LAN connection 
setting is completed.
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• Auto SSID Setup

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select Wireless Setup, and then press the  button.

The printer automatically searches the access points on wireless network.

5 Select the desired access point, and then press the  button.

If the desired access point does not appear, go to "Manual SSID Setup" on page 81.

NOTE: 

• Some hidden SSID may not be displayed. If the SSID is not detected, turn on SSID broadcast from the 
access point.

6 Enter the passphrase or WEP key.

When the encryption type of the access point selected in step 5 is WPA, WPA2 or Mixed:

• Enter the passphrase, and then press the  button.

When the encryption type of the access point selected in step 5 is WEP:

• Enter the WEP key, and then press the  button.

NOTE: 

• A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the 
manual supplied with the access point or router.

When the setup is successful and the screen returns to Select Function, wireless LAN 
connection setting is completed.
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• Manual SSID Setup

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select Wireless Setup, and then press the  button.

5 Select Manual Setup, and then press the  button.

6 Enter the SSID, and then press the  button.

7 Select the network mode from Infrastructure and Ad-hoc depending on your environment, 
and then press the  button.

If you select Infrastructure, proceed to step 8.

If you select Ad-hoc, proceed to step 9.

8 Select the encryption type from Mixed Mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or WEP.

IMPORTANT: 

• Be sure to use one of the supported encryption methods to protect your network traffic.

To use Mixed Mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Select Mixed Mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES, and then press the  
button.

b Enter the passphrase, and then press the  button.

NOTE: 

• A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric 
characters. It may be described as a key on some access points or routers. For details, refer to the 
manual supplied with the access point or router.

When the setup is successful and the screen returns to Select Function, wireless LAN 
connection setting is completed.

To use WEP encryption:

a Select WEP, and then press the  button.

b Enter the WEP key, and then press the  button.

c Select the desired transmit key from WEP Key 1 to WEP Key 4, and then press the  
button.

When the setup is successful and the screen returns to Select Function, wireless LAN 
connection setting is completed.
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9 Select WEP for the encryption type.

IMPORTANT: 

• Be sure to use one of the supported encryption methods to protect your network traffic.

a Select WEP, and then press the  button.

b Enter the WEP key, and then press the  button.

c Select the desired transmit key from WEP Key 1 to WEP Key 4, and then press the  
button.

When the setup is successful and the screen returns to Select Function, wireless LAN 
connection setting is completed.
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Setting the IP Address (for IPv4 Mode) (DocuPrint 
CM215 f/CM215 fw Only)

This section describes how to set an IP address of the printer in IPv4 mode.

NOTE: 

• When you set an IP address in IPv6 mode, use the CentreWare Internet Services. For more information, refer 
to the Help on the CentreWare Internet Services. To display the CentreWare Internet Services, use a link local 
address. The printer's link local address is listed in the System Settings page. See "Printing and Checking the 
System Settings Page" on page 88.

This section includes:

• "Printer's TCP/IP and IP Addresses" on page 83

• "Dynamic Methods of Setting the Printer’s IP Address" on page 84

• "Assigning an IP Address Manually" on page 85

• "Verifying the IP Settings" on page 87

• "Printing and Checking the System Settings Page" on page 88

Printer's TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP 
addresses and additional system settings information. 

If you are creating your own small Local Area Network or connecting the printer directly to your 
computer using Ethernet, follow the procedure for automatically setting the printer’s IP address. 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
With TCP/IP protocols, each printer and computer must have a unique IP address. It is important that 
the addresses are similar, but not the same; only the last digit needs to be different. For example, your 
printer can have the address 192.168.1.2 while your computer has the address 192.168.1.3. Another 
device can have the address 192.168.1.4.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically programs an IP address into every computer and printer on the network that is 
configured to use DHCP. A DHCP server is built into most cable and Digital Subscriber Line (DSL) 
routers. If you use a cable or DSL router, see your router’s documentation for information on IP 
addressing.
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Dynamic Methods of Setting the Printer’s IP Address
The DHCP and AutoIP protocols are available for dynamically setting the printer’s IP address. They 
are enabled by default in your printer.

You can turn on/off both protocols using the operator panel or the CentreWare Internet Services.

NOTE: 
• You can print a report that includes the printer’s IP address. For more information, refer to "Printing and 

Checking the System Settings Page" on page 88.

Using the Operator Panel

1 On the operator panel, press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP/AutoIP, and then press the  button.

8 Turn off and turn on the printer.

Using the CentreWare Internet Services

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Select Properties.

4 Select TCP/IP from the Protocol Settings folder on the left navigation panel.

5 In the IP Address Mode field under IPv4, select the DHCP/AutoIP option.

6 Click the Apply button.

7 Click the Reboot Machine button to restart the printer.
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Assigning an IP Address Manually

NOTE: 

• Assigning an IP address is considered as an advanced function and is normally done by a system 
administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for 
example, an IP address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment 
of IP addresses, contact your system administrator. 

You can assign the IP address by using the operator panel or using the Printer Setting Utility.

For Windows, you can also assign the IP address to the printer using the installer on the Software 
Pack CD-ROM.

Using the Operator Panel

1 On the operator panel, press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Network, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select Panel, and then press the  button.

8 Press the  (Back) button.

Confirm that Get IP Address is selected.

9 Select IP Address, and then press the  button.

The cursor is located at the first digit of the IP address.

10 Enter the value of the IP address using the numeric keypad.

11 Press the  button.

The next digit is selected.

12 Repeat steps 10 to 11 to enter all of the digits in the IP address, and then press the  button.

13 Press the  (Back) button.

Confirm that IP Address is selected.

14 Select Subnet Mask, and then press the  button.

The cursor is located at the first digit of the subnet mask.

15 Enter the value of the subnet mask using the numeric keypad.
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16 Press the  button.

The next digit is selected.

17 Repeat steps 15 to 16 to set subnet mask, and then press the  button.

18 Press the  (Back) button.

Confirm that Subnet Mask is selected.

19 Select Gateway Address, and then press the  button.

The cursor is located at the first three digit of the gateway address.

20 Enter the value of the gateway address using the numeric keypad.

21 Press the  button.

The next digit is selected.

22 Repeat steps 20 to 21 to set gateway address, and then press the  button.

23 Turn off and turn on the printer.

See also: 
• "Operator Panel" on page 48

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.

The TCP/IP Settings page is displayed.

4 Select Panel from IP Address Mode, and then enter the values in IP Address, Subnet Mask, 
and Gateway Address.

5 Click the Restart printer to apply new settings button to take effect.
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Using the Installer on the Software Pack CD-ROM (Windows Only)
You can assign the IP address to the printer when setting up the printer with the installer on the 
Software Pack CD-ROM.

When you use the Ethernet or the manual Wireless setup method, and Get IP Address is set to 
DHCP/AutoIP on the operator panel menu, the installer detects the printer by the automatically 
assigned IP address. You can set the IP address to the desired IP address by clicking the Advanced 
button on the Configure Printer screen while in the setup process.

See also: 
• "Dynamic Methods of Setting the Printer’s IP Address" on page 84

The IP address is assigned to your printer. To verify the setting, display the web browser on any 
computer connected to the network and enter the IP address into the address bar on the browser. If 
the IP address is set up correctly, the CentreWare Internet Services displays in your browser.

Verifying the IP Settings
You can confirm the settings by printing the System Settings page or using the ping command.

Printing the System Settings Page

1 Print the System Settings page.

See also: 

• "Printing and Checking the System Settings Page" on page 88

2 Look under the IPv4 heading on the Wired Network or Wireless Network section of the System 
Settings page to confirm that the IP address, subnet mask and gateway address are appropriate.

Using the Ping Command
To verify if the printer is active on the network, run the ping command in your computer.

The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Accessories → Run.

2 Enter "cmd", and then click OK.

A Command Prompt window is displayed.

3 Enter "ping xxx.xxx.xxx.xxx" (xxx.xxx.xxx.xxx is the IP address of your printer), and then press 
the Enter key.

Receiving the reply from the printer IP address means that the printer is appropriately connected 
to the network.
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Printing and Checking the System Settings Page
Print the System Settings page and check your printer's IP address.

Using the Operator Panel

1 Press the System button.

2 Select Report / list, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.

4 On the Wired Network or Wireless Network section of the System Settings page, confirm the 
IP address next to IP Address under the IPv4 heading. If the IP address is 0.0.0.0, wait for a few 
minutes to resolve the IP address automatically, and then print the System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address Manually" on 
page 85.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click the System Settings button.

The System Settings page is printed.

If the IP address is 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been 
assigned. 

See also: 
• "Assigning an IP Address Manually" on page 85
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Configuring Printer and Installing Software on 
Windows

This section includes:

• "Identifying Print Driver Pre-install Status (for Network Connection Setup) (DocuPrint CM215 
f/CM215 fw Only)" on page 89

• "Using Installer to Set Up Connection and Install Software" on page 91

• "Using Installer to Install Software" on page 94

• "Installing the XML Paper Specification (XPS) Print Driver" on page 95

• "Setting Up for Web Services on Devices (WSD) (DocuPrint CM215 f/CM215 fw Only)" on 
page 105

• "Setting Up for Shared Printing (DocuPrint CM215 f/CM215 fw Only)" on page 108

 Identifying Print Driver Pre-install Status (for Network 
Connection Setup) (DocuPrint CM215 f/CM215 fw Only)

Before installing the print driver on your computer, check the IP address of your printer and change 
the firewall settings.

This section includes:

• "Checking the IP Address for Your Printer" on page 89

• "Changing the Firewall Settings Before Installing Your Printer" on page 90

Checking the IP Address for Your Printer

1 Press the System button.

2 Select Report / list, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.

4 Find the IP address under Wired Network/Wireless Network on the System Settings page.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and 
then print the System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address Manually" on 
page 85.
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Changing the Firewall Settings Before Installing Your Printer
You may need to change the firewall settings before installing the printer software. Contact your 
network administrator for more information.

The following procedure uses Windows 7 as an example.

1 Insert the Software Pack CD-ROM into your computer.

2 Click Start → Control Panel.

3 Click System and Security.

4 Click Allow a program through Windows Firewall.

5 Click Change settings.

6 Click Allow another program.

7 Click Browse.

8 Enter "D:\setup.exe" (in case your optical disk drive is D) in the File name text box, and then 
click Open.

9 Click Add.

10 Click OK.
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Using Installer to Set Up Connection and Install Software

NOTE: 

• The following procedure sets up printer connection and then install the drivers and software. If you have 
already established printer connection, go to "Using Installer to Install Software" on page 94 to install the print 
driver and software immediately.

Launching the Printer Setup Screen

1 Insert the Software Pack CD-ROM into your computer to start the FX Printer Setup screen.

NOTE: 

• For Windows 8 and Windows Server® 2012, click on the message displayed on the upper right corner of 
the screen, and then select Run setup.exe.

• If the CD does not automatically launch, perform the following steps.

a For Windows XP, Windows Server 2003, Windows Server 2008 and Windows Server 2008 R2, click Start (start for 

Windows XP) → Run.

For Windows Vista® and Windows 7, click Start → All Programs → Accessories → Run.

For Windows 8 and Windows Server 2012, right-click on the Start screen and click All apps → Run.

b Enter "D:\setup.exe" (in case your optical disk drive is D), and then click OK.

2 Click the Setup Printer and Install Software button.

3 If you agree to the terms of the License Agreement, choose I accept the terms of the license 
agreement, and then click Next.
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4 Select a connection method to the printer.

For the wireless connection, go to "Configuring Wireless Connection Settings (DocuPrint CM215 
fw Only)" on page 92.

For the USB connection, go to "Configuring USB Connection Settings" on page 93.

For the Ethernet connection, go to "Configuring Ethernet Connection Settings (DocuPrint CM215 
f/CM215 fw Only)" on page 93.

Configuring Wireless Connection Settings (DocuPrint CM215 fw 
Only)

1 Confirm that the printer is turned on and the  (Wi-Fi) LED is blinking.

2 Click the Wireless button on the Select a connection Method screen.

3 Software automatically detects your network.

If the Press "WPS" button on Printer and WPS button on Router screen is displayed, follow 
the steps displayed on the screen.

In case the WPS button is not available on your router or you want to set up manually, click 
Manual settings and follow the instructions displayed on the screen.

4 Confirm SSID and Printer Name on the screen, and then click Next.

Software automatically detects your printer and installs required driver and software.

5 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click 
Print Test Page to print a test page.
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Configuring USB Connection Settings

1 Confirm that the USB cable is connected to the computer and the printer, and the printer is 
turned on.

NOTE: 

• For Windows XP or Windows Vista, if Found New Hardware Wizard appears, click Cancel at this time.

2 Click the USB button on the Select a connection Method screen.

The Plug and Play installation starts and the required driver and software are automatically 
installed.

3 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click 
Print Test Page to print a test page.

Configuring Ethernet Connection Settings (DocuPrint CM215 
f/CM215 fw Only)

1 Click the Ethernet button on the Select a connection Method screen.

2 Connect the Ethernet cable to the printer and turn on the printer, and then click Next.

3 Select a printer you want to install from the Printer list, and then click Next.

If the target printer is not displayed on the Printer list, click the Refresh button to refresh the list 
or click Enter IP Address to add a printer manually.
In Enter IP Address, enter assigned IP address to the printer manually, and then click OK.

NOTE: 

• If the target printer is not displayed on the list, ensure Ethernet cable is correctly inserted to the printer 
and the router, and also confirm the printer IP address is properly appointed.

4 Confirm IP Mode and Type, and then click Next.

If you want to change the printer's IP address settings, click Advanced and configure the items 
on the Configure Printer screen. Especially if you want to set up printer with fixed IP, select Use 
Manual Address from Type.

5 Check and configure the printer information such as a printer name, default printer/scanner 
settings, printer sharing setting, specify whether to install the fax driver, and then click Next.

6 Select the check box of the software and documentation you want to install, and then click 
Install.

7 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click 
Print Test Page to print a test page.
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Using Installer to Install Software
If the printer connection via USB/Ethernet/Wireless is already configured and you want to perform the 
driver and software installation only, follow the procedure below.

If you have executed the steps in "Using Installer to Set Up Connection and Install Software" on 
page 91, the following procedure is not necessary. 

1 Click the Install Software button.

2 If you agree to the terms of the License Agreement, choose I accept the terms of the license 
agreement, and then click Next.

3 Choose an installation type, and then click Next.

For the printer connected to your computer Using the USB cable, select Personal Installation.

For the printer connected to a wired or wireless network, select Network Installation.

4 Follow the instructions displayed on the screen to complete the installation.
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 Installing the XML Paper Specification (XPS) Print Driver
This section describes how to install the XML Paper Specification (XPS) print driver using the 
Windows Add Printer wizard.

NOTE: 

• The XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, 
Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 
2008 R2, Windows 7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, and Windows Server 
2012.

Getting the Driver File

1 Insert the Software Pack CD-ROM into your computer.

2 Extract the zip file in the following path to your desired location.

D:\Drivers\XPS\Win_7Vista or Win_8 (in case your optical disk drive is D)
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Installing the Print Driver

• USB Connection Setup

Windows Vista or Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box 
displayed under the Printer name.

11 Click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to 
continue the desired action.

12 Upon completion of the driver installation, click Print a test page to print a test page.

13 Click Finish.
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Windows Server 2008 or Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

11 Click Next.

Installation starts.

12 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find 
and use it.

13 Click Next.

14 Upon completion of the driver installation, click Print a test page to print a test page.

15 Click Finish.
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Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue 
the desired action.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find 
and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 Upon completion of the driver installation, click Print a test page to print a test page.

15 Click Finish.
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Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

2 Click Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

3 Click Add a printer.

4 Click The printer that I want isn't listed.

5 Select Add a local printer or network printer with manual settings, and then click Next.

6 Select the port connected to your printer, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue 
the desired action.

13 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find 
and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to print a test page.

17 Click Finish.
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• Network Connection Setup

Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP 
address box, and then click Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to 
continue the desired action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 Upon completion of the driver installation, click Print a test page to print a test page.

15 Click Finish.
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Windows Server 2008 and Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP 
address box, and then click Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to 
continue the desired action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share 
this printer so that others on your network can find and use it.

15 Click Next.

16 Upon completion of the driver installation, click Print a test page to print a test page.

17 Click Finish.
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Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

NOTE: 

• If you click The printer that I want isn't listed, the Find a printer by name or TCP/IP address screen 
appears. Find your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to 
continue the desired action.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share 
this printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 Upon completion of the driver installation, click Print a test page to print a test page.

15 Click Finish.
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Windows 7 and Windows 7 64-bit Edition

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP 
address box, and then click Next.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue 
the desired action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

13 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share 
this printer so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to print a test page.

17 Click Finish.
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Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

2 Click Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

3 Click Add a printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP 
address box, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver 
File" on page 95.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue 
the desired action.

13 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share 
this printer so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to print a test page.

17 Click Finish.
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Setting Up for Web Services on Devices (WSD) 
(DocuPrint CM215 f/CM215 fw Only)

This section provides information for network printing with WSD, the Microsoft protocol for Windows 
Vista, Windows Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, and Windows Server 
2012.

NOTE: 

• WSD stands for Web Services on Devices.

This section includes:

• "Adding Roles of Print Services" on page 105

• "WSD Printer Setup" on page 106

Adding Roles of Print Services
When you use Windows Server 2008, Windows Server 2008 R2, or Windows Server 2012, you need 
to add the roles of print services to the Windows Server 2008, Windows Server 2008 R2, or Windows 
Server 2012 client.

• For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print and Document Services check box on the Server Roles window in the Add 
Roles Wizard, and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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• For Windows Server 2012:

1 On the Start screen, click Server Manager.

2 Click Add roles and features to start Add Roles and Features Wizard.

3 Specify the settings and click Next until the Select server roles screen is displayed.

4 Select the Print and Document Services check box.

5 On the pop-up window, click Add Features.

6 Click Next.

7 Click Next on the Select features screen.

8 Check the explanation for Print and Document Services and click Next.

9 Select the Print Server check box, and then click Next.

10 Click Install.

WSD Printer Setup
You can install your new printer on the network using Windows Add Printer wizard. When installing 
using the Software Pack CD-ROM that shipped with your printer, see "Using Installer to Set Up 
Connection and Install Software" on page 91.

• Installing a Print Driver Using the Add Printer Wizard

1 For Windows 7 and Windows Server 2008 R2, click Start → Devices and Printers.

For Windows Vista, click Start → Control Panel → Hardware and Sound → Printers.

For Windows Server 2008, click Start → Control Panel → Printer.

For Windows 8, on the Desktop screen, place the mouse pointer in the upper right corner of the 
screen and move the mouse down, and then select Settings. Click Control Panel → Hardware 
and Sound → Devices and Printers.

For Windows Server 2012, on the Desktop screen, place the mouse pointer in the upper right 
corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
→ Hardware → Devices and Printers.

2 Click Add a printer to launch the Add Printer Wizard.

For Windows 8 and Windows Server 2012, go to step 4.

3 Select Add a network, wireless or Bluetooth printer.
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4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 

• In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/. 

• If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. 
To enter the printer's IP address manually, follow the instructions below.
To create a WSD printer, you must be a member of Administrators group.

1 Click The printer that I want isn't listed.

2 Select Add a printer using a TCP/IP address or hostname and click Next.

3 Select Web Services Device from Device type.

4 Enter the printer's IP address in the Hostname or IP address text box and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, add 
the print driver to your computer.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator 
password or confirmation, type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify printer installation.

a Open the Devices and Printers or Printers folder by performing step 1.

b Right-click the printer you just created, and then click Printer properties (Properties for 
Windows Vista and Windows Server 2008).

c On the General tab, click Print Test Page. When a test page is printed successfully, the 
installation is complete.
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Setting Up for Shared Printing (DocuPrint CM215 
f/CM215 fw Only)

You can share your new printer on the network using the Software Pack CD-ROM that shipped with 
your printer, or using Windows Point and Print or peer-to-peer method. 

This section describes Point and Print and peer-to-peer methods. Configure the printer sharing 
settings on the server computer, and then install its driver on all the client computers that use the 
shared printer using Point and Print or peer-to-peer method. Using either of the methods, however, 
you will not be able to use features such as the SimpleMonitor and other printer utilities, which will be 
installed from the Software Pack CD-ROM.

NOTE: 

• You need to purchase an Ethernet cable separately for shared printing.

Configuring the Sharing Settings of Your Printer

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click this printer icon and select Properties.

3 From the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.

If the files are not present in your computer, and then you will be prompted to insert the server 
operating system CD.

6 Click Apply, and then click OK.
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click the Change sharing options button.

The "Windows needs your permission to continue" appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in the Share name text box.

6 Select Additional Drivers and select the operating systems of all network clients using this 
printer.

7 Click OK.

8 Click Apply, and then click OK.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.

6 Click Apply, and then click OK.
Printer Connection and Software Installation 109



• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

2 Click Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

3 Right-click the printer icon and select Printer properties.

4 On the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients that print to the 
printer.

6 Click OK.

7 Click Apply, and then click OK.

To check that the printer is shared:

• Make sure that the printer object in the Printers, Printers and Faxes or Devices and Printers 
folder is shared. The share icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and look for the 
shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the Point and Print 
method or the peer-to-peer method.
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Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This 
feature automatically downloads and installs the print driver.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and 
for a new printer object to be added to the Printers and Faxes folder. The time taken to copy 
varies based on the network traffic.

4 Close My Network Places.

5 Print a test page to verify installation.

a Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers 
and Faxes.

b Select the printer you have installed.

c Click File → Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Network.

2 Locate and double-click the host name of the server computer.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

Wait until the driver is copied from the server to the client computer. A new printer object is added 
to the Printers folder. The duration of this procedure may vary based on the network traffic.

6 Print a test page to verify installation.

a Click Start → Control Panel → Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be 
added to the Printers folder. The time taken for these activities varies based on network traffic.

6 Print a test page to verify installation.

a Click Start → Control Panel.

b Select Hardware and Sound.

c Select Printers.

d Right-click the printer you just created and select Properties.

e On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Computer → Network (Start → Network for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be 
added to the Devices and Printers folder. The time taken for these activities varies based on 
network traffic.

6 Print a test page to verify installation.

a Click Start → Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.
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• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

2 Click Control Panel → Network and Internet → View network computers and devices.

3 Locate the host name of the server computer, and then double-click the host name.

4 Right-click the shared printer name, and then click Connect.

5 Click Install driver.

6 Wait until the driver is copied from the server to the client computer. A new printer object will be 
added to the Devices and Printers folder. The time taken for these activities varies based on 
network traffic.

7 Print a test page to verify installation.

a On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

b Click Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → 
Devices and Printers.

c Right-click the printer you just created and select Printer properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.
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Peer-to-Peer
Peer-to-Peer is a technology that allows you to connect to a printer connected to a host computer. You 
are required to download and install the print driver during the connection set up.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers and 
Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003/Windows Server 2003 x64 Edition) 
to launch the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. 

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next. 

If the printer is not listed, click Back and enter in the path of the printer in the text box.

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

7 Select Yes if you want this printer to be set as the default printer, and then click Next.

8 Click Finish.

For example: \\<server host name>\<shared printer name>
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

4 Perform the following as required, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

5 Click Finish.

If a test page is printed successfully, the installation is complete.

For example: \\<server host name>\<shared printer name>
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. 
The shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

4 Perform the following as required, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

5 Click Finish.

If a test page is printed successfully, the installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you need to specify the path to the available drivers.

4 Perform the following as required, and then click Finish.

• Click Set as the default printer to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

If a test page is printed successfully, the installation is complete.

For example: \\<server host name>\<shared printer name>
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• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and 
move the mouse down, and then select Settings.

2 Click Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

3 Click Add a printer to launch the Add Printer wizard.

4 If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

The server host name is the name that identifies the server computer on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no print drivers are 
available, you will need to provide a path to your print driver.

5 Confirm the printer name, and then click Next.

6 Perform the following as required, and then click Finish.

• Click Set as the default printer to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

If a test page is printed successfully, the installation is complete.

For example: \\<server host name>\<shared printer name>
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Configuring Printer and Installing Software on Mac 
OS X

This section includes:

• "Installing Software" on page 120

• "Adding a Printer" on page 121

 Installing Software

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CD-ROM icon displayed on the desktop.

3 Double-click the installer icon.

NOTE: 

• For the Mac OS X 10.4.11, click Continue on the confirmation message.

4 Click Continue on the Introduction screen.

5 Select a language for the Software License Agreement.

6 After reading the Software License Agreement, click Continue.

7 If you agree to the terms of the Software License Agreement, click Agree to continue the 
installation process.

NOTE: 

• When the screen to select the installation destination appears, select an installation location and click 
Continue.

8 Click Install to perform the standard installation. 

9 Enter the administrator's name and password, and then click OK (Install Software for Mac OS X 
10.7-10.8).

10 Click Continue Installation.

11 Click Restart to complete the installation.
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Adding a Printer

Adding a Printer on Mac OS X 10.7/10.8

• When Using a USB connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Display System Preferences, and then click Print & Scan.

4 Confirm your USB printer is added to Print & Scan.

If your USB printer is not displayed, execute the following procedures.

5 Click the plus (+) sign, and then click Default.

6 Select the printer connected via USB from the Printer Name (Name for Mac OS X 10.8) list.

Name, Location, and Print Using (Use for Mac OS X 10.8) are automatically entered.

7 Click Add.

• When Using Bonjour (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Display System Preferences, and then click Print & Scan.

4 Click the plus (+) sign, and select the printer from Nearby Printers. The printer will be added to 
Print & Scan.

If there are no printers in Nearby Printers, select Add Other Printer or Scanner (Add Printer 
or Scanner for Mac OS X 10.8), and then click Default. Proceed to step 5.

5 Select the printer connected via Bonjour from the Printer Name (Name for Mac OS X 10.8) list.

Name and Print Using (Use for Mac OS X 10.8) are automatically entered.

6 Click Add.
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• When Using IP Printing (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Display System Preferences, and then click Print & Scan.

4 Click the plus (+) sign, and then click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Print Using (Use for Mac OS X 10.8).

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 
specify it.

8 Click Add.

Adding a Printer on Mac OS X 10.5.8/10.6

• When Using a USB connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Display System Preferences, and then click Print & Fax.

4 Confirm your USB printer is added to Print & Fax in System Preferences.

If your USB printer is not displayed, execute the following procedures.

5 Click the plus (+) sign, and then click Default.

6 Select the printer connected via USB from the Printer Name list.

Name, Location, and Print Using are automatically entered.

7 Click Add.
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• When Using Bonjour (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click Default.

5 Select the printer connected via Bonjour from the Printer Name list. 

Name and Print Using are automatically entered.

6 Click Add.

• When Using IP Printing (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Print Using.

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 
specify it.

8 Click Add.
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Adding a Printer on Mac OS X 10.4.11

• When Using a USB Connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Start Printer Setup Utility.

NOTE: 

• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Confirm your USB printer is added to Printer List.

If your USB printer is not displayed, execute the following procedures.

5 Click Add.

6 Click Default Browser in the Printer Browser dialog box.

7 Select the printer connected via USB from the Printer Name list.

Name, Location and Print Using are automatically entered.

8 Click Add.

• When Using Bonjour (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Start Printer Setup Utility.

NOTE: 

• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via Bonjour from the Printer Name list.

Name and Print Using are automatically entered.

7 Click Add.
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• When Using IP Printing (DocuPrint CM215 f/CM215 fw Only)

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer 
and the network.

If you use wireless connection, make sure that wireless connection is configured properly on 
your computer and printer.

3 Start Printer Setup Utility.

NOTE: 

• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click IP Printer in the Printer Browser dialog box.

6 Select Line Printer Daemon - LPD for Protocol.

7 Enter the IP address of the printer in the Address area.

8 Select FX for Print Using, and then select the model of your printer.

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 
specify it. 

9 Click Add.
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5
Printing Basics

This chapter includes:

• "About Print Media" on page 128

• "Supported Print Media" on page 131

• "Loading Print Media" on page 133

• "Setting Paper Sizes and Types" on page 152

• "Printing" on page 153
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About Print Media

This section includes:

• "Print Media Usage Guidelines" on page 128

• "Automatic Document Feeder (ADF) Guidelines (DocuPrint CM215 f/CM215 fw Only)" on 
page 129

• "Print Media That Can Damage Your Printer" on page 130

• "Print Media Storage Guidelines" on page 130

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failure. To achieve the best performance from your printer, we recommend you to use only the 
paper described in this section.

When using paper other than that recommended, contact the Fuji Xerox local representative office or 
an authorized dealer.

Print Media Usage Guidelines
The printer tray accommodates various sizes and types of paper and other specialty media. Follow 
these guidelines when loading paper and media:

• Envelopes can be printed from the multipurpose feeder (MPF) and priority sheet inserter (PSI).

• Fan paper or other specialty media before loading in the tray.

• Do not print on label stock once a label has been removed from a sheet.

• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 
release strips.

• Print all envelopes single-sided only. 

• Some wrinkling and embossing may occur when printing envelopes.

• Do not overload the tray. Do not load print media above the fill line on the inside of the paper 
width guides.

• Adjust the paper width guides to fit the paper size.

• If excessive jams occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 139

• "Loading Envelope in the Priority Sheet Inserter (PSI)" on page 144

• "Printing on Custom Size Paper" on page 162

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Automatic Document Feeder (ADF) Guidelines 
(DocuPrint CM215 f/CM215 fw Only)

The ADF accommodates the following original sizes:

• Width: 148–215.9 mm (5.83–8.50 inches)

• Length: 210–355.6 mm (8.27–14.00 inches)

The weight range includes 60–105 gsm.

Follow these guidelines when loading original documents into the ADF:

• Load documents face up so that the top of the document enters the printer first.

• Place only loose sheets of paper in the ADF.

• Adjust the document guides so that they fit against the documents.

• Insert paper in the document feeder tray only when the ink on the paper is completely dry.

• Do not load documents above the MAX fill line. You can load up to 15 sheets of 64 gsm 
documents.

NOTE: 

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can 
cause poor output quality, increased paper jams, or damage to your printer.

Unacceptable media includes:

• Rough or porous media

• Plastic media

• Paper that has been folded or wrinkled

• Paper with staples

• Envelopes with windows or metal clasps

• Padded envelopes

• Non-laser glossy or coated paper

• Perforated media

Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.

• Avoid attics, kitchens, garages, and basements for storing print media. 

• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.

• Avoid having food or drinks in the area where print media is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 
paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags. 

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Supported Print Media

Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of this printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 

• The toner may come off the print media if it gets wet by water, rain, steam and so on. For details, contact the 
Fuji Xerox local representative office or an authorized dealer.

Usable Print Media
The types of print media that can be used on this printer are as follows:

Multipurpose Feeder (MPF)

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Legal SEF (8.5 × 14 inches)

Folio SEF (8.5 × 13 inches)

Executive SEF (7.25 × 10.5 inches)

C5 SEF (162 × 229 mm)

Monarch SEF (3.875 × 7.5 inches)

Monarch LEF (7.5 × 3.875 inches)*

Com 10 SEF (4.125 × 9.5 inches)

DL SEF (110 × 220 mm)

DL LEF (220 × 110 mm)*

Custom size:

Width: 76.2–215.9 mm (3–8.5 inches)

Length: 127–355.6 mm (5 –14 inches)

Paper Type Plain (60 -90 gsm)

Bond (91 -105 gsm)

Lightweight Cardstock (106 -163 gsm)

Lightweight Glossy Cardstock (106 -163 gsm)

Envelope

Labels

Recycled (60 -105 gsm)

Loading Capacity 150 sheets of standard paper

*: Monarch and DL can be supported by LEF with their flap open.
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Priority Sheet Inserter (PSI)

NOTE: 

• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-
edge feed.

• Use only laser print media. Do not use ink jet paper in this printer.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 139

• "Loading Envelope in the Priority Sheet Inserter (PSI)" on page 144

Printing on print media that differs from the paper size or paper type selected on the print driver may 
lead to paper jams. To make sure that printing is correctly done, select the correct paper size and 
paper type.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Legal SEF (8.5 × 14 inches)

Folio SEF (8.5 × 13 inches)

Executive SEF (7.25 × 10.5 inches)

C5 SEF (162 × 229 mm)

Monarch SEF (3.875 × 7.5 inches)

Com 10 SEF (4.125 × 9.5 inches)

DL SEF (110 × 220 mm)

Custom size:

Width: 76.2–215.9 mm (3–8.5 inches)

Length: 190.5–355.6 mm (7.5 –14 inches)

Paper Type Plain (60 -90 gsm)

Bond (91 -105 gsm)

Lightweight Cardstock (106 -163 gsm)

Lightweight Glossy Cardstock (106 -163 gsm)

Envelope

Labels

Recycled (60 -105 gsm)

Loading Capacity 10 sheets of standard paper
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Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is 
usually on the print media package.

NOTE: 

• After loading paper in the feeder, specify the same paper type on the operator panel.

This section includes:

• "Capacity" on page 133

• "Print Media Dimensions" on page 133

• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

• "Manual Duplex Printing" on page 147

• "Using the Output Tray Extension" on page 151

Capacity
The MPF can hold:

• 150 sheets of standard paper

• 16.2 mm (0.64 inches) of thick paper

• One sheet of coated paper

• Five envelopes

• 16.2 mm (0.64 inches) of labels

The PSI can hold:

• 10 sheets of standard paper or one sheet of other paper

Print Media Dimensions
The MPF accepts print media within the following dimensions: 

• Width: 76.2–215.9 mm (3.00–8.50 inches)

• Length: 127–355.6 mm (5.00–14.00 inches)

The PSI accepts print media within the following dimensions: 

• Width: 76.2–215.9 mm (3.00–8.50 inches)

• Length: 190.5–355.6 mm (7.50–14.00 inches)
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Loading Print Media in the Multipurpose Feeder (MPF)

NOTE: 

• To avoid paper jams, do not remove the priority sheet inserter (PSI) while printing is in progress.

• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

NOTE: 

• When you use the MPF for the first time, open the front cover by pulling out the instruction sheet.
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2 Pull the PSI out.

NOTE: 

• When you use the MPF for the first time, remove the instruction sheet attached to the PSI with adhesive 
tape.

• Read the instruction sheet before you use the PSI.

3 Pull the slide bar forward until it stops.

4 Pinch the length guide and pull it forward until it stops.
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5 Adjust the paper width guides to their maximum width.

6 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.

7 Load print media on the MPF with the top edge first and with the recommended print side facing 
up.
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8 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.

9 Pinch the length guide and slide it towards the printer until it touches the print media.

NOTE: 

• Depending on the size of print media, first slide the slide bar backward until it stops, and then pinch the 
length guide and slide it backward until it touches print media.
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10 Insert the PSI into the printer and then align the PSI to the marking on the MPF.

11 Select the paper type from the print driver if the loaded print media is not plain paper. If a user-
specified print media is loaded in the MPF, you must specify the paper size setting by using the 
print driver.

NOTE: 

• For more information about setting the paper size and type on the print driver, refer to the Help provided 
for the print driver.

NOTE: 

• For standard-size paper, adjust the length guide and paper width guides first and then set paper.
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Loading Envelope in the Multipurpose Feeder (MPF)

NOTE: 

• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 
print image will be rotated 180 degrees.

• When Loading Com 10, DL, or Monarch
Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned 
to the right.

To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the print-
side facing up, flap opened, and facing you.

NOTE: 

• When you load the envelopes in the long-edge feed (LEF) orientation, be sure to specify the landscape 
orientation on the print driver.
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• When Loading C5
Load envelopes with the side to be printed on facing up, flap opened and facing you.

IMPORTANT: 

• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer.

NOTE: 

• If you do not load envelopes in the MPF right after they have been removed from the packaging, they may 
bulge. To avoid jams, flatten them as shown below when loading them in the MPF.
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• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.

• To confirm the correct orientation of envelopes, see the instruction on the Envelope/Paper Setup Navigator on 
the print driver.
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Loading Print Media in the Priority Sheet Inserter (PSI)

NOTE: 

• To avoid paper jams, do not remove the PSI while printing is in progress.

• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

2 Slide the PSI forward, and then align the PSI to the marking on the MPF.

3 Adjust the paper width guides to their maximum width.
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4 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.

5 Load print media on the PSI with the top edge first and with the recommended print side facing 
up.

6 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.

7 Select the paper type from the print driver if the loaded print media is not plain paper. If a user-
specified print media is loaded in the PSI, you must specify the paper size setting by using the 
print driver.

NOTE: 

• For more information about setting the paper size and type on the print driver, refer to the Help provided for 
the print driver.
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Loading Envelope in the Priority Sheet Inserter (PSI)

NOTE: 

• Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed.

• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 
print image will be rotated 180 degrees.

• When Loading Com 10, DL, or Monarch
Load the envelope with the side to be printed on facing up, the flap side facing down, and the flap 
turned to the right.
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• When Loading C5
Load the envelope with the side to be printed on facing up, flap opened and facing you.

IMPORTANT: 

• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 
printer.

NOTE: 

• If you do not load envelopes in the PSI right after they have been removed from the packaging, they may 
bulge. To avoid jams, flatten them as shown below when loading them in the PSI.
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• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.

• To confirm the correct orientation of envelopes, see the instruction on the Envelope/Paper Setup Navigator on 
the print driver.
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Manual Duplex Printing
This section includes:

• "Operations on Your Computer" on page 147

• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 149

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 150

NOTE: 

• When printing on curled paper, straighten the paper and then insert it into the feeder.

Operations on Your Computer

• Using the Windows Print Driver
The following procedure uses Microsoft® Windows® 7 as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 
software. Refer to the manual of your respective application software.

1 From the application menu, select Print.

2 Select the printer from the Select Printer list box, and then click Preferences.

The Paper/Output tab of the Printing Preferences dialog box appears.

3 From Duplex, select either Flip on Long Edge or Flip on Short Edge to define the way 2-sided 
print pages are bound.

4 From Paper Size, select the size of the document to be printed.

3

4

5
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5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

IMPORTANT: 

• When you start manual duplex printing, the instruction window appears. Note that the window cannot be 
reopened once it is closed. Do not close the window until duplex printing is complete.

• Using the Mac OS X Print Driver
The following procedure uses Mac OS X 10.8 TextEdit as an example.

1 From the File menu, select Print.

2 Select the printer from Printer.

3 From Paper Size, select the size of the document to be printed.

4 Select the Printer Features pane.

5 From Feature Sets, select Paper Handling.

6 From Paper Type, select the paper type to be used. 

7 From Duplex, select either Flip on Long Edge or Flip on Short Edge to define the way 2-sided 
print pages are bound.

8 Click Print in the Print dialog box to start printing.

4

5

6
7

148 Printing Basics



Loading Print Media in the Multipurpose Feeder (MPF)

1 First print the even pages (back sides).

For a six page document, back sides are printed in the order of page 6, page 4, then page 2.

The  (Data) LED blinks and the Insert Output to Tray message appears on the LCD 
panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 

• Warped or curled prints can cause paper jams. Straighten them before setting.

3 Stack the prints and set them as they are (with the blank side facing up) into the MPF, and then 
press the  button.

Pages are printed in the order of page 1 (back of page 2), page 3 (back of page 4), and then 
page 5 (back of page 6).

NOTE: 

• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Loading Print Media in the Priority Sheet Inserter (PSI)

1 First print the even pages (back sides).

For a six page document, back sides are printed in the order page 6, page 4, then page 2.

The  (Data) LED blinks and the Insert Output to Tray message appears on the LCD 
panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 

• Warped or curled prints can cause paper jams. Straighten them before setting.

3 Stack the prints and set them as they are (with the blank side face up) into the PSI, and then 
press the  button.

Pages are printed in order of page 1 (back of page 2), page 3 (back of page 4), and then page 5 
(back of page 6).

NOTE: 

• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print 
job is complete.

Before printing a long length document, make sure that the output tray extension is fully extended.

NOTE: 

• When you pull out envelopes or small size print media from the center output tray, lift up the scanner.
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Setting Paper Sizes and Types

When loading print media, set the paper size and type on the operator panel before printing.

This section describes how to set the paper size and type on the operator panel.

See also: 
• "Understanding the Printer Menus" on page 274

Setting Paper Sizes

1 Press the System button.

2 Select Tray Settings, and then press the  button.

3 Select MPF, and then press the  button.

4 Select Paper Size, and then press the  button.

5 Select the correct paper size for the print media loaded, and then press the  button.

Setting Paper Types

IMPORTANT: 

• Paper type settings must match those of the actual print media loaded in the tray. Otherwise, print-quality 
problems can occur.

1 Press the System button.

2 Select Tray Settings, and then press the  button.

3 Select MPF, and then press the  button.

4 Select Paper Type, and then press the  button.

5 Select the correct paper type for the print media loaded, and then press the  button.
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Printing

This section covers how to print documents from your printer and how to cancel a job.

This section includes:

• "Printing from the Computer" on page 153

• "Canceling a Print Job" on page 154

• "Selecting Printing Options" on page 156

• "Printing on Custom Size Paper" on page 161

• "Checking Status of Print Job" on page 163

• "Printing a Report Page" on page 164

• "Printer Settings" on page 165

Printing from the Computer
Install the print driver to use all the features of the printer. When you choose Print from an application, 
a window representing the print driver opens. Select the appropriate settings for the file to print. Print 
settings selected from the driver have precedence over the default menu settings selected from the 
operator panel or the Printer Setting Utility.

Printing from the Computer (Windows)
Clicking Properties/Preferences from the initial Print dialog box enables you to change the print 
settings. If you are not familiar with a feature in the print driver window, open the Help for more 
information.

To print a job from a typical Windows application:

1 Open the file you want to print.

2 From the application menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the print settings as needed 
(such as the pages you want to print or the number of copies).

4 To adjust print settings not available from the first screen, such as Paper Size, Paper Type, or 
MPF Orientation, click Preferences.

The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Printing from the Computer (Mac OS X)
The following procedure uses Mac OS X 10.8 TextEdit as an example.

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in Printer. Modify the system settings as needed (such 
as the pages you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Pages per Sheet, Output 
Color, or Paper Type, select the desired pane from the drop-down menu.

5 Specify the print settings. For more information, click the ? button.

6 Click Print to send the job to the selected printer.

Canceling a Print Job
There are several methods for canceling a print job.

Canceling a Print Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Stop) button.

NOTE: 

• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Print Job From the Computer (Windows)

• Canceling a Print Job From the Taskbar
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

4 Click Yes on the Printers dialog box to cancel a print job.
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• Canceling a Print Job From the Desktop

1 Minimize all programs to reveal the desktop.

For Windows XP, click start → Printers and Faxes.

For Windows Server® 2003, click Start → Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start → Devices and Printers.

For Windows Vista® and Windows Server 2008, click Start → Control Panel → Hardware and 
Sound → Printers.

For Windows 8, on the Desktop screen, place the mouse pointer in the upper right corner of the 
screen and move the mouse down, and then select Settings. Click Control Panel → Hardware 
and Sound → Devices and Printers.

For Windows Server 2012, on the Desktop screen, place the mouse pointer in the upper right 
corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
→ Hardware → Devices and Printers.

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.

A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.

5 Click Yes on the Printers dialog box to cancel a print job.

Canceling a Print Job From the Computer (Mac OS X)

• Canceling a Print Job From the Dock
When you send a job to print, a printer icon appears in the Dock.

1 Click the printer dock icon.

The print queue appears.

2 Select the job you want to cancel.

3 For Mac OS X 10.4.11-10.7, click Delete.

For Mac OS X 10.8, click the X button.
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• Canceling a Print Job From System Preferences

1 For Mac OS X 10.4.11-10.6, display System Preferences, and then click Print & Fax.

For Mac OS X 10.7-10.8, display System Preferences, and then click Print & Scan.

2 Select the printer from the printer list on the left.

3 For Mac OS X 10.4.11, click Print Queue.

For Mac OS X 10.5-10.8, click Open Print Queue.

4 Select the job you want to cancel.

5 For Mac OS X 10.4.11-10.7, click Delete.

For Mac OS X 10.8, click the X button.

Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 156

• "Selecting Options for an Individual Job (Windows)" on page 157

• "Selecting Options for an Individual Job (Mac OS X)" on page 159

Selecting Printing Preferences (Windows)
Printing preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex printing for most jobs, set this option in printing preferences.

To select printing preferences:

1 For Windows XP, click start → Printers and Faxes.

For Windows Server 2003, click Start → Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start → Devices and Printers.

For Windows Vista and Windows Server 2008, click Start → Control Panel → Hardware and 
Sound → Printers.

For Windows 8, on the Desktop screen, place the mouse pointer in the upper right corner of the 
screen and move the mouse down, and then select Settings. Click Control Panel → Hardware 
and Sound → Devices and Printers.

For Windows Server 2012, on the Desktop screen, place the mouse pointer in the upper right 
corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
→ Hardware → Devices and Printers.

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing Preferences.

The printer’s Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 

• For more information about Windows print driver options, click Help on the print driver tab to view the Help.
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Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting in the driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs.

NOTE: 

• In Windows, you can save current printing options with a distinctive name and apply them to other print 
jobs. Make selections on the Paper/Output, Graphics, Layout, or Watermarks/Forms tab, and then 
click Save under Favorites on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.

See the following table for specific printing options:

Printing Options for Windows

Driver Tab Printing Options

Paper/Output tab • Favorites

• Duplex

• Output Color

• Copies

• Collated

• Paper Summary

• Paper Size

• Paper Type

• MPF Orientation

• Envelope/Paper Setup Navigator

• Show Paper Size/Type Error

• Printer Status

• Restore Defaults

Graphics tab • Output Color

• Image Adjustment Mode

• Image Types

• Intent

• Screen

• Toner Saving Mode

• Image Settings

• Color Balance

• Profile Settings

• Restore Defaults
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Layout tab • Image Orientation

• Multiple Up

• Image Order

• Image Border

• Poster/Mixed Document

• Output Size

• Reduce / Enlarge

• Margin Shift/Margin

• Restore Defaults

Watermarks/Forms tab • Watermarks

– New Text

– New Bitmap

– Edit

– Delete

– First Page Only

• Forms

– Off

– Create / Register Forms

– Image Overlay

• Header / Footer Options

• Restore Defaults

Driver Tab Printing Options
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select your printer from Printer.

3 Select the desired printing options from the menus and drop-down list boxes that are displayed.

NOTE: 

• In Mac OS X, click Save As (Save Current Settings as Preset for Mac OS X 10.8) on the Presets 
menu screen to save the current printer settings. You can create multiple presets and save each with its 
own distinctive name and printer settings. To print jobs using specific printer settings, click the applicable 
saved preset in the Presets menu.

4 Click Print to print the job.

Mac OS X Print Driver Printing Options:

The table shown below uses Mac OS X 10.8 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options

• Copies

• Pages

• Paper Size

• Orientation

Layout • Pages per Sheet

• Layout Direction

• Border

• Reverse page orientation (for Mac OS X 10.5 or later)

• Flip horizontally (for Mac OS X 10.6 or later)

Color Matching • ColorSync

• Vendor Matching

Paper Handling • Collate pages

• Pages to Print

• Page Order

• Scale to fit paper size

• Destination Paper Size

• Scale down only

Cover Page • Print Cover Page

• Cover Page Type

• Billing Info
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Image Options • Output Color

• Image Quality

• Brightness

• Image Types

• Screen

• Color Balance

Printer Features • Detailed Settings

– Image Rotation (180deg)

– Toner Saving Mode

• Paper Handling

– Paper Type

– Duplex

– Show Paper Size/Type Error

• Printer Specific Options

– Skip Blank Pages

Item Printing Options
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Printing on Custom Size Paper
This section explains how to print on custom size paper using the print driver.

The way to load custom size paper is the same as the one to load standard size paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

• "Setting Paper Sizes and Types" on page 152

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 

• When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the 
actual print media used. Setting the wrong size for printing can cause printer failure. This is especially true if 
you configure a bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows 7 as an example.

An administrator’s password only allows users with administrator rights to change the settings. Users 
without the rights of administrator can only view the contents.

1 Click Start → Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Change Setting For. You can specify 
the values either by entering them directly or using the up arrow and down arrow buttons. The 
length of the short edge cannot be longer than the long edge even if it is within the specified 
range. The length of the long edge cannot be shorter than the short edge even if it is within the 
specified range.

7 To assign a paper name, select the Name the Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.
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Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.

• Using the Windows Print Driver
This section explains the procedure using Windows 7 as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 
software. Refer to the manual of your respective application software.

1 From the application menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 Select the size of the document to be printed from Paper Size.

5 Select the paper type to be used from Paper Type.

6 Click the Layout tab.

7 From Output Size, select the custom size you defined. If you have selected the custom size from 
Paper Size in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.8 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select your printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.

A newly created setting "Untitled" is displayed in the list.

5 Double-click "Untitled" and enter a name for the setting.

6 Enter the size of the document to be printed in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Click Print to start printing.
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Checking Status of Print Job

Checking Status via the SimpleMonitor (Windows Only)
You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon 
on the taskbar at the bottom right of the screen. The Printer Selection window appears, which 
displays the printer name, printer connection port, printer status, and model name. Check the column 
Status to know the current status of your printer.

Settings button: Displays the Settings window and allows you to modify the SimpleMonitor settings.

Click the name of the desired printer listed on the Printer Selection window. The Printer Status 
window appears. You can check the printer status and print job status.

For more information about the SimpleMonitor, see Help. The following procedure uses Windows 7 as 
an example:

1 Click Start → All Programs.

2 Select Fuji Xerox.

3 Select Fuji Xerox Printer Software for Asia-Pacific.

4 Select your printer.

5 Select SimpleMonitor-Btype for Asia-Pacific.

The Printer Selection window appears.

6 Click the name of the desired printer from the list.

The Printer Status window appears.

7 Click Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 59

Checking Status via the CentreWare Internet Services (DocuPrint 
CM215 f/CM215 fw Only)
You can check the status of the print job sent to the printer at the Jobs tab of the CentreWare Internet 
Services.

See also: 
• "CentreWare Internet Services (DocuPrint CM215 f/CM215 fw Only)" on page 57
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Printing a Report Page
You can print a various types of reports and lists. For details on each report and list, see "Report / List" 
on page 274.

Taking the System Settings page as an example, this section describes how to print a report page.

Printing a System Settings Page
To verify detailed printer settings, print a System Settings page.

Using the Operator Panel

NOTE: 

• The reports and lists are all printed in English.

1 Press the System button.

2 Select Report / List, and then press the  button.

3 Select System Settings, and then press the  button.

The System Settings page is printed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

NOTE: 

• The reports and lists are all printed in English.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click System Settings.

The System Settings page is printed.
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Printer Settings
This section includes:

• "Using the Operator Panel to Change the Printer Settings" on page 165

• "Using the Printer Setting Utility to Change the Printer Settings (Windows Only)" on page 166

• "Adjusting the Language" on page 166

Using the Operator Panel to Change the Printer Settings
You can select menu items and corresponding values from the operator panel.

When you first enter the menus from the operator panel, you see a list of menu items. The value 
displayed on the right of each menu item is the factory default menu setting. These settings are the 
original printer settings.

NOTE: 

• Factory defaults may vary for different regions.

To select a new value as a default menu setting:

1 Press the System button.

2 Select the desired menu, and then press the  button.

3 Select the desired menu or menu item, and then press the  button.

• If the selection is a menu, the menu is opened and the list of menu items appears.

• If the selection is a menu item, the default menu setting for the menu item is displayed with a 
highlight.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value.

5 Press the  button to enable the setting value.

The value is displayed on the right of the menu item in the previous screen to identify it as the 
current user default menu setting.

6 To continue setting other items, select the desired menu. Press the  (Back) or  button to 
return to the previous menu.

To quit setting new values, press the System button, and then press the  (Back) or  button 
to return to the Select Function screen.

These settings are active until new ones are selected or the factory defaults are restored.

Note that the print driver settings have precedence over the settings made on the operator panel.
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Using the Printer Setting Utility to Change the Printer Settings 
(Windows Only)
You can select menu items and corresponding values from the Printer Setting Utility.

The following procedure uses Windows 7 as an example.

NOTE: 

• Factory defaults may vary for different regions.
These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value, and then click the Apply New Settings or Restart printer to apply 
new settings button.

Note that the print driver settings have precedence over the settings made on the Printer Settings 
Utility.

Adjusting the Language
To display a different language on the operator panel:

• Using the Operator Panel

1 Press the System button.

2 Select Panel Language, and then press the  button.

3 Select the desired language, and then press the  button.
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• Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select System Settings from the list at the left side of the page.

The System Settings page is displayed.

4 Select the desired language from Panel Language, and then click the Apply New Settings 
button.
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6
Copying

This chapter includes:

• "Loading Paper for Copying" on page 170

• "Preparing a Document" on page 171

• "Making Copies From the Document Glass" on page 172

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Setting Copy Options" on page 175

• "Changing the Default Settings" on page 191
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Loading Paper for Copying

The instructions for loading print documents are the same whether you are printing, faxing, or copying. 
(The fax feature is available only on the DocuPrint CM215 f/CM215 fw.)

See also: 
• "Usable Print Media" on page 131

• "Loading Print Media" on page 133
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Preparing a Document

You can use the document glass or the automatic document feeder (ADF) to load an original 
document for copying, scanning and sending a fax. (The ADF and fax feature are available only for 
the DocuPrint CM215 f/CM215 fw.) You can load up to 15 sheets of 64 gsm documents for one job 
using the ADF or one sheet at a time using the document glass.

IMPORTANT: 

• Avoid loading documents that are smaller than 148.0 × 210.0 mm (5.83 × 8.27 inch) or larger than 215.9 × 
355.6 mm (8.5 × 14 inch), different sizes or weights together, booklets, pamphlets, transparencies, or 
documents having other unusual characteristics in ADF.

• Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, 
curled or rolled paper or torn paper cannot be used in ADF.

• Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such 
as glue, ink and correcting fluid in ADF.

NOTE: 

• To get the best scan quality, especially for color or gray scale images, use the document glass instead of the 
ADF.
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Making Copies From the Document Glass

NOTE: 

• A computer connection is not required for copying. 

• For the DocuPrint CM215 f/CM215 fw, make sure that no document is in the ADF. If any document is detected 
in the ADF, it takes priority over the document on the document glass.

• Dust on the document glass may cause black spots on the copy printout. For best results, clean the document 
glass before use. For more information, see "Cleaning the Scanner" on page 383.

To make a copy from the document glass:

1 Open the document cover.

2 Place the document facing down on the document glass and align it with the registration guide on 
the top left corner of the document glass.

3 Close the document cover.

NOTE: 

• Leaving the document cover open while copying may affect the copy quality and increase the toner 
consumption.

• If you are copying a page from a book or magazine, lift the document cover until its hinges are caught by 
the stopper, and then close the document cover. If the book or magazine is thicker than 20 mm, start 
copying with the document cover open. 

CAUTION:

• Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.
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4 Press the Copy button.

5 Customize the copy settings such as the number of copies, copy size, and image quality.

See also: 

• "Setting Copy Options" on page 175

To clear the settings, use the  (Clear All) button.

6 Press the  (Start) button to begin copying.

NOTE: 

• Press the  (Stop) button to cancel a copy job at any time while scanning a document.
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Making Copies From the ADF (DocuPrint CM215 
f/CM215 fw Only)

IMPORTANT: 

• Do not load more than 15 sheets on the ADF or allow more than 15 sheets to be fed to the document output 
tray. The document output tray should be emptied before it holds more than 15 sheets or your source 
documents may be damaged.

NOTE: 

• To get the best scan quality, especially for color or gray scale images, use the document glass instead of the ADF.

• A computer connection is not required for copying. 

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

To make copy from the ADF:

1 Load up to 15 sheets of 64 gsm documents facing up on the ADF with top edge of the documents 
in first. Then adjust the document guides to the correct document size.

NOTE: 

• Be sure to adjust the document guides before copying a legal-size document.

2 Press the Copy button.

3 Customize the copy settings such as number of copies, copy size, and image quality. 

See also: 

• "Setting Copy Options" on page 175

To clear the settings, use the  (Clear All) button.

NOTE: 

• The options automatically return to default statuses when the next copy service is initiated or the auto 
clear timer expires.

4 Press the  (Start) button to begin copying.

NOTE: 

• Press the  (Stop) button to cancel a copy job at any time while scanning a document.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Setting Copy Options

Set the following options for the current copy job before pressing the  (Start) button to make 
copies.

NOTE: 

• After a copy job is completed, the copy options would be kept until the screen returns to Select Function 
(auto-reset or the  (Back) button is pressed), the  (Clear All) button is pressed, or the Copy button is 
pressed again.

This section includes:

• "Number of Copies" on page 176

• "Color" on page 176

• "Collated" on page 177

• "Reduce/Enlarge" on page 178

• "Document Size" on page 180

• "Original Type" on page 181

• "Lighten/Darken" on page 182

• "Sharpness" on page 183

• "Auto Exposure" on page 184

• "Color Balance R" on page 184

• "Color Balance G" on page 184

• "Color Balance B" on page 185

• "Gray Balance" on page 185

• "N-Up" on page 186

• "Margin Top/Bottom" on page 188

• "Margin Left/Right" on page 189

• "Margin Middle" on page 190
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Number of Copies
Specify the number of copies from 1 to 99.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Enter the number of copies using the numeric keypad.

4 If necessary, customize the copy settings such as copy size, and image quality.

See also: 

• "Setting Copy Options" on page 175

5 Press the  (Start) button to begin copying.

Color
Select a mode from color or black and white copying.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Press the Color Mode button to select the desired color mode.

4 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

5 Press the  (Start) button to begin copying.
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Collated
Sort the copy outputs. For examples, if you make two copies of three page documents, first set of 
three-pages documents will be printed followed by the second set.

NOTE: 

• Copying documents with a large amount of data may exhaust available memory. If a memory shortage occurs, 
cancel the collating by turning Collated to Off on the operator panel.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Collated, and then press the  button.

4 Select the desired setting, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Off* Does not sort the copy output.

On Sorts the copy outputs.

Auto

(DocuPrint CM215 f/CM215 fw 
only)

Sorts the copy outputs if multiple-sheet documents are scanned with 
the ADF.
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Reduce/Enlarge
Reduce or enlarge the size of a copied image, from 25% to 400%.

NOTE: 

• When you make a reduced copy, black lines may appear at the bottom of your copy. Size reducing may cause 
black lines to appear at the bottom of copies.

• This item is available only when N-Up is set to Off or Manual.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Reduce/Enlarge, and then press the  button.

4 Select the desired settings, and then press the  button.

• mm series

NOTE: 

• Asterisk (*) is the factory default setting.

• inch series

200%

A5→A4 (141%)

A5→B5 (122%)

100%*

B5→A5 (81%)

A4→A5 (70%)

50%

200%

Stmt→Lgl (154%)

Stmt→Ltr (129%)

100%*

Lgl→Ltr (78%)

Ldgr→Ltr (64%)

50%
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NOTE: 

• You can also use the numeric keypad to input the desired zoom ratio from 25% to 400%, or press the  
button to increase the zoom ratio or press the  button to reduce the zoom ratio in 1% interval. See the 
following table for specific zoom ratios.

The methods to load print media vary depending on the size and orientation of the print media. 
For details, refer to "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134 or 
"Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142.

For print media that can be loaded, refer to "Usable Print Media" on page 131.

5 If necessary, customize the copy settings such as the number of copies, and image quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Copy

Original

A5 B5 A4

A5 100% 122% 141%

B5 81% 100% 115%

A4 70% 86% 100%
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Document Size
Specify the default document size.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Document Size, and then press the  button.

4 Select the desired settings, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

A4 (210 × 297mm)*

A5 (148 × 210mm)

B5 (182 × 257mm)

Letter (8.5 × 11")

Folio (8.5 × 13")

(DocuPrint CM215 f/CM215 fw only)

Legal (8.5 × 14")

(DocuPrint CM215 f/CM215 fw only)

Executive (7.25 × 10.5")
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Original Type
Select the copy image quality.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Original Type, and then press the  button.

4 Select the desired settings, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies and copy size.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Text Suitable for document contains mostly text.

Mixed* Suitable for document contains photos/text/gray tones.

Photo Suitable for document contains mostly photos.
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Lighten/Darken
Adjust density level to create lighter or darker copy of original document.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Lighten/Darken, and then press the  button.

4 Select the desired settings, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Lighten2 Makes the copy lighter than the original. Works well with dark print.

Lighten1

Normal* Works well with standard type or printed documents.

Darken1 Makes the copy darker than the original. Works well with light print or 
faint pencil markings.Darken2
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Sharpness
Adjust the sharpness to make the copy sharper or softer than the original.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Sharpness, and then press the  button.

4 Select the desired settings, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Sharpest Makes the copy sharper than the original.

Sharper

Normal* Does not make the copy sharper or softer than the original.

Softer Makes the copy softer than the original.

Softest
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Auto Exposure
Suppress the background of the original to enhance text on the copy.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Auto Exposure, and then press the  button.

4 Select On, and then press the  button.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

Color Balance R
Specify the default color balance level of red within the range of -2 to +2.

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults, and then press the  button.

4 Select Color Balance R, and then press the  button.

5 Select the desired value, and then press the  button.

Color Balance G
Specify the default color balance level of green within the range of -2 to +2.

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults, and then press the  button.

4 Select Color Balance G, and then press the  button.

5 Select the desired value, and then press the  button.
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Color Balance B
Specify the default color balance level of blue within the range of -2 to +2.

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults, and then press the  button.

4 Select Color Balance B, and then press the  button.

5 Select the desired value, and then press the  button.

Gray Balance
Specify the default gray balance level within the range of -2 to +2.

NOTE: 

• This option is effective only for black and white copying.

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults, and then press the  button.

4 Select Gray Balance, and then press the  button.

5 Select the desired value, and then press the  button.
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N-Up
Print two original images to fit onto one sheet of paper.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select N-Up, and then press the  button.

Auto:
Automatically 
reduces the 
pages to fit in 
one page.

ID Card Copy:
Always prints two 
sides of the ID card 
in one page in the 
original size (by 
100%).

Manual:
Reduces the pages in the 
custom size depending on 
the setting of the 
Reduce/Enlarge menu.
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4 Select the desired setting, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size (only for Off 
or Manual) and image quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

When you are using the document glass and N-Up is set to Auto, ID Card Copy, or Manual, 
the display prompts you for another page. Select Yes or No, and then press the  button.

If you select Yes, select Continue or Cancel, and then press the  button.

Off* Does not perform N-Up printing.

Auto Automatically reduces the original pages to fit onto one sheet of 
paper.

ID Card Copy Prints the original pages onto one sheet of paper in the original size.

Manual Prints the original pages onto the one sheet of paper in the size 
specified in Reduce/Enlarge.
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Margin Top/Bottom
Specify the top and bottom margins of the copy.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Margin Top/Bottom, and then press the  button.

4 Press the  or  button or enter the desired value using the numeric keypad, and then press 
the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

4mm*/0.2 inch* Factory default setting.

0-50mm/0.0-2.0 inch Specify the value in increments of 1 mm/0.1 inch.
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Margin Left/Right
Specify the left and right margins of the copy.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Margin Left/Right, and then press the  button.

4 Press the  or  button or enter the desired value using the numeric keypad, and then press 
the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

4mm*/0.2 inch* Factory default setting.

0-50mm/0.0-2.0 inch Specify the value in increments of 1 mm/0.1 inch.
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Margin Middle
You can specify the middle margin of the copy.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Copy button.

3 Select Margin Middle, and then press the  button.

4 Press the  or  button or enter the desired value using the numeric keypad, and then press 
the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

5 If necessary, customize the copy settings such as the number of copies, copy size, and image 
quality.

See also: 

• "Setting Copy Options" on page 175

6 Press the  (Start) button to begin copying.

0mm*/0.0 inch* Factory default setting.

0-50mm/0.0-2.0 inch Specify the value in increments of 1 mm/0.1 inch.
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Changing the Default Settings

The COPY menu options such as color mode and image quality can be set to your most frequent use 
modes.

To create your own default settings:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Copy Defaults and then press the  button.

4 Select the desired menu item and then press the  button.

5 Select the desired setting or enter the value using the numeric keypad and then press the  
button.

6 Repeat steps 4 and 5, as needed.

7 To return to the previous screen, press the  (Back) button.
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7
Scanning

This chapter includes:

• "Scanning Overview" on page 194

• "Scanning to a Computer" on page 195

• "Scanning to a Computer or Server via SMB/FTP (DocuPrint CM215 f/CM215 fw Only)" on 
page 202

• "Scanning to a USB Storage Device" on page 226

• "Sending an E-Mail With the Scanned Image (DocuPrint CM215 f/CM215 fw Only)" on page 227

• "Adjusting Scanning Options" on page 230
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Scanning Overview

You can use your printer to turn pictures and text into editable images on your computer. 

The resolution setting to use when you scan an item depends on the item type and how you plan to 
use the image or document after you scan it into your computer. For the best results, use these 
recommended settings. 

Scanning beyond these recommended resolutions may exceed the capabilities of the application. If 
you require a recommended resolution mentioned in the above table, reduce the size of the image by 
previewing (or pre-scan) and crop it before scanning the image.

Scanning - From Computer
• To scan and export the scanned data to a graphic software application such as the Adobe® 

Photoshop® using the TWAIN driver, see "Scanning Using the TWAIN Driver" on page 198. This 
method is supported both on the Microsoft® Windows® and Mac OS X operating systems but 
requires a USB or network connection and a graphic software application.

• To scan and export the scanned data to Microsoft's program such as the Windows Photo Gallery 
and the Microsoft Paint, using the Windows Image Acquisition (WIA) driver, see "Scanning Using 
the WIA Driver" on page 200. This method is supported only on the Windows operating system 
and requires a USB or network (WSD only) connection.

NOTE: 

• WSD stands for Web Services on Devices.

Scanning - From Printer
• To scan and send the scanned data to a computer connected with a USB cable, see "Scanning 

From the Operator Panel - Scan to Application" on page 195. This method is supported both on 
the Windows and Mac OS X operating systems but requires a USB connection and the Express 
Scan Manager, a bundled software tool. The scanned data will be saved in the location on your 
computer that is specified on the Express Scan Manager.

• To scan and send the scanned data to a computer connected to a network via the WSD, see 
"Scanning From the Operator Panel - Scan to WSD (DocuPrint CM215 f/CM215 fw Only)" on 
page 196.

• To scan and send the scanned data to a computer or server connected to a network, see 
"Sending the Scanned File to the Network" on page 225.

• To scan and save the scanned data onto a USB storage device, see "Scanning to a USB Storage 
Device" on page 226.

• To scan and send the scanned data through e-mail, see "Sending an E-Mail With the Scanned 
Image (DocuPrint CM215 f/CM215 fw Only)" on page 227. 

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or 
color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100–200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150–300 dpi

Images for a high-resolution printer 300–600 dpi
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Scanning to a Computer

This section includes:

• "Scanning From the Operator Panel - Scan to Application" on page 195

• "Scanning From the Operator Panel - Scan to WSD (DocuPrint CM215 f/CM215 fw Only)" on 
page 196

• "Scanning Using the TWAIN Driver" on page 198

• "Scanning Using the WIA Driver" on page 200

Scanning From the Operator Panel - Scan to Application
The following procedure uses Windows 7 as an example.

NOTE: 

• Make sure that the printer is connected to the computer using the USB cable.

• You must use the Express Scan Manager on your computer to configure the output destination of the scanned 
image files. 

• This service is supported both on the Windows and Mac OS X operating systems.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Scan button.

3 Select Scan to Application, and then press the  button.

4 Configure the scanning settings as necessary.

5 Press the  (Start) button.

A scanned image file is saved to the location you have specified on the Express Scan Manager.

NOTE: 

• If the window to select the program appears on your computer, select Express Scan Manager-Btype, 
and then click OK.

• File type of scanned data varies depending on application on computer. 

See also: 
• "Express Scan Manager" on page 63
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Scanning From the Operator Panel - Scan to WSD 
(DocuPrint CM215 f/CM215 fw Only)

If the printer is connected to a computer via network using Web Services on Devices (WSD), you can 
use the Scan to WSD function to send scanned images to a computer.

NOTE: 

• To use Scan to WSD, you need to setup connection using WSD.

• WSD is supported only on Windows Vista®, Windows 7 and Windows 8.

Printer Setup for Scan to WSD
Setup the printer and computer for connection using WSD.

• Checking the Printer Setting
To use the Scan to WSD function, WSD needs to be set to Enable. See "Protocol" on page 281 for 
details.

• Setting Up the Computer

NOTE: 

• For Windows 8, a computer automatically connects the printer using WSD. There is no need to install the 
printer manually.

For Windows 7:

1 Click Start → Computer → Network.

2 Right-click the icon for the printer, and then click Install.

The printer is connected by WSD.

For Windows Vista:

1 Click Start → Network.

2 Right-click the icon for the printer, and then click Install.

3 Click Continue.

The printer is connected by WSD.
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Procedures for WSD Scan

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Scan button.

3 Select Scan to WSD, and then press the  button.

4 Ensue that Scan to is highlighted, and then press the  button.

5 Select a desired computer you want to send the scan job, and then press the  button.

6 Select a desired scan event, and then press the  button.

Options are :

• Scan

• ScanToPrint

• ScanToEmail

• ScanToFax

• ScanToOCR

7 Press the  (Start) button.
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Scanning Using the TWAIN Driver
Your printer supports the Tool Without An Interesting Name (TWAIN) driver for scanning images. 
TWAIN is one of the standard components provided by Windows XP, Windows Server® 2003, 
Windows Server 2008, Windows Server 2008 R2, Windows Vista, Windows 7, Windows 8, Windows 
Server 2012, and Mac OS X 10.4/10.5/10.6/10.7/10.8, and works with various scanners. 

The following procedure uses Windows 7 as an example.

NOTE: 

• Make sure that the printer is connected to the computer with a USB cable or to a network.

The following procedure to scan an image uses Microsoft Clip Organizer as an example.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Click Start → All Programs → Microsoft Office → Microsoft Office 2010 Tools → Microsoft 
Clip Organizer.

3 Click File → Add Clips to Organizer → From Scanner or Camera.

4 In the Insert Picture from Scanner or Camera window, under Device, select your TWAIN 
device.

5 Click Custom Insert.
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6 Select your scanning preferences and click Preview to display the preview image.

NOTE: 

• For the DocuPrint CM215 f/CM215 fw, Preview is grayed out and disabled when you select Document 
Feeder Tray from Scan From.

• File type of scanned data vary depends on application on computer.

7 Select the desired properties from the Image Quality and Image Options tabs.

8 Click Scan to start scanning.

The scanned image file is generated.
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Scanning Using the WIA Driver
Your printer also supports the Windows Image Acquisition (WIA) driver for scanning images. WIA is 
one of the standard components provided by Windows XP and later operating systems and works with 
digital cameras and scanners. Unlike the TWAIN driver, the WIA driver allows you to scan an image 
and easily manipulate those images without using additional software.

The following procedure uses Windows 7 as an example.

NOTE: 

• Make sure that the printer is connected to the computer using the USB cable.

1 For the DocuPrint CM215 f/CM215 fw, firstly load the top edge of document(s) with facing up into 
the ADF or place a single document facing down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Start the drawing software, such as Paint for Windows.

NOTE: 

• When you use Windows Vista or Windows Server 2008, use Windows Photo Gallery instead of Paint.

3 Click the Paint button → From scanner or camera.

The WIA window appears.

4 Select your scanning preferences and click Adjust the quality of the scanned picture to 
display the Advanced Properties window.

5 Select the desired properties including brightness and contrast, and then click OK.

6 Click Scan to start scanning.
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7 Click the Paint button → Save as.

8 Enter a picture name, and select a file format and destination to save the picture.
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Scanning to a Computer or Server via SMB/FTP 
(DocuPrint CM215 f/CM215 fw Only)

This section includes:

• "Overview" on page 202

• "Confirming a Login name and Password" on page 204

• "Specifying a Destination to Store the Document" on page 206

• "Configuring the Printer Settings" on page 219

• "Sending the Scanned File to the Network" on page 225

Overview
The Scan to Server/Computer feature allows you to scan documents and send the scanned document 
to a network computer via the FTP or SMB protocol. 

You can select the kind of the server and specify a destination to store the scanned document with the 
CentreWare Internet Services or the Address Book Editor.

The following items are required to use the Scan to Server/Computer feature.

• Using SMB

To transfer data via SMB, your computer must run on one of the following operating systems that 
includes folder sharing.

For Mac OS X, a shared user account is required on the Mac OS X.

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008 R2

• Windows Server 2012

• Windows XP

• Windows Vista

• Windows 7

• Windows 8

• Mac OS X 10.4/10.5/10.6

Scan
Using FTP

Using SMB

FTP Server

Computer

Computer
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• Using FTP

To transfer data via FTP, one of the following FTP servers and an account to the FTP server 
(login name and password) are required.

• Windows XP

FTP service of Microsoft Internet Information Server 3.0/4.0 or Internet Information Services 
5.0/5.1

• Windows Vista, Windows 7, Windows Server 2003, Windows Server 2008, and Windows 
Server 2008 R2

FTP service of Microsoft Internet Information Services 6.0

• Windows 8 and Windows Server 2012

FTP service of Microsoft Internet Information Services 8.0

• Mac OS X

FTP service of Mac OS X 10.4.2/10.4.4/10.4.8/10.4.9/10.4.10/10.4.11/10.5/10.6/10.7/10.8

For information on how to configure the FTP service, contact your system administrator.

Follow the procedure below to use the Scan to Server/Computer feature.

"Confirming a Login name and Password" on page 204

"Specifying a Destination to Store the Document" on page 206

"Configuring the Printer Settings" on page 219

"Sending the Scanned File to the Network" on page 225
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Confirming a Login name and Password

When Using SMB
The Scan to Computer/Server feature requires a user login account with a valid and non-empty 
password for authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password for your user login 
account with the following procedure.

• For Windows XP:

1 Click start → Control Panel → User Accounts.

2 Click Change an account.

3 Select your account.

4 Click Create a password and add in a password for your user login account.

• For Windows Server 2003:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 

• When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.
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• For Windows Vista and Windows 7:

1 Click Start → Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

• For Windows 8 and Windows Server 2012:

1 Place the mouse pointer in the upper right corner of the screen and move the mouse down, and 
then select Settings → Change PC settings.

2 Click Users.

3 Click Create a password and add in a password for your user login account.

• For Windows Server 2008 and Windows Server 2008 R2:

1 Click Start → Control Panel.

2 Click User Accounts.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

• For Mac OS X 10.4/10.5/10.6:

1 Click System Preferences → Accounts.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New Password (New password for Mac OS X 
10.6).

5 Re-enter the password in Verify.

6 Click Change Password.

After you confirmed a login user name and password, go to "Specifying a Destination to Store the 
Document" on page 206.

When Using FTP
The Scan to Computer/Server feature requires a user name and a password. For your user name and 
password, contact your system administrator.
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Specifying a Destination to Store the Document

When Using SMB
Share a folder to store the scanned document using the following procedure.

• For Windows XP Home Edition:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder on the network.

4 Enter a shared name in the Share name box.

NOTE: 

• Write down this shared name because you will use this name in the next setting procedure.
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NOTE: 

• When the following screen appears, click If you understand the security risks but want to share files 
without running the wizard, click here, then select Just enable file sharing, and then click OK.

5 Select Allow network users to change my files.

6 Click Apply, and then click OK.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name, MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 219.
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• For Windows XP Professional Edition:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare) 
and double-click the folder.

2 Select Folder Options from Tools.

3 Click View tab, and then deselect the Use simple file sharing (Recommended) check box.

4 Click OK, and then close the window.

5 Right-click the folder, and then select Properties.

6 Select the Sharing tab, and then select Share this folder.
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7 Enter a shared name in the Share name box.

NOTE: 

• Write down this shared name because you will use this name in the next setting procedure.

8 Click Permissions to create a write permission for this folder.

9 Click Add.

10 Search user login name by clicking Advanced, or enter the user login name in the Enter the 
object names to select box and click Check Names to confirm (Example of user login name, 
MySelf).

11 Click OK.
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12 Click the user login name that you have just entered. Select the Full Control check box. This will 
grant you permission to send the document into this folder.

NOTE: 

• Do not use Everyone as the user login name.

13 Click OK.

14 Click Apply, and then click OK.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 219.
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• For Windows Server 2003:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select the Share this folder.

4 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.

5 Click Permissions to give write permission for this folder.

6 Click Add.

7 Search user login name by clicking Advanced, or enter the user login name in the Enter the 
object names to select box and click Check Names to confirm (Example of user login name, 
MySelf).

8 Click OK.
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9 Click the user login name that you have just entered. Select the Full Control check box. This will 
grant you permission to send the document to this folder.

NOTE: 

• Do not use Everyone as the user login name.

10 Click OK.

11 Configure other settings as necessary, and then click Apply and click OK.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 219.
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• For Windows Vista, Windows 7, Windows Server 2008, and Windows 
Server 2008 R2:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Advanced Sharing.

For Windows Vista, when User Account Control window appears, click Continue.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.
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6 Click Permissions to give write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in the Enter the 
object names to select box and click Check Names to confirm (Example of user login name, 
MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will 
grant you permission to send the document to this folder.

NOTE: 

• Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing window.
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13 Click Close.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 219.
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• For Windows 8 and Windows Server 2012:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then click Advanced Sharing.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.

6 Click Permissions to create a write permission for this folder.

7 Click Add.
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8 Search user login name by clicking Advanced, or enter the user login name in the Enter the 
object names to select box and click Check Names to confirm (Example of user login name: 
MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will 
grant you permission to send the document into this folder.

NOTE: 

• Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing dialog box.

13 Click Close.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Configuring the Printer Settings" on page 219.
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• For Mac OS X 10.4:

1 Select Home from the Go menu.

2 Double-click Public.

3 Create a folder (Example of folder name, MyShare).

NOTE: 

• Note down the folder name as you need to use this name in the next setting procedure.

4 Open System Preferences, and then click Sharing.

5 Select the Personal File Sharing check box and the Windows Sharing check box.

• For Mac OS X 10.5/10.6:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

NOTE: 

• Note down the folder name as you need to use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder (Shared folder for Mac OS X 10.6) check box, and then close the 
window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share files and folders using SMB (Share files and folders using SMB 
(Windows) for Mac OS X 10.6) check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.

When Using FTP
For a destination to store the document, contact your system administrator.
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Configuring the Printer Settings
You can configure the printer settings to use the Scan to Server/Computer feature with the 
CentreWare Internet Services or Address Book Editor.

The following procedure uses Windows 7 as an example.

From the CentreWare Internet Services

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 87.

3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

• The default User ID and password are 11111 and x-admin respectively.

4 Under Network Scan (Comp./Serv.), click Computer/Server Address Book.
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5 Select any unused number and click Add.

The Add Network Scan Address page appears.

6 To fill in the fields, enter the information as follows: 

1 Name (Displayed on 
Printer)

Enter a friendly name that you want it to appear on the Address Book.

2 Network Type Select Server FTP if you use a FTP server.

Select Computer SMB if you store the document in a shared folder of 
your computer.

1

2

3

4

5

6

7

8

9
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7 Click Apply.

After you configured settings, go to "Sending the Scanned File to the Network" on page 225.

3 Host Address (IP 
Address or DNS Name)

Enter a server name or IP address of your computer or the FTP 
server that you have shared out.

The following are examples:

• For Server FTP:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.168.1.100

• For Computer SMB:

Server name: myhost

IP address: 192.168.1.100

4 Port Number Enter the server port number. If you are unsure, you can enter the 
default value of 21 for FTP and 139 for SMB.

5 Login Name (if required 
by host)

Enter the user account name that has access to the shared folder on 
your computer or FTP server.

6 Login Password Enter the password corresponding to the above login name.

NOTE: 

• Empty password is not valid in the Scan to Computer feature. 
Make sure that you have a valid password for the user login 
account. (See "Confirming a Login name and Password" on 
page 204 for details on how to add a password in your user login 
account.)

7 Re-enter Password Re-enter your password.

8 Name of Shared 
Directory

For Computer SMB only.

On the Windows operating system, enter the share name of the folder 
to store the scanned document on the recipient computer.

On the Mac OS, enter the folder name to store the scanned document 
on the recipient computer.

9 Subdirectory Path 
(optional)

For Computer SMB

To store the scanned document in the share folder directly without 
creating any subfolder, leave the space blank.

To store the scanned document in the folder you created under the 
share folder, enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: 
MyPic, Third-level folder name: John

You should now see MyShare\Mypic\John in your directory.

In this case, enter the following item.

Server Path: \MyPic\John

For Server FTP

Enter the server path to store the scanned document.

MyShare (Share folder)

MyPic

John
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From the Address Book Editor

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Address Book Editor.

NOTE: 

• The window to select a device appears when multiple fax drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Device Name.

• The Enter Password window appears when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and click OK.

2 Click OK on the "Retrieval Successful" message window.

3 Click Tool → New (Device Address Book) → Server.

The Server Address window appears.
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4 To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want it to appear on the Address Book.

2 Server Type Select Computer if you store the document in a shared folder of your 
computer. 

Select Server if you use a FTP server.

3 Computer Settings 
wizard

For Computer only.

Clicking this button opens the wizard screen which guides you 
through several steps.

When you complete the steps in the wizard, the settings for Server 
Address are automatically configured. For details, click the Help 
button.

4 Server Name / IP 
Address

Enter a server name or IP address of your computer or the FTP 
server that you have shared out.

The following are examples:

• For Computer:

Server name: myhost

IP address: 192.168.1.100

• For Server:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.168.1.100

5 Share Name For Computer only.

Enter the name of the shared folder on the recipient computer. 

3

9

10

8

7

6

5

4

2

1
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5 Click OK.

6 Click the Save All icon on the toolbar.

After you configured settings, go to "Sending the Scanned File to the Network" on page 225.

6 Path For Computer

To store the scanned document in the share folder directly without 
creating any subfolder, leave the space blank.

To store the scanned document in the folder you created under the 
share folder, enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: 
MyPic, Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Path: \MyPic\John

For Server

Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on 
your computer or FTP server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: 

• Empty password is not valid in the Scan to Server/Computer 
feature. Make sure that you have a valid password for the user 
login account. (See "Confirming a Login name and Password" on 
page 204 for details on how to add a password in your user login 
account).

9 Confirm Login 
Password

Re-enter your password.

10 Port Number Enter the port number. If you are unsure, you can enter the default 
value of 139 for SMB and 21 for FTP.

MyShare (Share folder)

MyPic

John
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Sending the Scanned File to the Network

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Scan button.

3 Select Scan to Network, and then press the  button.

4 Select Scan to, and then press the  button.

5 Select Computer(Network) or Server(FTP), or Search Address Book, and then press 
the  button.

Computer(Network): Stores the scanned image on the computer by using the SMB protocol.

Server(FTP): Stores the scanned image on the server by using the FTP protocol.

Search Address Book: Select the server address registered in Address Book.

6 Select the destination to store the scanned file in, and then press the  button.

7 Select scanning options as required.

8 Press the  (Start) button to send the scanned files.
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Scanning to a USB Storage Device

The Scan to USB Memory feature allows you to scan documents and save the scanned data to a USB 
storage device. To scan documents and save them, follow the steps below: 

1 For the DocuPrint CM215 f/CM215 fw, load the top edge of document(s) first with facing up into 
the ADF or place a single document face down on the document glass and close the document 
cover.

For the DocuPrint CM215 b, place a single document facing down on the document glass, and 
close the document cover.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Insert the USB storage device into the USB drive on your printer. 

USB Memory appears.

3 Select Scan to, and then press the  button.

4 Select Save to Root or a folder to save file, and then press the  button. 

5 Select scanning options as required.

6 Press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Select Yes 
or No, and then press the  button.

If you select Yes, place the next page on the document glass, select Continue and then press 
the  button.
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Sending an E-Mail With the Scanned Image 
(DocuPrint CM215 f/CM215 fw Only)

To send an e-mail attached with the scanned image from your printer, follow the steps below:

• Set up your SMTP (Simple Mail Transfer Protocol) server information. SMTP is a protocol for 
sending e-mail. Refer to the Setup Guide for more details.

• Set up the E-mail Address Book through the CentreWare Internet Services. See "Setting an E-
mail Address Book" on page 227 for more details.

Setting an E-mail Address Book
The following procedure uses Windows 7 as an example.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 87.

3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

• The default User ID and password are 11111 and x-admin respectively.

4 Under Fax / E-mail, click Personal Address.
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5 Select any unused number and click Add.

The Add Personal Address page appears.

6 Enter a name in the Name field and e-mail address in the E-mail Address field.

7 Click the Apply button.
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Sending an E-mail With the Scanned File

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass.

See also: 

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 174

• "Making Copies From the Document Glass" on page 172

2 Press the Scan button.

3 Select Scan to E-Mail, and then press the  button.

4 Select E-Mail to, and then press the  button.

5 Select the setting listed below, and then press the  button.

Keypad: Enter the e-mail address directly and then press the  button.

Address Book: Select the e-mail address registered in the E-mail Address Book, and then 
press the  button.

E-Mail Group: Select the e-mail group registered in the E-mail Groups, and then press the  
button.

Search Address Book: Enter a text to search from the E-mail Address Book, and then press 
the  button. Select the e-mail address from the list, and then press the  button.

NOTE: 

• Users need to be registered before you can select Address Book on the operator panel.

6 Select scanning options as required.

7 Press the  (Start) button to send e-mail.
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Adjusting Scanning Options

This section includes:

• "Adjusting the Default Scan Settings" on page 230

• "Changing the Scan Settings for an Individual Job" on page 233

Adjusting the Default Scan Settings
This section includes:

• "Setting the Scanned Image File Type" on page 230

• "Setting the Color Mode" on page 231

• "Setting the Scan Resolution" on page 231

• "Setting the Original Size" on page 232

• "Automatically Suppressing Background Variations" on page 232

For a complete list of all of the defaults settings, see "Defaults Settings" on page 303.

Setting the Scanned Image File Type
To specify the file type of the scanned image:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select File Format, and then press the  button.

5 Select the type, and then press the  button.

Available types:

• PDF (factory default)

• TIFF

• JPEG
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Setting the Color Mode
You can scan an image in color or in black and white. Selecting black and white significantly reduces 
the file size of the scanned images. An image scanned in color will have a larger file size than the 
same image scanned in black and white.

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Color, and then press the  button.

5 Select one of the following options, and then press the  button.

• Black & White: Scans in black and white mode. This is available only when File Format 
is set to PDF or TIFF.

• Color: Scans in color mode. (factory default)

Setting the Scan Resolution
You may want to change the scan resolution depending on the way you plan to use the scanned 
image. Scan resolution affects both the size and image quality of the scanned image file. The higher 
the scan resolution, the larger the file size.

To select the scan resolution:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Resolution, and then press the  button.

5 Select one of the following options, and then press the  button:

• 200 × 200dpi: Produces the lowest resolution and smallest file size. (factory default)

• 300 × 300dpi: Produces medium resolution and a medium file size.

• 400 × 400dpi: Produces high resolution and a large file size.

• 600 × 600dpi: Produces the highest resolution and largest file size.
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Setting the Original Size
To specify the size of the original:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Document Size, and then press the  button.

5 Select a specific paper size to determine the area to be scanned, and then press the  button.

The factory default setting is A4 (210 × 297mm).

Automatically Suppressing Background Variations
When scanning document has light grey background such as newspapers, the printer automatically 
can detect the background and whiten it when outputting the image.

To turn on/off automatic suppression:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Scan Defaults, and then press the  button.

4 Select Auto Exposure, and then press the  button.

5 Select either On or Off, and then press the  button.

The factory default setting is On.
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Changing the Scan Settings for an Individual Job

Scanning to a Computer

• Scan to Computer (Network) (DocuPrint CM215 f/CM215 fw Only)

1 Press the Scan button.

2 Select Scan to Network, and then press the  button.

3 Select Scan to, and then press the  button.

4 Select Computer (Network), and then press the  button.

5 Select the destination computer, and then press the  button.

6 Select the desired setting or enter the value using the numeric keypad, and then press the  
button.

7 Repeat steps 5 and 6 as needed.

8 Press the  (Start) button to begin the scan.

• Scan to Computer (USB) 

1 Press the Scan button.

2 Select Scan to Application, and then press the  button.

3 Select the desired menu item, and then press the  button.

4 Select the desired setting or enter the value using the numeric keypad and then press the  
button.

5 Repeat steps 3 and 4 as needed.

6 Press the  (Start) button to begin the scan.
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Emailing the Scanned Image (DocuPrint CM215 f/CM215 fw Only)
To temporarily change a scan setting when emailing the scanned image:

1 Press the Scan button.

2 Select Scan to E-Mail, and then press the  button.

3 Select the e-mail destination, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the numeric keypad, and then press the  
button.

6 Repeat steps 4 and 5, as needed.

7 Press the  (Start) button to begin the scan.
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8
Faxing (DocuPrint CM215 f/CM215 fw 
Only)

This chapter includes:

• "Connecting the Telephone Line" on page 236

• "Configuring Fax Initial Settings" on page 238

• "Sending a Fax" on page 241

• "Sending a Delayed Fax" on page 248

• "Sending a Fax from the Driver (Direct Fax)" on page 249

• "Receiving a Fax" on page 254

• "Automatic Dialing" on page 257

• "Other Ways to Fax" on page 262

• "Setting Sounds" on page 265

• "Specifying the Fax Settings" on page 266

• "Changing Setting Options" on page 270

• "Printing a Report" on page 271
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Connecting the Telephone Line

IMPORTANT: 

• PTC 200 warning

General warning 

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 
accepted that the item complies with minimum conditions for connection to its network. It 
indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. 
Above all, it provides no assurance that any item will work correctly in all respects with another 
item of Telepermitted equipment of a different make or model, nor does it imply that any product 
is compatible with all of Telecom's network services Warnings taken from Specification text

2.11.1 Compliance testing (6) & (7) (Functional tests)

"This equipment is not capable, under all operating conditions, of correct operation at the higher 
speeds for which it is designed. Telecom will accept no responsibility should difficulties arise in 
such circumstances"

4.5.1 Off-hook line impedance

(4) "This equipment does not fully meet Telecom's impedance requirements. Performance 
limitations may occur when used in conjunction with some parts of the network. Telecom will 
accept no responsibility should difficulties arise in such circumstances"

4.9.3 Non-voice equipment

(4) "This equipment is not capable, under all operating conditions, of correct at the higher speeds 
for which it is designed. Telecom will accept no responsibility should difficulties arise in such 
circumstances"

5.6.1 General requirements (automatic dialling devices)

(3) "This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency 
Service

5.5.5 User instructions

(4) If a charge for local calls is unacceptable, the 'Dial' button should NOT be used for local calls. 
Only the 7-digits of the local number should be dialled from your telephone. DO NOT dial the 
area code digit or the '0' prefix

8.1.7 User Instructions (automatic call set-up)

(b) This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency 
Service

8.2.1(b) Call answering

When this equipment is set up call answering not within 3~30 sets., the telephone or answering 
machine shall answer incoming call with 3~30sec.

NOTE: 

• Do not connect your printer directly to a DSL (digital subscriber line). This may damage the printer. To use a 
DSL, you will need to use an appropriate DSL filter. Contact your service provider for the DSL filter.
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1 Plug one end of a telephone line cord to the wall jack connector and the other end to an active 
wall jack.

2 To connect a telephone and/or answering machine to your printer, plug the telephone or 
answering machine line cord into the phone connector ( ).

Wall jack connector

To the wall jack

Phone connector

To an external telephone 
or answering machine
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Configuring Fax Initial Settings

This section includes:

• "Setting Your Region" on page 238

• "Setting the Printer ID" on page 239

• "Setting the Time and Date" on page 240

• "Changing the Clock Mode" on page 240

NOTE: 

• The following settings can be configured also using Fax Setup on the FX Printer Setup screen which is 
launched from the Software Pack CD-ROM.

Setting Your Region
You need to set the region where your printer is used for using the fax service on the printer.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Region, and then press the  button.

5 Select the region where the printer is used, and then press the  button.

6 Confirm that Restart System is displayed, select Yes, and then press the  button.

The printer restarts automatically to apply the settings.

NOTE: 

• When you configure the region setting, the information, which is registered to the device, is initialized.
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Setting the Printer ID
You may be required to indicate your fax number on any fax you send. The printer ID, containing your 
telephone number and name or company name, will be printed at the top of each page sent from your 
printer.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Your Fax Number, and then press the  button.

5 Enter your fax number using the numeric keypad.

NOTE: 

• If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

6 Press the  button when the number on the LCD panel is correct. 

7 Select Company Name, and then press the  button.

8 Enter your name or company name using the numeric keypad.

You can enter alphanumeric characters using the numeric keypad, including special symbols by 
pressing the 1, *, and # buttons.

For details on how to use the numeric keypad to enter alphanumeric characters, see "Using the 
Numeric Keypad" on page 320.

9 Press the  button when the name on the LCD panel is correct.

10 To return to the previous screen, press the  (Back) button.
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Setting the Time and Date

NOTE: 

• It may be necessary to reset the correct time and date if loss of power to the printer occurs.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Clock Settings, and then press the  button.

5 Select Set Date, and then press the  button.

6 Enter the correct date using the numeric keypad, or select the correct date.

NOTE: 

• If you make a mistake while entering numbers, press the  button to re-enter the digit.

7 Press the  button when the date on the LCD panel is correct.

8 Select Set Time, and then press the  button.

9 Enter the correct time using the numeric keypad, or select the correct time.

10 Press the  button when the time on the LCD panel is correct.

11 To return to the previous screen, press the  (Back) button.

Changing the Clock Mode
You can set the current time using either the 12-hour or the 24-hour format.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Clock Settings, and then press the  button.

5 Select Time Format, and then press the  button.

6 Select the desired format, and then press the  button.

7 To return to the previous screen, press the  (Back) button.
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Sending a Fax

You can fax data from your printer. 

This section includes:

• "Loading an Original Document on the ADF" on page 241

• "Loading an Original Document on the Document Glass" on page 242

• "Resolution" on page 243

• "Original Type" on page 243

• "Lighten/Darken" on page 244

• "Inserting a Pause" on page 244

• "Sending a Fax Automatically" on page 245

• "Sending a Fax Manually" on page 246

• "Confirming Transmissions" on page 247

• "Automatic Redialing" on page 247

Loading an Original Document on the ADF

IMPORTANT: 

• Do not load more than 15 sheets into the automatic document feeder (ADF) or allow more than 15 sheets to 
be fed to the document output tray. The document output tray should be emptied before it exceeds 15 sheets 
or your original documents may be damaged.

NOTE: 

• To get the best scan quality, especially for gray scale images, use the document glass instead of the ADF.

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

1 Place the document(s) facing up on the ADF with the top edge of the documents in first. Then 
adjust the document guides to the correct document size.

2 Adjust the document resolution, referring to "Resolution" on page 243.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Loading an Original Document on the Document Glass

1 Open the document cover.

2 Place the document facing down on the document glass and align it with the registration guide on 
the top left corner of the document glass.

3 Adjust the document resolution, referring to "Resolution" on page 243.

4 Close the document cover.

NOTE: 

• Make sure that no document is in the ADF. If any document is detected in the ADF, it takes priority over the 
document on the document glass. 

• If you are faxing a page from a book or magazine, lift the document cover until its hinges are caught by the 
stopper and then close the document cover. If the book or magazine is thicker than 20 mm, start faxing with 
the document cover open.

CAUTION:

• Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.
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Resolution
To specify the resolution level to be used for fax transmission:

1 Press the Fax button.

2 Select Resolution, and then press the  button.

3 Select the desired menu item, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

NOTE: 

• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving 
device. 

Original Type
To select the default document type for the current fax job:

1 Press the Fax button.

2 Select Original Type, and then press the  button.

3 Select the desired setting, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

Standard * Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or 
documents printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The Super 
Fine mode is enabled only if the remote machine also supports the 
super fine resolution.

Ultra Fine Suitable for documents containing photographic images.

Text * Suitable for documents with text.

Photo Suitable for documents with photos.
Faxing (DocuPrint CM215 f/CM215 fw Only) 243



Lighten/Darken
To adjust the contrast to make the fax lighter or darker than the original:

1 Press the Fax button.

2 Select Lighten/Darken, and then press the  button.

3 Select the desired setting, and then press the  button.

NOTE: 

• Asterisk (*) is the factory default setting.

 Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. 
A pause must be entered in order for the access code to function. For example, enter the access code 
9 and then press the Redial/Pause button before entering the telephone number. "-" appears on the 
LCD panel to indicate when a pause is entered.

Lighten2 Makes the fax lighter than the original. Works well with dark print.

Lighten1

Normal * Works well with standard typed or printed documents.

Darken1 Makes the fax darker than the original. Works well with light print or 
faint pencil markings.Darken2
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Sending a Fax Automatically

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 241

• "Loading an Original Document on the Document Glass" on page 242

2 Press the Fax button.

3 Adjust the document resolution to suit your fax documents.

See also: 

• "Resolution" on page 243

• "Lighten/Darken" on page 244

4 You can select a fax number by one of the following way:

• Select Fax to, and then press the  button. Select Keypad, and then press the  button. 
Enter the fax number of the remote fax machine using the numeric keypad, and then press the 

 button.

• Press the One-touch button, and then press the  button.

• Press the Address Book button, select All Entries, Group Dial, or Search using the 
 button, and then press the  button.

• Press the Redial/Pause button to redial, and then press the  button.

• Press the Speed Dial button. Enter the speed dial number between 01 and 99 using the 
numeric keypad, and then press the  button.

NOTE: 

• Before you use the One-touch button, you need to register a number for any speed dial from 01 to 08. 
For more information on how to store the number, see "Storing a Number for Speed Dialing" on 
page 257.

5 Press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Select Yes 
or No, and then press the  button.

If you select Yes, place the next page on the document glass, select Continue and then press 
the  button.

The number is dialed and then the printer begins sending the fax when the remote fax machine is 
ready.

NOTE: 

• Press the  (Stop) button to cancel the fax job at any time while sending the fax.

All Entries Displays a list of registered fax numbers. Press the  button to select 
the recipients, and then press the  button.

Group Dial Press the  button to select the recipients, and then press the  
button.

Search Searches a fax number from the Address Book. Enter the text you 
want to search, and then press the  button. Press the  button to 
select the recipients, and then press the  button.
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Sending a Fax Manually

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 241

• "Loading an Original Document on the Document Glass" on page 242

2 Press the Fax button.

3 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 243

• "Lighten/Darken" on page 244

4 Select OnHook, and then press the  button.

5 Select On, and then press the  button.

6 Enter the fax number by one of the following way.

• Enter the fax number of the remote fax machine using the numeric keypad.

• Press the One-touch button.

• Press the Address Book button, press the  button to select the recipients, and then press 
the  button.

• Press the Speed Dial button. Enter the speed dial number between 01 and 99 using the 
numeric keypad, and then press the  button.

7 Press the  (Start) button.

8 Select Manual Send, and then press the  button.

NOTE: 

• Press the  (Stop) button to cancel the fax job at any time while sending the fax.
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Confirming Transmissions 
When the last page of your document has been sent successfully, the printer beeps and returns to the 
standby mode. 

If something goes wrong while sending your fax, an error message appears on the LCD panel.

If you receive an error message, press the  button to clear the message and try to send the 
document again. 

You can set your printer to print a confirmation report automatically after each fax transmission.

See also: 
• "Fax Transmit" on page 290

• "Fax Broadcast" on page 290

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will 
automatically redial the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Redial Delay" on 
page 285 and "Number of Redial" on page 285.

NOTE: 

• The printer will not automatically redial a number that was busy when the number was manually entered.
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Sending a Delayed Fax

The Delayed Start mode can be used to save scanned documents for transmission at a specified time 
to take advantage of lower long distance rates. 

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 241

• "Loading an Original Document on the Document Glass" on page 242

2 Press the Fax button.

3 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 243

• "Lighten/Darken" on page 244

4 Select Delayed Start, and then press the  button.

5 Select On, and then press the  button.

6 Enter the start time using the numeric keypad or press the  or  button to select the start time, 
and then press the  button.

7 Select Fax to, and then press the  button.

8 Select Keypad, and then press the  button.

9 Enter the fax number of the remote fax machine using the numeric keypad, and then press the 
 button.

You can also use speed dial or group dial numbers.

See also: 

• "Automatic Dialing" on page 257

10 Press the  (Start) button.

Once the Delayed Start mode is activated, your printer stores all the documents to be faxed to its 
memory and sends them at the specified time. After faxing in the Delayed Start mode is complete, the 
data in the memory will be cleared.
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Sending a Fax from the Driver (Direct Fax)

You can send a fax directly from the computer running a Microsoft® Windows® operating system or 
Mac OS X by using the driver.

NOTE: 

• Only black and white faxes can be sent using Direct Fax.

This section includes:

• "For Windows" on page 249

• "For Mac OS X" on page 252

For Windows

NOTE: 

• The following procedure uses Windows 7 as an example. The names of the windows and the buttons may be 
different from those given in the following procedure depending on the OS and application you are using. 

• To use this feature, you must install the fax driver.

See also: 
• "Configuring Printer and Installing Software on Windows" on page 89

1 Open the file you want to send by fax. 

2 Open the print window from the application, and then select your fax driver.

3 Click Preferences.
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4 Specify the fax settings. For more information, click Help of the driver.

NOTE: 

• The settings done here are only applied to a single fax job. 

5 Click OK to close the Printing Preferences window. 

6 Click Print. 

The Set / Check Fax Transmission window appears. 
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7 Specify the destination for the recipient in one of the following ways:

• Enter a name and phone number directly.

• Select a recipient from the PC Fax Address Book saved on your computer or Device Address 
Book.

• Select a recipient from a database other than the PC Fax Address Book or Device Address 
Book.

For more information on how to specify the destination, click Help to see the Help of the fax 
driver.

NOTE: 

• Enter the password in the Password field in the Authorization area before sending a fax if the Fax 
service is locked with a password.

8 Click Start Sending.
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For Mac OS X

NOTE: 

• The following procedure uses Mac OS X 10.8 TextEdit as an example. The names of the windows and the 
buttons may be different from those given in the following procedure depending on the OS and application you 
are using.

• When using a USB connection on Mac OS X 10.4.11, upgrade Common UNIX Printing System (CUPS) 
software to version 1.2.12 or later. You can download it from CUPS web site.

• To use this feature, you must install the fax driver.

See also: 
• "Configuring Printer and Installing Software on Mac OS X" on page 120

1 Open the file you want to send by fax.

2 Open the print window from the application, and then select your fax driver.

3 Specify the fax settings.

NOTE: 

• The settings done here are only applied to a single fax job. 

4 Click Print. 

The Set/Check Fax Transmission window appears.
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5 Specify the destination for the recipient in one of the following ways:

• Specify a recipient directly.

a Enter a name and phone number directly.

b Click Add.

OR

• Select a recipient from the PC Fax Address Book saved on your computer.

a Click Look Up Address Book.

The Refer To Address Book window appears.

b On the Look Up Address Book tab, select a recipient and then click Add.

c Click OK.

OR

• Select a recipient from the Device Address Book.

a Click Look Up Address Book.

The Refer To Address Book window appears.

b On the Look Up Device Address Book tab, select a recipient and then click Add.

c Click OK.

NOTE: 

• Enter the password in the Password field in the Authorization area before sending a fax if the Fax 
service is locked with a password.

6 Click Start Sending.
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Receiving a Fax

This section includes:

• "About Receiving Modes" on page 254

• "Loading Paper for Receiving Faxes" on page 254

• "Receiving a Fax Automatically in the FAX Mode" on page 254

• "Receiving a Fax Manually in the TEL Mode" on page 255

• "Receiving a Fax Automatically in the TEL/FAX Mode or ANS/FAX Mode" on page 255

• "Receiving a Fax Manually Using an External Telephone" on page 255

• "Receiving Faxes Using the DRPD Mode" on page 256

• "Receiving Faxes in the Memory" on page 256

• "Polling Receive" on page 256

About Receiving Modes
There are five receiving modes; FAX Mode, TEL Mode, TEL/FAX Mode, ANS/FAX Mode, and DRPD 
Mode.

NOTE: 

• To use TEL/FAX Mode or ANS/FAX Mode, attach an external telephone or answering machine to the phone 
connector ( ) on the rear of your printer.

• When the memory is full, the fax is received in the TEL Mode.

See also: 
• "Receiving a Fax Automatically in the FAX Mode" on page 254

• "Receiving a Fax Manually in the TEL Mode" on page 255

• "Receiving a Fax Automatically in the TEL/FAX Mode or ANS/FAX Mode" on page 255

• "Using an Answering Machine" on page 263

• "Receiving Faxes Using the DRPD Mode" on page 256

Loading Paper for Receiving Faxes 
The instructions for loading paper in the priority sheet inserter (PSI) or multipurpose feeder (MPF) are 
the same whether you are printing, faxing, or copying, except that faxes can only be printed on Letter-, 
A4-, or Legal-sized paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

• "Setting Paper Sizes and Types" on page 152

Receiving a Fax Automatically in the FAX Mode
Your printer is preset to FAX Mode at the factory. 

If you receive a fax, the printer automatically goes into the fax receive mode after a specified period of 
time and receives the fax.

To change the interval at which the printer goes into the fax receive mode after receiving an incoming 
call, see "Auto Answer Fax" on page 283.
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Receiving a Fax Manually in the TEL Mode
To receive a fax manually, pick up the handset of the external telephone, and follow the instructions 
below.

1 Press the Fax button when you hear fax tones on the external telephone.

OffHook appears.

2 Press the  (Start) button.

3 Select Manual Receive, and then press the  button.

The printer receives the document.

Receiving a Fax Automatically in the TEL/FAX Mode or 
ANS/FAX Mode

To use TEL/FAX Mode or ANS/FAX Mode, you must attach an external telephone to the phone 
connector ( ) on the rear of your printer. 

In the TEL/FAX Mode, if the printer receives an incoming fax, the external telephone rings for the time 
specified in Auto Ans. TEL/FAX, and then the printer automatically receives a fax.

In the ANS/FAX Mode, if the caller leaves a message, the answering machine stores the message as 
it would normally. If your printer hears a fax tone on the line, it automatically starts to receive a fax. 

NOTE: 

• If you have set Auto Answer Fax and your answering machine is turned off, or no answering machine is 
connected to your printer, your printer will automatically go into the fax receive mode after a predefined time.

See also: 
• "Using an Answering Machine" on page 263

Receiving a Fax Manually Using an External Telephone
This feature works best when you are using an external telephone connected to the phone connector 
( ) on the rear of your printer. You can receive a fax from someone you are talking to on the external 
telephone without having to go to the printer.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the 
external telephone.

The printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try 
pressing the two-digit keys once again.

Remote Receive is set to Off at the factory. You can change the two-digit number to whatever you 
choose. For details on changing the code, see "Remote Rcv Tone" on page 285.

NOTE: 

• Set the dialing system of your external telephone to DTMF.
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Receiving Faxes Using the DRPD Mode
The Distinctive Ring Pattern Detection (DRPD) is a telephone company service which enables a user 
to use a single telephone line to answer several different telephone numbers. The particular number 
someone uses to call you on is identified by different ringing patterns, which consist of various 
combinations of long and short ringing sounds.

Before using the DRPD option, Distinctive Ring service must be installed on your telephone line by the 
telephone company. To set up DRPD, you will need another telephone line at your location, or 
someone available to dial your fax number from outside. 

To set up the DRPD:

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select DRPD Pattern, and then press the  button.

5 Select the desired menu item, and then press the  button.

6 Reboot the printer by turning the power switch off and then on.

To receive faxes in the DRPD, you need to set the menu to DRPD Mode. For more details, see "Ans 
Select" on page 283.

Your printer provides seven DRPD patterns. If this service is available from your telephone company, 
ask your telephone company which pattern you need to select to use this service.

See also: 
• "DRPD Pattern" on page 287

Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or 
printing. If you receive a fax while you are copying, printing, or run out of paper or toner, your printer 
stores incoming faxes in the memory. Then, as soon as you finish copying, printing, or re-supply the 
toner cartridges, the printer automatically prints the fax.

Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the Fax button.

2 Select Polling Receive, and then press the  button.

3 Select On, and then press the  button.

4 Enter the fax number of the remote machine, and then press the  button.

NOTE: 

• For information on how to enter the fax number of the remote machine, see "Sending a Fax 
Automatically" on page 245.

5 Press the  (Start) button.
256 Faxing (DocuPrint CM215 f/CM215 fw Only)



Automatic Dialing

This section includes:

• "Speed Dialing" on page 257

• "Storing a Number for Speed Dialing" on page 257

• "Sending a Fax Using a Speed Dial" on page 258

• "Group Dialing" on page 259

• "Setting Group Dial" on page 259

• "Editing Group Dial" on page 260

• "Sending a Fax Using Group Dialing (Multi-address Transmission)" on page 260

• "Printing an Address Book List" on page 261

Speed Dialing
You can store up to 99 frequently dialed numbers in speed dial locations (01– 99). 

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial 
number from the operator panel or CentreWare Internet Services.

Storing a Number for Speed Dialing

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Speed Dial, and then press the  button.

5 Select the desired speed dial number displayed as Not in Use between 01 and 99, and then 
press the  button.

6 Select Name, and then press the  button.

7 Enter the name, and then press the  button.

8 Select Phone Number, and then press the  button.

9 Enter the phone number you want to store using the numeric keypad, and then press the  
button.

To insert a pause between numbers, press the Redial/Pause button. "-" appears on the LCD 
panel.

10 Select Apply Settings, and then press the  button.

11 Confirm that Are You Sure? is displayed, select Yes, and then press the  button.

12 To store more fax numbers, repeat steps 5 to 11. 

13 To return to the previous screen, press the  (Back) button.
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Sending a Fax Using a Speed Dial

1 Load the document(s) facing up with top edge in first into the ADF or place a single document 
facing down on the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 241

• "Loading an Original Document on the Document Glass" on page 242

2 To enter the speed dial number, do either of the following after pressing the Fax button:

• Select Fax to, and then press the  button. Select Speed Dial, and then press the  
button.

• Press the Speed Dial button.

3 Enter the speed dial number between 01 and 99 using the numeric keypad.

The corresponding entry's name briefly appears on the LCD panel. 

4 Press the  button.

5 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 243

• "Lighten/Darken" on page 244

6 Press the  (Start) button.

7 The document scans to the memory.

When you are using the document glass, the display prompts you for another page. Select Yes 
to add more documents or to select No to begin sending the fax immediately, and then press the 

 button.

8 The fax number stored in the speed dial location is automatically dialed. The document is sent 
when the remote fax machine answers.

NOTE: 

• Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 
0*, you can send a document to the locations registered between 01 and 09.
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Group Dialing
If you frequently send the same document to several destinations, you can create a group of these 
destinations. You can create up to six groups. This enables you to use a group dial number setting to 
send the same document to all the destinations in the group.

NOTE: 

• You cannot include one group dial number within another group dial number.

Setting Group Dial

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Group Dial, and then press the  button.

5 Select the desired group dial number between 01 and 06, and then press the  button.

6 Select Name, and then press the  button.

7 Enter the name, and then press the  button.

8 Select Speed Dial No, and then press the  button.

9 Select the speed dial numbers, and then press the  button.

10 Select Apply Settings, and then press the  button.

11 Confirm that Are You Sure? is displayed, select Yes, and then press the  button.

12 To store more group dial numbers, repeat steps 5 to 11. 

13 To return to the previous screen, press the  (Back) button.
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Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the 
selected group.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Phone Book, and then press the  button.

4 Select Group Dial, and then press the  button.

5 Select the group dial number that you want to edit, and then press the  button.

6 To change the speed dial number:

a Select Speed Dial No, and then press the  button.

b Select or deselect the desired speed dial number. Press the  button.

c Select Apply Settings, and then press the  button.

d Confirm that Are You Sure? is displayed, select Yes, and then press the  button.

7 To change the group dial name:

a Select Name, and then press the  button.

b Enter a new name, and then press the  button.

c Select Apply Settings, and then press the  button.

d Confirm that Are You Sure? is displayed, select Yes, and then press the  button.

NOTE: 

• When you delete the last speed dial in a group, the group itself is not deleted.

8 To delete the group dial:

a Press the C (Clear) button.

b Confirm that Are You Sure? is displayed, select Yes, and then press the  button.

9 If you want to edit another group dial number or enter a new group dial number, repeat steps 5 to 
8.

10 To return to the previous screen, press the  (Back) button.

Sending a Fax Using Group Dialing (Multi-address 
Transmission)

You can use group dialing for broadcasting or delayed transmissions.

Follow the procedure of the desired operation (For delayed transmission, see "Sending a Delayed 
Fax" on page 248).

You can use one or more group numbers in one operation. Then continue the procedure to complete 
the desired operation. 

Your printer automatically scans the document loaded in the ADF or on the document glass into the 
memory. The printer dials each of the numbers included in the group.
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Printing an Address Book List
You can check your automatic dial setting by printing an Address Book List.

NOTE: 

• The list is printed in English.

1 Press the System button.

2 Select Report / List, and then press the  button.

3 Select Address Book, and then press the  button.

A list of your speed dial and group dial entries is printed.
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Other Ways to Fax

This section includes:

• "Using the Secure Receiving Mode" on page 262

• "Using an Answering Machine" on page 263

• "Using a Computer Modem" on page 264

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can 
turn on the secure receiving mode using the Secure Receive option to restrict printing out all of the 
received faxes when the printer is unattended. In the secure receiving mode, all incoming faxes will 
get saved in the memory. When the mode turns off, any faxes stored will be printed.

NOTE: 

• Before operation, make sure that Panel Lock Set is set to Enable.

To turn the secure receiving mode on:

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Enter the password for Panel Lock, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Secure Receive, and then press the  button.

6 Select Secure Receive Set, and then press the  button.

7 Select Enable, and then press the  button.

NOTE: 

• The factory-default password is 0000.

8 To return to the previous screen, press the  (Back) button.

When a fax is received in the secure receiving mode, your printer stores it into memory and the 
Job Status screen displays Secure Receive to let you know that there is a fax stored.

NOTE: 

• If you change the password while Secure Receive Set is set to Enable, perform steps 1 to 5. Select 
Change Password, and then press the  button. Enter the new password, and then press the  
button.
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To print received documents:

1 Press the Job Status button.

2 Select Secure Receive, and then press the  button.

3 Enter the password, and then press the  button.

The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Access the Secure Receive Set menu by following steps 1 to 6 mentioned above in "To turn 
the secure receiving mode on:".

2 Select Disable, and then press the  button.

3 To return to the previous screen, press the  (Back) button.

Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the rear of your printer as shown 
above.

• Set your printer to ANS/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the 
TAD to respond.

• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received 
and then starts receiving the fax.

• If the answering device is off, the printer automatically goes into the fax receive mode after the 
ring tone sounds for a predefined time.

• If you answer the call and hear fax tones, the printer will answer the fax call if you

– Set OnHook to On (you can hear voice or fax tones from the remote machine), and then 
press the  (Start) button, select Manual Receive and press the  button, and then 
hang up the receiver.

OR

– Press the two-digit remote receive code and hang up the receiver.

To the 
wall jack

Printer
Line

Telephone Answering Device Phone
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Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up Internet connection, connect the 
computer modem directly to the rear of your printer with the TAD as shown above.

• Set your printer to ANS/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the 
TAD to respond.

• Turn off the computer modem's fax-receive feature.

• Do not use the computer modem if your printer is sending or receiving a fax.

• Follow the instructions provided with your computer modem and fax application to fax via the 
computer modem.

To the 
Internet

Computer

Printer

Line

Telephone Answering Device Phone
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Setting Sounds

This section includes:

• "Speaker Volume" on page 265

• "Ringer Volume" on page 265

Speaker Volume

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Line Monitor, and then press the  button.

5 Select the desired volume, and then press the  button.

6 Reboot the printer by turning the power switch off and then on.

Ringer Volume

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Ring Tone Volume, and then press the  button.

5 Select the desired volume, and then press the  button.

6 Reboot the printer by turning the power switch off and then on.
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Specifying the Fax Settings

This section includes:

• "Changing the Fax Settings Options" on page 266

• "Available Fax Setting Options" on page 267

Changing the Fax Settings Options

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the numeric keypad.

6 Press the  button to save the selection. 

7 If necessary, repeat steps 4 to 6.

8 To return to the previous screen, press the  (Back) button.

For details on available menu items, see "Available Fax Setting Options" on page 267.
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Available Fax Setting Options
You can use the following setting options for configuring the fax system:

Option Description

Ans Select TEL Mode Automatic fax reception is turned off. You can receive a fax by 
picking up the handset of the external telephone, and then 
pressing the remote receive code, or setting OnHook to On 
(you can hear voice or fax tones from the remote machine), 
pressing the  (Start) button, and then selecting Manual 
Receive.

FAX Mode * Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external 
telephone rings for the time specified in Auto Ans. 
TEL/FAX, and then the printer automatically receives a fax. If 
an incoming call is not a fax, the printer beeps from the 
internal speaker indicating that the call is a telephone call.

ANS/FAX Mode The printer can share a telephone line with an answering 
machine. In this mode, the printer will monitor the fax signal 
and pick up the line if there are fax tones. If the phone 
communication is using serial transmission in your region, this 
mode is not supported. 

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) 
option, a distinctive ring service must be installed on your 
telephone line by the telephone company. After the telephone 
company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for 
that specific ring pattern.

Auto Answer 
Fax

Sets the interval at which the printer goes into the fax receive mode after receiving 
an incoming call. 

Auto Ans. 
TEL/FAX

Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call.

Auto Ans. 
ANS/FAX

Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call.

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission through 
the internal speaker until a connection is made.

Ring Tone 
Volume

Sets the volume of the ring tone, which indicates that an incoming call is a telephone 
call through the internal speaker when Ans Select is set to TEL/FAX Mode.

Line Type Sets the line type.

Dialing Type Sets the dialing type.

NOTE: 

• The available values differ depending on your Region setting.

Interval Timer Specifies the interval between transmission attempts. 

Number of 
Redial

Specifies the number of redial attempts to make when the destination fax number is 
busy. If you enter 0, the printer will not redial.

Redial Delay Specifies the interval between redial attempts.

Junk Fax 
Filter

Sets whether to reject faxes sent from unwanted numbers by accepting faxes only 
from the fax numbers registered in the Address Book.

Remote Receive Sets whether to receive a fax by pressing a remote receive code on the external 
telephone.
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Remote Rcv 
Tone

Specifies the remote receive code in two digits to start Remote Receive.

Send Header Sets whether to print the information of sender on the header of faxes.

Company Name Sets the name of sender to be printed on the header of faxes. Up to 30 
alphanumeric characters can be entered.

Your Fax 
Number

Sets the fax number of the printer to be printed on the header of faxes.

Fax Cover Page Sets whether to attach a cover page to faxes.

DRPD Pattern Sets the DRPD setting from Pattern1 to Pattern7. DRPD is a service provided 
by some telephone companies.

Forward 
Settings

Select Forward Only or Forward and Print to forward incoming faxes to the 
destination number specified for Fax Fwd Number.

You can also select options such as E-Mail and Print to forward incoming faxes 
with an e-mail to the destination e-mail address specified for Fax Fwd E-Mail, 
and Forward to Server or Fwd to Server and Print to forward incoming 
faxes to the server address specified on the CentreWare Internet Services.

Fax Fwd Number Enter the forwarding fax number when you have selected Forward Only or 
Forward and Print for Forward Settings.

Fax Fwd E-Mail Enter the forwarding e-mail address when you have selected E-Mail and Print 
for Forward Settings.

Prefix Dial Specifies whether to set a prefix dial number.

Prefix Dial 
Num

Sets a prefix dial number of up to five digits. This number dials before any auto dial 
number is started. It is useful for accessing the Private Automatic Branch Exchange 
(PABX).

Discard Size Sets whether to discard text or images at the bottom of a fax page when the entire 
page does not fit onto the output paper. Selecting Auto Reduction automatically 
reduces the fax page to fit it onto the output paper, and does not discard any images 
or text at the bottom of the page.

ECM Sets whether to enable the ECM. To use the ECM, the remote machines must also 
support the ECM.

Extel Hook 
Thresh

You can select the external telephone hook detection threshold for the condition in 
which a telephone line is not being used.

Modem Speed Specifies the fax modem speed when a fax transmission or reception error occurs.

Fax Activity Sets whether to automatically print a fax activity report after every 50 incoming and 
outgoing fax communications.

Fax Transmit Sets whether to print a transmission report after every fax transmission or only when 
an error occurs.

Fax Broadcast Sets whether to print a transmission report after every fax transmission to multiple 
destinations or only when an error occurs.

Region Sets the region where the printer is used.

Option Description
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• Prefix Dial

NOTE: 

• Prefix Dial only supports the environment where you send a fax to the external line number. To use 
Prefix Dial, you must do the following from the operator panel. 

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Line Type, and then press the  button.

5 Select PBX, and then press the  button.

6 Press the  (Back) button to return to the previous menu.

7 Select Prefix Dial, and then press the  button.

8 Select On, and then press the  button.

9 Press the  (Back) button to return to the previous menu.

10 Select Prefix Dial Num, and then press the  button.

11 Enter an up-to-five-digit prefix number from 0–9, *, and #.

12 Press the  button when the prefix dial number on the LCD panel is correct.

13 Reboot the printer by turning the power switch off and then on.
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Changing Setting Options

The fax menu options can be set to the most frequently used modes.

To create your own default settings:

1 Press the System button.

2 Select Defaults Settings, and then press the  button.

3 Select Fax Defaults, and then press the  button.

4 Select the desired menu item, and then press the  button.

5 Select the desired setting or enter the value using the numeric keypad, and then press the  
button.

6 Repeat steps 4 and 5, as needed.

7 To return to the previous screen, press the  (Back) button.
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Printing a Report

The following reports may be useful when using fax:

• Address Book List

This list shows all the addresses currently stored in the memory of the printer as Address Book 
information.

• Fax Activity Report

This report shows information about the recent 50 faxes you received or sent. 

• Protocol Monitor

This report shows the status of the protocol when the latest fax was being sent.

• Monitor Report

This report shows the details of a fax job. This is printed when the fax was successfully sent.

• Transmission Report

This report shows the details of a fax job. This is printed when the fax transmission failed.

• Fax Broadcast Report

This report shows all the destinations of a broadcast fax and the transmission result for each 
destination.

NOTE: 

• The reports and lists are all printed in English.

To print a report or list:

1 Press the System button.

2 Select Report / List, and then press the  button.

3 Select the report or list you want to print, and then press the  button.

The selected report or list is printed.

NOTE: 

• You cannot manually print Monitor Report, Transmission Report or Fax Broadcast Report using the procedure 
above. They are printed after a fax job completed according to the setting. For details on the setting of when to 
print them, see "Fax Transmit" on page 290 or "Fax Broadcast" on page 290.
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9
Using the Operator Panel Menus and 
Keypad

This chapter includes:

• "Understanding the Printer Menus" on page 274

• "Panel Lock Function" on page 315

• "Limiting Access to Printer Operations" on page 317

• "Setting the Time for the Power Saver Mode" on page 318

• "Resetting to Factory Defaults" on page 319

• "Using the Numeric Keypad" on page 320
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Understanding the Printer Menus

This section describes menu options that can be accessed by pressing the System button on the 
operator panel.

This section includes:

• "Report / List" on page 274

• "Meter Readings" on page 275

• "Admin Menu" on page 276

• "Defaults Settings" on page 303

• "Tray Settings" on page 313

• "Panel Language" on page 314

NOTE: 

• The access to Admin Menu and Report / List can be limited with a password by enabling the Panel 
Lock. For more information, see "Panel Lock Function" on page 315.

Report / List
Use Report / List to print various types of reports and lists.

NOTE: 

• A password is required to enter the Report / List menu when Panel Lock Set is set to Enable. In this 
case, enter the password you specified, and press the  button.

• The reports and lists are all printed in English.

System Settings
Purpose:

To print a list of the information such as the printer name, serial number, and print volume.

For the DocuPrint CM215 f/CM215 fw, network settings are also printed.

Panel Settings
Purpose:

To print a detailed list of all the settings on the operator panel menus.

Job History
Purpose:

To print a detailed list of the jobs that have been processed. This list contains the last 50 jobs.

Error History
Purpose:

To print a detailed list of paper jams and fatal errors.
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Demo Page
Purpose:

To print a test page.

Protocol Monitor (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To print a detailed list of monitored protocols.

Address Book (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To print the list of all addresses stored as Address Book information.

Fax Activity (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To print the report of faxes you recently received or sent.

Meter Readings
Use Meter Readings to check the total number of printed pages.

Values:

Meter 1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3 Always shows 0 on your printer.

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + 
Meter 2).
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Admin Menu
Use Admin Menu to configure a variety of printer features.

NOTE: 

• A password is required to enter Admin Menu when Panel Lock Set is set to Enable. In this case, enter 
the password you specified, and press the  button.

Phone Book (DocuPrint CM215 f/CM215 fw Only)
Use the Phone Book menu to configure the speed dial and group dial settings.

• Speed Dial
Purpose:

To store up to 99 frequently dialed numbers in speed dial locations.

NOTE: 

• The first eight entries are assigned to the one-touch buttons on the operator panel.

See also: 
• "Storing a Number for Speed Dialing" on page 257

• Group Dial
Purpose:

To create a group of fax destinations and register it under a 2-digit dial code. Up to 6 group dial codes 
can be registered.

See also: 
• "Setting Group Dial" on page 259
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Network (DocuPrint CM215 f/CM215 fw Only)
Use the Network menu to change the printer settings affecting jobs sent to the printer through the 
network.

NOTE: 

• Asterisk (*) is the factory default setting.

• Ethernet
Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes 
effective after the printer is turned off and then on.

Values:

NOTE: 

• For the DocuPrint CM215 fw, this item is not displayed when the Ethernet cable is disconnected and Wi-Fi is 
set to On.

• Wireless Status (DocuPrint CM215 fw Only)
Purpose:

To display the information on the wireless signal strength. No changes can be made on the operator 
panel to improve the status of the wireless connection.

Values:

NOTE: 

• This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10base-T half-duplex.

10BASE-T Full Uses 10base-T full-duplex.

100BASE-TX Half Uses 100base-TX half-duplex.

100BASE-TX Full Uses 100base-TX full-duplex.

Good Indicates good signal strength.

Acceptable Indicates marginal signal strength.

Low Indicates insufficient signal strength.

No Reception Indicates that no signal is received.
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• Wireless Setup (DocuPrint CM215 fw Only)
Purpose:

To configure the wireless network interface.

Values:

Select 
Access

Select the access point from the list. The access points are listed starting with the one in 
the best communication condition.

WEP Key Entry When you select an access point using WEP as the security method, 
enter the WEP key. For 64bit keys, enter 10 hexadecimal characters. 
For 128bit keys, enter 26 hexadecimal characters.

PassPhrase 
Entry

When you select an access point using WPA, WPA2, or Mixed as the 
encryption type, enter the passphrase of 8 to 63 alphanumeric 
characters.
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NOTE: 

• This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

Manual 
Setup

Enter Network 
(SSID)

Specify a name to identify the wireless network. Up to 32 
alphanumeric characters can be entered.

Infrastructure Select to configure the wireless settings through the access point 
such as a wireless router.

No Security Select to configure the wireless settings with no 
encryption settings.

Mixed Mode 
PSK

Select to configure the wireless settings with the 
Mixed Mode PSK encryption. Mixed Mode PSK 
automatically selects the encryption type from 
either WPA-PSK-TKIP, WPA-PSK-AES, or WPA2-
PSK-AES.

PassPhrase 
Entry

Specify the pass phrase of 
alphanumeric characters from 8 
to 63.

WPA-PSK-
TKIP

Select to configure the wireless settings with the 
WPA-PSK-TKIP encryption.

PassPhrase 
Entry

Specify the pass phrase of 
alphanumeric characters from 8 
to 63.

WPA2-PSK-
AES

Select to configure the wireless settings with the 
WPA2-PSK-AES encryption.

PassPhrase 
Entry

Specify the pass phrase of 
alphanumeric characters from 8 
to 63.

WEP Select to configure the wireless settings with the 
WEP encryption.

WEP Key 
Entry

Specify the WEP key to use 
through the wireless network. For 
64bit keys, enter 10 hexadecimal 
characters. For 128bit keys, enter 
26 hexadecimal characters.

Transmit 
Key

Select a transmit key from WEP 
Key 1, WEP Key 2, WEP Key 3, 
and WEP Key 4.

Ad-hoc Select to configure the wireless setting without the access point such 
as a wireless router.

No Security Select to configure the wireless settings with no 
encryption settings.

WEP Select to configure the wireless settings with the 
WEP encryption.

WEP Key 
Entry

Specify the WEP key to use 
through the wireless network. For 
64bit keys, enter 10 hexadecimal 
characters. For 128bit keys, enter 
26 hexadecimal characters.

Transmit 
Key

Select a transmit key from WEP 
Key 1, WEP Key 2, WEP Key 3, 
and WEP Key 4.
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• WPS (DocuPrint CM215 fw Only)
Purpose:

To configure wireless networks in accordance with the WPS standards.

Values:

NOTE: 

• Instead of selecting Push Button Control, you can also start WPS-PBC by pressing and holding the  
(WPS) button. 

• WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed Mode PSK, 
WPA-PSK-AES, WPA2-PSK-AES, WPA-PSK-TKIP, Open (No Security)

• This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

• Reset Wireless (DocuPrint CM215 fw Only)
Purpose:

To initialize wireless network settings. After executing this function and rebooting the printer, all 
wireless network settings are reset to their factory default values.

Values:

NOTE: 

• This item is displayed when the Ethernet cable is disconnected and Wi-Fi is set to On.

Push Button 
Control

PBC Start No* Disables the security method of WPS-PBC.

Yes Configures the wireless setting with the security method of 
WPS-PBC.

PIN Code Start 
Configuration

Configures the wireless setting using the PIN code assigned 
automatically by the printer.

Print PIN Code Prints the PIN code. Confirm it when you enter the PIN code to 
your computer.

No* Does not reset the wireless setting.

Yes Resets the wireless setting.
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• TCP/IP
Purpose:

To configure TCP/IP settings. The change becomes effective after the printer is turned off and then on.

Values:

NOTE: 

• When you set an IP address in IPv6 mode, use the CentreWare Internet Services. For more information, refer 
to the Help on the CentreWare Internet Services.

• Protocol
Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and 
then on.

Values:

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Uses IPv4 to set the IP address.

IPv4 Get IP 
Address

DHCP/AutoIP* Automatically sets the IP address.

BOOTP Uses BOOTP to set the IP address.

RARP Uses RARP to set the IP address.

DHCP Uses DHCP to set the IP address.

Panel Enables the IP address entered on the operator 
panel.

IP Address Manually sets the IP address allocated to the 
printer.

Subnet Mask Manually sets the subnet mask.

Gateway Address Manually sets the gateway address.

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port 9100 Disable Disables the Port 9100 port.

Enable* Enables the Port 9100 port.

WSD Disable Disables the Web Services on Devices (WSD) port.

Enable* Enables the WSD port.

SNMP Disable Disables the Simple Network Management Protocol (SNMP) 
UDP port.

Enable* Enables the SNMP UDP port.

StatusMessenger Disable Disables the StatusMessenger feature.

Enable* Enables the StatusMessenger feature.

Internet Services Disable Disables an access to the CentreWare Internet Services 
embedded in the printer.

Enable* Enables an access to the CentreWare Internet Services 
embedded in the printer.

Bonjour(mDNS) Disable Disables the Bonjour (mDNS).

Enable* Enables the Bonjour (mDNS).
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• IP Filter

NOTE: 

• The IP Filter feature is supported for IPv4 addresses and available only for LPD or Port 9100.

Purpose:

To block data received from certain IP addresses through the network. You can set up to five IP 
addresses. To make any changes effective, turn off the printer and then turn it back on.

Values:

• Initialize NVM
Purpose:

To initialize wired network data stored in Non-Volatile Memory (NVM). After executing this function and 
rebooting the printer, all wired network settings are reset to their default values.

Values:

• Wi-Fi (DocuPrint CM215 fw Only)
Purpose:

To enable the wireless connection.

Values:

NOTE: 

• This item is displayed only when the Ethernet cable is disconnected.

• When you use the USB connection and do not use the wireless connection, you need to disable Wi-Fi.

No.n/Address

(n is 1 - 5.)

Sets the IP address for Filter n.

No.n/Mask

(n is 1 - 5.)

Sets the address mask for Filter n.

No.n/Mode

(n is 1 - 5.)

Reject Rejects an access from the specified IP address.

Accept Accepts an access from the specified IP address.

Off* Disables the IP Filter feature for Filter n.

Yes

No*

Off

On*
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Fax Settings (DocuPrint CM215 f/CM215 fw Only)
Use the Fax Settings menu to configure the basic fax settings. 

NOTE: 

• Asterisk (*) is the factory default setting.

• Ans Select
Purpose:

To select the default fax receiving mode.

Values:

• Auto Answer Fax
Purpose:

To set the interval at which the printer goes into the fax receive mode after receiving an incoming call. 
The interval can be specified within the range of 0 to 255 seconds. The default is 0 second.

• Auto Ans. TEL/FAX
Purpose:

To set the interval at which the printer goes into the fax receive mode after the external telephone 
receives an incoming call. The interval can be specified within the range of 0 to 255 seconds. The 
default is six seconds.

• Auto Ans. ANS/FAX
Purpose:

To set the interval at which the printer goes into the fax receive mode after the external answering 
machine receives an incoming call. The interval can be specified within the range of 0 to 255 seconds. 
The default is 21 seconds.

TEL Mode Automatic fax reception is turned off. You can receive a fax by picking 
up the handset of the external telephone, and then pressing the 
remote receive code, or setting OnHook to On (you can hear voice or 
fax tones from the remote machine), pressing the  (Start) button, 
and then selecting Manual Receive.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone 
rings for the time specified in Auto Ans. TEL/FAX, and then the 
printer automatically receives a fax. If an incoming call is not a fax, 
the printer beeps from the internal speaker indicating that the call is a 
telephone call.

ANS/FAX Mode The printer can share a telephone line with an answering machine. In 
this mode, the printer will monitor the fax signal and pick up the line if 
there are fax tones. If the phone communication is using serial 
transmission in your region, this mode is not supported. 

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, a 
distinctive ring service must be installed on your telephone line by the 
telephone company. After the telephone company has provided a 
separate number for faxing with a distinctive ring pattern, configure 
the fax setup to monitor for that specific ring pattern.
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• Line Monitor
Purpose:

To set the volume of the line monitor, which audibly monitors a transmission through the internal 
speaker until a connection is made.

Values:

• Ring Tone Volume
Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the 
internal speaker when Ans Select is set to TEL/FAX Mode.

Values:

• Line Type
Purpose:

To select the line type.

Values:

• Dialing Type
Purpose:

To select the dialing type.

Values:

NOTE: 

• The available values differ depending on your Region setting.

Off Turns off the volume of the line monitor.

Min Sets the volume of the line monitor.

Middle*

Max

Off Turns off the volume of the ring tone.

Min Sets the volume of the ring tone.

Middle

Max*

PSTN* Sets the line type to PSTN.

PBX Sets the line type to PBX.

Tone* Sets the dialing type to Tone.

DP (10pps) Sets the dialing type to Dial Pulse (10 pulse per second).

DP (20pps) Sets the dialing type to Dial Pulse (20 pulse per second).
284 Using the Operator Panel Menus and Keypad



• Interval Timer
Purpose:

To specify the interval between transmission attempts within the range of 3 to 255 seconds. The 
default is eight seconds.

• Number of Redial
Purpose:

To specify the number of redial attempts to make when the destination fax number is busy, within the 
range of 0 to 9. If you enter 0, the printer will not redial. The default is 3.

• Redial Delay
Purpose:

To specify the interval between redial attempts within the range of 1 to 15 minutes. The default is one 
minute.

• Junk Fax Filter
Purpose:

To reject faxes sent from unwanted numbers by accepting faxes only from the fax numbers registered 
in the Address Book.

Values:

NOTE: 

• Be sure to register the fax numbers you want to accept faxes from in the Address Book before using Junk 
Fax Filter.

• Remote Receive
Purpose:

To receive a fax by pressing a remote receive code on the external telephone after picking up the 
handset of the telephone.

Values:

• Remote Rcv Tone
Purpose:

To specify the remote receive code in two digits to start Remote Receive. 

Off* Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Off* Does not receive a fax by pressing a remote receive code on the 
external telephone.

On Receives a fax by pressing a remote receive code on the external 
telephone.
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• Send Header
Purpose:

To print the information of sender on the header of faxes.

Values:

• Company Name
Purpose:

To set the name of sender to be printed on the header of faxes. Up to 30 alphanumeric characters can 
be entered.

• Your Fax Number
Purpose:

To set the fax number of the printer to be printed on the header of faxes.

• Fax Cover Page
Purpose:

To set whether to attach a cover page to faxes.

Values:

Off Does not print the information of sender on the header of faxes.

On* Prints the information of sender on the header of faxes.

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.
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• DRPD Pattern
Purpose:

To provide a separate number for faxing with a distinctive ring pattern.

Values:

Pattern1-7 DRPD is a service provided by some telephone companies. DRPD 
patterns are specified by your telephone company. The patterns 
provided with your printer are shown below:

Ask your telephone company which pattern you need to select to use 
this service. For example, Pattern7 is the New Zealand FaxAbility 
distinctive ringing pattern: rings for 400ms, stops for 800ms, rings for 
400ms and stops for 1400ms. This pattern is repeated over and over 
again. This printer only responds to Distinctive Alert cadence(s) DA4 
in New Zealand.

Pattern1

Pattern2

Pattern3

Pattern4

Pattern5

Pattern6

Pattern7
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• Forward Settings
Purpose:

To specify whether to forward incoming faxes to a specified destination.

Values:

• Fax Fwd Number
Purpose:

To enter the fax number of the destination to where incoming faxes will be forwarded.

• Fax Fwd E-Mail
Purpose:

To enter the e-mail address to where incoming faxes will be sent with an e-mail.

• Prefix Dial
Purpose:

To select whether to set a prefix dial number.

Values:

• Prefix Dial Num
Purpose:

To set a prefix dial number of up to five digits. This number dials before any auto dial number is 
started. It is useful for accessing the Private Automatic Branch Exchange (PABX).

Off* Incoming faxes will not be forwarded.

Forward Only Incoming faxes will be forwarded to a specified destination.

Forward and Print Incoming faxes will be forwarded to a specified destination by Fax 
and printed.

E-Mail and Print Incoming faxes will be sent with an e-mail to a specified destination 
by E-mail and printed.

Forward to Server Incoming faxes will be forwarded to a server specified on the 
CentreWare Internet Services.

Fwd to Server and Print Incoming faxes will be forward to a server specified on the 
CentreWare Internet Services and printed.

Off* Does not set a prefix dial number.

On Sets a prefix dial number.
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• Discard Size
Purpose:

To set whether to discard text or images at the bottom of a fax page when the entire page does not fit 
onto the output paper.

Values:

• ECM
Purpose:

To set whether to enable the Error Correction Mode (ECM). To use the ECM, the remote machines 
must also support the ECM.

Values:

• Extel Hook Thresh
Purpose:

To select the external telephone hook detection threshold for the condition in which a telephone line is 
not being used.

Values:

• Modem Speed
Purpose:

To specify the fax modem speed when a fax transmission or reception error occurs.

Values:

Off Prints any excess at the bottom of a fax page without discarding it.

On Discards any excess at the bottom of a fax page.

Auto Reduction* Automatically reduces a fax page to fit it onto the output paper.

Off Disable the ECM.

On* Enables the ECM.

Lower Sets the external telephone hook detection threshold to Lower.

Normal* Sets the external telephone hook detection threshold to Normal.

Higher Sets the external telephone hook detection threshold to Higher.

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps*
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• Fax Activity
Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax 
communications.

Values:

• Fax Transmit
Purpose:

To set whether to print a transmission report after every fax transmission or only when an error occurs.

Values:

• Fax Broadcast
Purpose:

To set whether to print a transmission report after every fax transmission to multiple destinations or 
only when an error occurs.

Values:

• Region
Purpose:

To select the region where the printer is used.

Auto Print* Automatically prints a fax activity report after every 50 incoming and 
outgoing fax communications.

No Auto Print Does not automatically print a fax activity report.

Print Always Prints a transmission report after every fax transmission.

Print On Error* Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always* Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission to 
multiple destinations.
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System Settings
Use the System Settings menu to configure a variety of printer features. 

NOTE: 

• Asterisk (*) is the factory default setting.

• Power Saver Timer
Purpose:

To specify the time for transition to the Power Saver mode.

Values:

Select 5min (default) for Low Power Timer if your printer shares an electrical circuit with your room 
lights and you notice them flickering. Otherwise, select a high value to keep your printer available for 
frequent use with the minimum warm-up time.

The printer automatically returns to the standby mode from the Power Saver mode when it receives 
data from the computer. In the Low Power mode, you can also return the printer to the standby mode 
by pressing any button on the operator panel. In the Sleep mode, you can return the printer to the 
standby mode by pressing the  (Energy Saver) button.

• Auto Reset
Purpose:

To automatically reset the settings for copying, scanning, or faxing to the defaults and return to the 
standby mode after you do not specify any settings for the specified time. (The fax feature is available 
only on the DocuPrint CM215 f/CM215 fw.)

Values:

• Fault Time-Out
Purpose:

To specify the time taken by the printer before it cancels jobs that stop abnormally. The job is 
cancelled if it times out.

Values:

Low Power 
Timer

5min* Specifies the time taken by the printer before it enters the Low 
Power mode after it finishes a job.5–30min

Sleep Timer 6min* Specifies the time taken by the printer before it enters the 
Sleep mode after it goes into the Low Power mode.1–6min

45sec*

1min

2min

3min

4min

Off Disables the fault time-out.

On 60sec* Specifies the time taken by the printer before it cancels for jobs 
that stop abnormally.3–300sec
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• Job Time-Out
Purpose:

To specify the amount of time that the printer waits for data to arrive from the computer. The print job is 
cancelled if it times out. 

Values:

• Clock Settings
Purpose:

To set the date and time, and regional time zone of the printer.

Values:

• Alert Tone
Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message 
appears. 

Values:

Off Disables the job time-out.

On 60sec* Specifies the amount of time that the printer waits for data to 
arrive from the computer.5–300sec

Set Date Specifies the current date.

Set Time Specifies the current time.

Date Format yy / mm / dd Specifies the date format.

mm / dd / yy

dd / mm / yy*

Time Format 12H* Specifies the time format.

24H

Time Zone Specifies the time zone.

Panel Select 
Tone

Off* Does not emit a tone when the operator panel input is correct.

Min Emits a tone at the specified volume when the operator panel 
input is correct.Middle

Max

Panel Alert 
Tone

Off* Does not emit a tone when the operator panel input is 
incorrect.

Min Emits a tone at the specified volume when the operator panel 
input is incorrect.Middle

Max

Auto Clear 
Alert

Off* Does not emit a tone before the printer performs auto clear.

Min Emits a tone at the specified volume five seconds before the 
printer performs auto clear.Middle

Max
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• mm / inch
Purpose:

To specify the measurement unit displayed after the numeric value on the operator panel.

Values:

• Low Toner Alert Msg
Purpose:

To specify whether to show the alert message when the toner is low.

Values:

• Power On Wizard
Purpose:

To perform initial settings for the printer.

See also: 
• "Setting Initial Settings on the Operator Panel" on page 52

Values:

Job Tone Off Does not emit a tone when a job is complete.

Min Emits a tone at the specified volume when a job is complete.

Middle*

Max

Alert Tone Off Does not emit a tone when a problem occurs.

Min Emits a tone at the specified volume when a problem occurs.

Middle*

Max

Out of Paper Off Does not emit a tone when the printer runs out of paper.

Min Emits a tone at the specified volume when the printer runs out 
of paper.Middle*

Max

All Tones Off Disables all the alert tones.

Min Sets the volume of all the alert tones at once.

Middle

Max

Millimeters (mm)* Specifies the default measurement unit.

Inches (")

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

Yes Performs the initial settings for the printer.

No* Does not perform the initial settings for the printer.
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Maintenance
Use the Maintenance menu for maintenance work including initialization of the NVM (non-volatile 
memory).

NOTE: 

• Asterisk (*) is the factory default setting.

• F/W Version
Purpose:

To display the version of the controller.

• Adjust Paper Type
Purpose:

To adjust the paper type.

Values:

Plain Lightweight

Heavyweight*

Labels Lightweight

Heavyweight*
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• Adjust BTR
Purpose:

To specify the optimum voltage settings for printing for the transfer roller (BTR). To lower the voltage, 
set negative values. To increase, set positive values.

The default settings may not give the best output on all paper types. If you see mottles on the print 
output, try to increase the voltage. If you see white spots on the print output, try to decrease the 
voltage.

NOTE: 

• The print quality changes depending on the values you select for this item.

Values:

Plain 0*

-3 – 3

Bond 0*

-3 – 3

Light Card 0*

-3 – 3

LW Gloss Card 0*

-3 – 3

Labels 0*

-3 – 3

Recycled 0*

-3 – 3

Envelope 0*

-3 – 3
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• Adjust Fusing Unit
Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, 
set negative values. To increase, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has 
curled, try to lower the temperature. When the toner does not fuse on the paper properly, try to 
increase the temperature.

NOTE: 

• The print quality changes depending on the values you select for this item.

Values:

• Auto Regi Adjust
Purpose: 

To specify whether to automatically adjust color registration.

Values:

Plain 0*

-3 – 3

Bond 0*

-3 – 3

Light Card 0*

-3 – 3

LW Gloss Card 0*

-3 – 3

Labels 0*

-3 – 3

Recycled 0*

-3 – 3

Envelope 0*

-3 – 3

Off Does not automatically adjust color registration.

On* Automatically adjusts color registration.
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• Adjust ColorRegi
Purpose:

To automatically adjust color registration.

Color registration adjustment need to be made during the initial setup of the printer or when the printer 
is moved to a different location.

NOTE: 

• The Adjust ColorRegi feature can be configured when Auto Regi Adjust is set to Off.

Values:

• Clean Developer
Purpose:

To rotate the developer motor and stir the toner in the toner cartridge.

Values:

• Toner Refresh
Purpose:

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in 
a new toner cartridge.

Values:

• BTR Refresh
Purpose:

Specify whether to execute counter measures for curling/separating discharge of the paper.

Values:

Auto Adjust Yes Automatically corrects color registration.

No* Does not correct color registration automatically.

Yes Stirs the toner in a new toner cartridge.

No* Does not stir the toner in a new toner cartridge.

Yellow Yes Cleans the toner in the yellow toner cartridge.

No* Does not clean the toner in the yellow toner cartridge.

Magenta Yes Cleans the toner in the magenta toner cartridge.

No* Does not clean the toner in the magenta toner cartridge.

Cyan Yes Cleans the toner in the cyan toner cartridge.

No* Does not clean the toner in the cyan toner cartridge.

Black Yes Cleans the toner in the black toner cartridge.

No* Does not clean the toner in the black toner cartridge.

Off* Does not automatically execute counter measures for 
curling/separating discharge of the paper.

On Automatically executes counter measures for curling/separating 
discharge of the paper.
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• Initialize NVM
Purpose:

To initialize NVM for system parameters, Address Book data for fax, or Address Book data for e-mail. 
After executing this function and rebooting the printer, the menu parameters or data, except the 
parameters for the network, are reset to their factory default values. (Address Book is available only 
on the DocuPrint CM215 f/CM215 fw.)

See also: 
• "Resetting to Factory Defaults" on page 319

Values:

DocuPrint CM215 f/CM215 fw:

DocuPrint CM215 b:

• Non-Genuine Mode
Purpose:

To use toner cartridges of another manufacturer.

NOTE: 

• Using non-genuine toner cartridges may make some printer features unusable, reduce print quality and 
decrease the reliability of your printer. Fuji Xerox recommends only new Fuji Xerox brand toner cartridges for 
your printer. Fuji Xerox does not provide warranty coverage for problems caused by using consumables not 
supplied by Fuji Xerox.

• Before you use toner cartridges of another manufacturer, be sure to restart the printer.

Values:

User Fax 
Section

Yes Initializes the fax number entries in the Address Book.

No* Does not initialize the fax number entries in the Address Book.

User Scan 
Section

Yes Initializes the e-mail and server address entries in the Address 
Book.

No* Does not initialize the e-mail and server address entries in the 
Address Book.

System Section Yes Initializes the system parameters.

No* Does not initialize the system parameters.

System Section Yes Initializes the system parameters.

No* Does not initialize the system parameters.

Off* Does not use toner cartridges of another manufacturer.

On Uses toner cartridges of another manufacturer.
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• Adjust Altitude
Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. 
Adjustments are performed by specifying the altitude of the location where the printer is being used. 

NOTE: 

• An incorrect altitude adjustment setting leads to poor printing quality or incorrect indication of remaining toner.

Values:

• Machine Life
Purpose:

To specify whether to continue print operations when the printer comes to the end of its service life.

Values:

NOTE: 

• When the printer no longer operates showing the error code 191-310 on the LCD panel, press the  
(Back) button and the  button at the same time and change the Machine Life setting to Continue 
Print. Then, you can keep using the printer.

• Although you can keep using the printer after the end of its service life by changing the setting to Continue 
Print, the printing quality is not guaranteed. 

0m* Specifies the altitude of the location where the printer is installed.

1000m

2000m

3000m

Stop Print* Stops print operations at the end of service life.

Continue Print Continues print operations after the end of service life.
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Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents 
items from being changed accidentally.

NOTE: 

• Asterisk (*) is the factory default setting.

• Panel Lock
Purpose:

To restrict access to Admin Menu and Report / List with a password.

See also: 
• "Panel Lock Function" on page 315

NOTE: 

• For the DocuPrint CM215 f/CM215 fw, you can select Disable for Panel Lock Set when all items under 
Service Lock are set to Unlocked and Secure Receive Set is set to Disable.

• For the DocuPrint CM215 b, you can select Disable for Panel Lock Set when all items under Service 
Lock are set to Unlocked.

Values:

Panel Lock Set Disable* Does not restrict access to Admin Menu and Report / 
List with a password.

Enable Restricts access to Admin Menu and Report / List with a 
password.

Change 
Password

0000*–9999 Sets or changes the password required to access Admin 
Menu and Report / List.
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• Service Lock
Purpose:

To specify whether to enable each of the printer services or to require a password to use the services, 
and to set or change the password.

See also: 
• "Limiting Access to Printer Operations" on page 317

NOTE: 

• You can access to the items under Service Lock only when Panel Lock Set is set to Enable.

Values:

• Secure Receive (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To specify whether to require a password to print incoming faxes, and to set or change the password. 
When Secure Receive Set is set to Enable, the printer stores incoming faxes and prints them 
when the correct password is entered on the operator panel.

NOTE: 

• You can access to the items under Secure Receive only when Panel Lock Set is set to Enable.

Values:

Copy Unlocked* Enables the Copy service.

Locked Disables the Copy service.

Password 
Locked

Enables the Copy service, but requires a password.

Color Pass. 
Locked

Enables the Copy service with a color mode, but requires a 
password.

FAX

(DocuPrint CM215 
f/CM215 fw only)

Unlocked* Enables the FAX service.

Locked Disables the FAX service (the printer will not send or receive 
faxes).

Password 
Locked

Enables the FAX services, but requires a password to send 
faxes (does not require a password to receive incoming 
faxes).

Scan Unlocked* Enables the Scan service. 

Locked Disables the Scan service.

Password 
Locked

Enables the Scan service, but requires a password.

Change 
Password

0000*–9999 Sets or changes the password required to use the Copy, FAX, 
Scan services. 

Secure Receive 
Set

Disable* Does not require a password to print incoming faxes.

Enable Requires a password to print incoming faxes.

Change 
Password

0000*–9999 Sets or changes the password required to print incoming 
faxes.
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• Software Download
Purpose:

To specify whether to allow downloading firmware updates.

Values:

Scan to E-Mail (DocuPrint CM215 f/CM215 fw Only)
Use the Scan to E-Mail menu to edit the transmission source.

NOTE: 

• Asterisk (*) is the factory default setting.

• Edit From Field
Purpose:

To enable or disable editing of the transmission source.

Values:

USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 

• Asterisk (*) is the factory default setting.

• Port Status
Purpose:

To enable or disable the USB interface.

Values:

Disable Disables downloading of firmware updates.

Enable* Enables downloading of firmware updates.

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.

Disable Disables the USB interface.

Enable* Enables the USB interface.
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Defaults Settings
Use the Defaults Settings menu to configure the default copy, scan, and fax settings of the 
printer. (The fax feature is available only on the DocuPrint CM215 f/CM215 fw.)

Copy Defaults
Use the Copy Defaults menus to configure a variety of copy features.

NOTE: 

• Asterisk (*) is the factory default setting.

• Color
Purpose:

To set whether to make copies in color or in black and white.

Values:

• Collated
Purpose:

To sort the copy job.

Values:

Black & White Prints in black and white mode.

Color* Prints in color mode. 

Off* Does not sort the copy job. 

On Sorts the copy job. 

Auto

(DocuPrint CM215 f/CM215 fw 
only)

Sorts the copy job if multiple-sheet documents are scanned with the 
ADF.
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• Reduce/Enlarge
Purpose:

To set the default value for copy reduction/enlargement ratio.

Values:

mm systems

inch systems

NOTE: 

• You can also use the numeric keypad to input the desired zoom ratio from 25% to 400%, or press the  
button to enlarge the zoom ratio or press the  button to reduce the zoom ratio in 1% intervals.

• This item is available only when N-Up is set to Off or Manual.

• Document Size
Purpose:

To specify the default document size.

Values:

200%

A5→A4(141%)

A5→B5(122%)

100%*

B5→A5(81%)

A4→A5(70%)

50%

200%

Stmt→Lgl(154%)

Stmt→Ltr(129%)

100%*

Lgl→Ltr (78%)

Ldgr→Ltr(64%)

50%

A4 (210 × 297mm)*

A5 (148 × 210mm)

B5 (182 × 257mm)

Letter (8.5 × 11")

Folio (8.5 × 13") 

(DocuPrint CM215 f/CM215 fw only)

Legal (8.5 × 14") 

(DocuPrint CM215 f/CM215 fw only)

Executive (7.25 × 10.5")
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• Original Type
Purpose:

To select the copy image quality.

Values:

• Lighten/Darken
Purpose:

To set the default copy density level.

Values:

• Sharpness
Purpose:

To set the default sharpness level.

Values:

• Auto Exposure
Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

• Color Balance R
Purpose:

To specify the default color balance level of red within the range of -2 to +2. The factory default menu 
setting is 0.

Text Suitable for documents with text.

Mixed* Suitable for documents with both text and photos/gray tones. 

Photo Suitable for documents with photos. 

Lighten2 Makes the copy lighter than the original. Works well with dark print. 

Lighten1

Normal* Works well with standard type or printed documents. 

Darken1 Makes the copy darker than the original. Works well with light print or 
faint pencil markings. Darken2

Sharpest Makes the copy sharper than the original. 

Sharper

Normal* Does not make the copy sharper or softer than the original. 

Softer Makes the copy softer than the original.

Softest

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the 
copy.
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• Color Balance G
Purpose:

To specify the default color balance level of green within the range of -2 to +2. The factory default 
menu setting is 0.

• Color Balance B
Purpose:

To specify the default color balance level of blue within the range of -2 to +2. The factory default menu 
setting is 0.

• Gray Balance
Purpose:

To specify the default gray balance level within the range of -2 to +2. The factory default menu setting 
is 0.

NOTE: 

• This option is effective only for black and white copying.

• N-Up
Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

• Margin Top/Bottom
Purpose:

To specify the value of the top and bottom margins.

Values:

• Margin Left/Right
Purpose:

To specify the value of the left and right margins.

Values:

Off* Does not perform N-Up printing.

Auto Automatically reduces the original pages to fit onto one sheet of 
paper. 

ID Card Copy Prints the original pages onto one sheet of paper in the original size. 

Manual Prints the original pages onto the one sheet of paper in the size 
specified in Reduce/Enlarge.

4mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch

4mm*/0.2 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch
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• Margin Middle
Purpose:

To specify the value of the middle margin.

Values:

• Paper Error
Purpose:

To specify whether to display a paper error when the size of print media loaded in the printer is 
different from the setting specified on the operator panel.

Values:

Scan Defaults
Use the Scan Defaults menus to configure a variety of scanner features.

NOTE: 

• Asterisk (*) is the factory default setting.

• Scan to Network (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To store the scanned image on a network server or on a computer.

Values:

• File Format
Purpose:

To specify the file format to save the scanned image.

Values:

0mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch

Off* Does not display a paper error.

On Displays a paper error.

Computer(Network)* Stores the scanned image on a computer using the Server Message 
Block (SMB) protocol.

Server(FTP) Stores the scanned image on a server using the FTP protocol. 

PDF*

TIFF

JPEG 
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• Color
Purpose:

To set the color mode.

Values:

• Color Button Set
Purpose:

To assign color mode to the Color Mode button.

Values:

• Resolution
Purpose:

To specify the default scan resolution.

Values:

• Document Size
Purpose:

To specify the default document size.

Values:

Black & White Scans in black and white mode. This is available only when File 
Format is set to PDF or TIFF.

Color* Scans in color mode.

B&W Button Black & White* Scans in black and white when Black & White is selected 
for a color mode.

Grayscale Scans in gray scale when Black & White is selected for a 
color mode.

Color Button Color* Scans in color when Color is selected for a color mode.

Color(Photo) Scans in color (photo) when Color is selected for a color 
mode. This is suitable for photographic images.

200 × 200dpi*

300 × 300dpi

400 × 400dpi

600 × 600dpi

A4 (210 × 297mm)*

A5 (148 × 210mm)

B5 (182 × 257mm)

Letter (8.5 × 11")

Folio (8.5 × 13") (DocuPrint CM215 f/CM215 fw only)

Legal (8.5 × 14") (DocuPrint CM215 f/CM215 fw only)

Executive (7.25 × 10.5")
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• Lighten/Darken
Purpose:

To set the default scan density level.

Values:

• Sharpness
Purpose:

To set the default sharpness level.

Values:

• Auto Exposure
Purpose:

To suppress the background of the original to enhance text on the scanned image.

Values:

• Margin Top/Bottom
Purpose:

To specify the value of the top and bottom margins.

Values:

Lighten2 Makes the scanned image lighter than the original. Works well with 
dark print. Lighten1

Normal* Works well with standard type or printed documents. 

Darken1 Makes the scanned image darker than the original. Works well with 
light print or faint pencil markings. Darken2

Sharpest Makes the scanned image sharper than the original.

Sharper

Normal* Does not make the scanned image sharper or softer than the original.

Softer Makes the scanned image softer than the original.

Softest

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the 
scanned image.

2mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch
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• Margin Left/Right
Purpose:

To specify the value of the left and right margins.

Values:

• Margin Middle
Purpose:

To specify the value of the middle margin.

Values:

• TIFF File Format
Purpose:

To specify the TIFF file format.

Values:

• Image Compression
Purpose:

To specify the image compression level.

Values:

• Max E-Mail Size (DocuPrint CM215 f/CM215 fw Only)
Purpose:

To specify the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K 
bytes. The default is 2048 K bytes.

2mm*/0.1 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch

0mm*/0.0 inch* Specify the value in increments of 1 mm/0.1 inch.

0-50mm/0.0-2.0 inch

TIFF V6

TTN2*

High Sets the image compression level to High.

Medium* Sets the image compression level to Medium.

Low Sets the image compression level to Low.
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Fax Defaults (DocuPrint CM215 f/CM215 fw Only)
Use the Fax Defaults menus to configure a variety of fax features.

NOTE: 

• The Fax service cannot be used unless you set up a region code under Region. If Region is not set up, a 
message Set The Region Code appears on the LCD panel.

• Asterisk (*) is the factory default setting.

• Resolution
Purpose:

To specify the resolution level to be used for fax transmission.

Values:

NOTE: 

• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

• Original Type
Purpose:

To select the default document type.

Values:

• Lighten/Darken
Purpose:

To set the default copy density level.

Values:

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or 
documents printed using a dot-matrix printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super 
Fine mode is enabled only if the remote machine also supports the 
super fine resolution. See the notes below.

Ultra Fine Suitable for documents containing photographic images.

Text* Suitable for documents with text.

Photo Suitable for documents with photos.

Lighten2 Makes the fax lighter than the original. Works well with dark print. 

Lighten1

Normal* Works well with standard typed or printed documents. 

Darken1 Makes the fax darker than the original. Works well with light print or 
faint pencil markings. Darken2
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• Delayed Start
Purpose:

This feature enables you to set a specific time for the fax transmission to start. Once Delayed Start 
mode is activated, your printer stores all of the documents to be faxed into its memory and sends them 
at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is 
cleared.

Values:

NOTE: 

• A maximum of 19 delayed fax jobs can be stored in this printer.

21:00*/PM9:00* Specify the fax transmission start time when sending a fax at a 
specified time. 0:00 - 23:59 / AM/PM1:00 

- 12:59
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Tray Settings
Use the Tray Settings menu to set the paper size and type of paper loaded in the multipurpose 
feeder (MPF).

MPF

NOTE: 

• Asterisk (*) is the factory default setting.

Purpose:

To specify the default paper size loaded in the MPF.

Values:

Paper Size A4 (210 × 297mm)*

A5 (148 × 210mm)

B5 (182 × 257mm)

Letter (8.5 × 11")

Folio (8.5 × 13")

Legal (8.5 × 14")

Executive (7.25 × 10.5")

Envelope #10 (4.1×9.5")

Monarch Env. (3.9×7.5")

Monarch Env. L (7.5×3.9")

DL Env. (110×220mm)

DL Env. L (220×110mm)

C5 Envelope (162 × 229mm)

Custom Size Portrait(Y) 297mm*/11.7inch* Specifies the 
length of the 
custom size paper.

127 - 355mm/5.0-
14.0inch

Landscape(X) 210mm*/8.3inch* Specifies the width 
of the custom size 
paper.

77 - 215mm/3.0-
8.5inch

Paper Type Plain*

Bond

Light Card

LW Gloss Card

Labels

Recycled

Envelope

Plain S2

Bond S2

Light Card S2

LW Gloss Card S2

Recycled S2
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NOTE: 

• For more information on supported paper sizes, see "Usable Print Media" on page 131.

Panel Language
Purpose:

To specify the language to be used on the operator panel.

See also: 
• "Adjusting the Language" on page 166

Values:

Display Screen Off Does not display a screen.

On* Displays a screen that prompts the user to set Paper Size 
and Paper Type when the paper is loaded in the MPF.

English
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Panel Lock Function

When your printer is configured as a network printer available to a number of users, the access to 
Admin Menu and Report / List can be limited by enabling the Panel Lock. This prevents 
unauthorized users from changing the settings made by the administrator. However, you can select 
settings for individual print jobs using the print driver.

This section includes:

• "Enabling the Panel Lock" on page 315

• "Changing the Panel Lock Password" on page 315

• "Disabling the Panel Lock" on page 316

Enabling the Panel Lock

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 As necessary, select Change Password, and change the password using the numeric keypad. 
Then, press the  button.

NOTE: 

• The factory-default panel password is 0000.

NOTE: 

• Be sure to remember the password. The procedure described below allows you to reset the password. 
However, for the DocuPrint CM215 f/CM215 fw, the settings for the Address Book would be cleared.

1 Turn off the printer.

2 Turn on the printer with holding the System button.

Changing the Panel Lock Password

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Enter the current password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Change Password, and then press the  button.

7 Enter a new password, and then press the  button.
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Disabling the Panel Lock

NOTE: 

• For the DocuPrint CM215 f/CM215 fw, you can select Disable for Panel Lock Set when all items under 
Service Lock are set to Unlocked and Secure Receive Set is set to Disable.

• For the DocuPrint CM215 b, you can select Disable for Panel Lock Set when all items under Service 
Lock are set to Unlocked.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Enter the password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.
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Limiting Access to Printer Operations

Enabling the Copy Lock, FAX Lock and Scan Lock options function which limits access to copy, fax 
and scan operations. (FAX Lock is available only on the DocuPrint CM215 f/CM215 fw.)

Taking Copy Lock as an example, the following procedure explains how to enable or disable the 
option.

Use the same procedure to enable or disable FAX Lock and Scan Lock.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 As necessary, select Change Password, and change the password using the numeric keypad. 
Then, press the  button.

NOTE: 

• The default password is 0000.

8 Press the  (Back) button.

9 Select Service Lock, and then press the  button.

10 Select Copy, and then press the  button.

11 Select one of the following option, and then press the  button.

• Unlocked

• Locked

• Password Locked

• Color Pass. Locked (available only for Copy Lock)
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Setting the Time for the Power Saver Mode

You can set the power saver timer for the printer. The printer switches to the Power Saver mode after 
the specified time.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Power Saver Timer, and then press the  button.

5 Select Low Power Timer or Sleep Timer, and then press the  button.

6 Press the  or  button or enter the desired value using the numeric keypad, and then press 
the  button.

You can select from 5–30 minutes for Low Power Timer or 1–6 minutes for Sleep Timer.

7 To return to the previous screen, press the  (Back) button.
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Resetting to Factory Defaults

After executing Initialize NVM and rebooting the printer, the menu parameters or data are reset to 
their factory default values.

NOTE: 

• The following procedure does not initialize the network settings.

– For the DocuPrint CM215 f/CM215 fw, to initialize the wired network settings, refer to "Initialize NVM" on 
page 282.

– For the DocuPrint CM215 fw, to initialize the wireless network settings, refer to "Reset Wireless (DocuPrint 
CM215 fw Only)" on page 280.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Select System Section to initialize the menu parameters, and then press the  button.

For the DocuPrint CM215 f/CM215 fw, select User Fax Section to initialize the Address Book 
data for fax, and select User Scan Section to initialize the Address Book data for e-mail.

6 Select Yes, and then press the  button.

The printer restarts automatically to apply the settings.
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Using the Numeric Keypad

As you perform various tasks, you may need to enter numbers. For example, when you enter the 
password, you enter four-digit number.

For the DocuPrint CM215 f/CM215 fw, you may also need to enter names. For example, when you set 
up your printer, you enter your name or your company name. When you store speed dial or group dial 
numbers, you need to enter the corresponding names.

Entering Characters (DocuPrint CM215 f/CM215 fw Only)
When prompted to enter a letter, press the each number key until the correct letter appears on the 
LCD panel.

For example, to enter the letter O, press 6.

• Each time you press 6, the display shows a different letter in sequence, m, n, o, M, N, O and finally 
6.

• To enter additional letters, repeat the first step.

• Press the  button when you are finished.

Deleting Numbers or Names
If an incorrect number or name is entered, press the C (Clear) button to delete the number or 
character, and then enter the correct number or character.

Key Assigned numbers, letters or characters

1 1 @ . _ - (space) \ & ( ) ! " # $ % ' ~ ^ | ` ; : ? , + * / = [ ] { } < >

2 a  b  c  A  B  C  2

3 d  e  f  D  E  F  3

4 g  h  i G  H  I  4

5 j  k  l  J  K  L  5

6 m  n  o  M  N  O  6

7 p  q  r  s  P  Q  R  S  7

8 t  u  v  T  U  V  8

9 w  x  y  z  W  X  Y  Z  9

0 0

* -  _ ~

# (space) & ( )

OK

9

C

8

0 #

7

4 65

1 32　
Wi-Fi

WPS

1 2　

3 4　

5 6　

7 8　
320 Using the Operator Panel Menus and Keypad



10
Troubleshooting

This chapter includes:

• "Clearing Jams" on page 322

• "Basic Printer Problems" on page 335

• "Display Problem" on page 336

• "Printing Problems" on page 337

• "Print Quality Problems" on page 339

• "Copy Problem" on page 352

• "Copy Quality Problems" on page 353

• "Adjusting Color Registration" on page 354

• "Fax Problems (DocuPrint CM215 f/CM215 fw Only)" on page 358

• "Scanning Problems" on page 360

• "Scan Driver/Printer Utility Problems" on page 363

• "Wireless Problems (DocuPrint CM215 fw Only)" on page 364

• "Other Problem" on page 365

• "Understanding Printer Messages" on page 366

• "Contacting Service" on page 375

• "Getting Help" on page 376

• "Non-Genuine Mode" on page 378
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Clearing Jams

This section includes:

• "Avoiding Jams" on page 322

• "Identifying the Location of Paper Jams" on page 323

• "Clearing Paper Jams From the ADF (DocuPrint CM215 f/CM215 fw Only)" on page 324

• "Clearing Paper Jams From the Front of the Printer" on page 328

• "Clearing Paper Jams From the Rear of the Printer" on page 329

• "Clearing Paper Jams From the Center Output Tray" on page 331

• "Jam Problems" on page 334

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 128

• "Supported Print Media" on page 131

NOTE: 

• Before buying large quantities of any print media, it is recommended that you try a sample first.

Avoiding Jams
• Use only recommended print media. See "About Print Media" on page 128 for more information.

• See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134 and "Loading Print 
Media in the Priority Sheet Inserter (PSI)" on page 142 to load print media properly.

• Do not overload the print media sources. Make sure that the stacked print media does not 
exceed the maximum height indicated on the paper width guides.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 
feeding one sheet at a time through the MPF or the PSI.

• Do not use print media that you have cut or trimmed.

• Do not mix print media sizes, weights, or types in the same print media source.

• Make sure that the recommended print side is facing up when you insert the print media.

• Keep print media stored in an acceptable environment. See "Print Media Storage Guidelines" on 
page 130 for more information.

• Do not remove the PSI during a print job.

• Make sure that all cables connected to the printer are correctly inserted.

• Overtightening the guides may cause jams.
322 Troubleshooting



 Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:

• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped 
around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product immediately and contact your local Fuji Xerox representative.

1 Center Output Tray

2 Transfer Belt

3 Levers

4 Rear Cover

5 ADF Cover (DocuPrint CM215 f/CM215 fw only)

6 Front Cover

7 Multipurpose Feeder (MPF)

8 Priority Sheet Inserter (PSI)

1 2
3

4

567

8
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Clearing Paper Jams From the ADF (DocuPrint CM215 
f/CM215 fw Only)

When a document jams while it passes through the automatic document feeder (ADF), remove jams 
in the following procedure.

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 
before performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 
during use.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the ADF cover.

2 Remove the jammed document by carefully pulling it in the direction of the arrow shown in the 
following illustration.
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3 If you find it difficult to pull the document, open the document feeder tray.

4 Remove the jammed document from the document output tray.

5 Close the document feeder tray.
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6 Close the ADF cover, and then load the documents back into the ADF.

NOTE: 

• Make sure that you adjust the document guides before printing a Legal-size document.

7 If you cannot remove the jammed document from the document output tray or cannot find any 
jammed document there, open the document cover.
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8 Remove the document from the ADF feed roller or the feed area by carefully pulling the 
document in the direction of the arrow shown in the following illustration.
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Clearing Paper Jams From the Front of the Printer

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the PSI out.

2 Remove any paper jammed from the front of the printer.

3 Replace the PSI in the printer.

IMPORTANT: 

• Do not use excessive force on the PSI. Doing so could damage or the inside of the printer.
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Clearing Paper Jams From the Rear of the Printer

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 
before performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 
during use.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the rear of the printer by carefully pulling it in the direction of the 
arrow shown in the following illustration.
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4 Lower the levers to their original position.

5 Close the rear cover.
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Clearing Paper Jams From the Center Output Tray

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 
before performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 
during use.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the rear of the printer by carefully pulling it in the direction of the 
arrow shown in the following illustration.
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4 If no paper is found in the paper path, lift and open the scanner.

5 Remove any paper jammed out of the center output tray. 

6 Lower and close the scanner.
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7 Lower the levers to their original position.

8 Close the rear cover.
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Jam Problems

Misfeed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Multi-feed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Print media misfeeds occur. Remove the paper from the PSI, and then make sure that the paper is 
properly inserted in the MPF.

Depending on the print media you use, take any of the following 
actions:

• For thick paper, use the one that is 163 gsm or less.

• For thin paper, use the one that is 60 gsm or more.

• For the envelope, make sure that it is properly loaded in the MPF 
or the PSI as instructed in "Loading Envelope in the Multipurpose 
Feeder (MPF)" on page 139 or in "Loading Envelope in the Priority 
Sheet Inserter (PSI)" on page 144.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex printing, make sure that the print media 
is not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action

Print media multiple feeds occur. Remove the paper from the PSI, and then make sure that the paper is 
inserted properly in the MPF.

If the print media is damp, use print media that is not damp.

Fan the print media. 

(DocuPrint CM215 f/CM215 fw 
only)

A document jam occurs in the 
ADF if scanning of multiple-sheet 
document is cancelled while 
scanning is in progress.

Clear the jam. 

See also: 
• "Clearing Paper Jams From the ADF (DocuPrint CM215 f/CM215 

fw Only)" on page 324
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Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the 
following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

• For the DocuPrint CM215 fw, when connected to the computer with the Wireless connection, the 
Ethernet cable is not connected between the printer and the network.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.

NOTE: 

• If error messages are displayed on the LCD panel or on your computer screen, follow the on-screen 
instructions to resolve the printer problems. For details about error messages and error codes, see 
"Understanding Printer Messages" on page 366.
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Display Problem

Problem Action

Menu settings changed from the 
operator panel have no effect.

Settings in the print driver, or the printer utilities have precedence 
over the settings made on the operator panel.

Change the menu settings from the print driver or the printer utilities 
instead of the operator panel.
336 Troubleshooting



Printing Problems

Problem Action

Job did not print or incorrect 
characters printed.

Confirm that the Select Function screen appears on the LCD 
panel before you send a job to print.

Make sure that print media is loaded in the printer.

Verify that you are using the correct print driver.

Make sure that you are using the correct Ethernet or USB cable and 
that it is securely connected to the printer. (Ethernet connection is 
available only on the DocuPrint CM215 f/CM215 fw.)

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

For the DocuPrint CM215 f/CM215 fw, check the interface of your 
printer from Admin Menu.

Determine the host interface you are using. Print a System Settings 
page to verify that the current interface settings are correct. Refer to 
"Printing a System Settings Page" on page 164 for details on how to 
print a System Settings page.

Print media misfeeds or multiple 
feeds occur.

Make sure that the print media you are using meets the specifications 
for your printer. 

See also: 
• "Usable Print Media" on page 131

Fan the print media before loading it.

Make sure that the print media is loaded correctly.

Make sure that the paper width guides and length guide are adjusted 
correctly.

Make sure that the PSI is securely inserted.

Do not overload the print media sources.

Do not force print media into the PSI or the MPF when you load it.

Otherwise, it may skew or buckle.

Make sure that the print media is not curled.

Load the recommended print side correctly for the type of print media 
you are using.

See also: 
• "Loading Print Media" on page 133

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix print media sizes.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load the print media source only when it is empty.

The envelope is creased after 
printing.

Make sure that the envelope is loaded as instructed in "Loading 
Envelope in the Multipurpose Feeder (MPF)" on page 139 or 
"Loading Envelope in the Priority Sheet Inserter (PSI)" on page 144.
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Page breaks in unexpected 
places.

Increase the value for Job Time-Out in the System Settings menu, 
that is on the Printer Maintenance tab in the Printer Setting Utility.

For the DocuPrint CM215 f/CM215 fw, increase the time-out value for 
the protocol in use in the Protocol Settings menu on the CentreWare 
Internet Services.

Print media does not stack neatly 
in the center output tray.

Turn the print media stack over in the PSI and MPF.

Printer does not print duplex 
pages.

Select either of the duplex printing options (flip on short edge/flip on 
long edge) in the print driver.

See also: 
• "Manual Duplex Printing" on page 147

Problem Action
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Print Quality Problems

This section includes:

• "The Output Is Too Light" on page 340

• "Toner Smears or Print Comes Off/Stain on Back Side" on page 341

• "Random Spots/Blurred Images" on page 342

• "The Entire Output Is Blank" on page 342

• "Streaks Appear on the Output" on page 343

• "Pitched Color Dots" on page 343

• "Vertical Blanks" on page 343

• "Mottle" on page 344

• "Ghosting" on page 345

• "Fog" on page 346

• "Bead-Carry-Out (BCO)" on page 346

• "Auger Mark" on page 347

• "Wrinkled/Stained Paper" on page 348

• "The Top Margin Is Incorrect" on page 349

• "Color Registration Is Out of Alignment" on page 350

• "Protrudent/Bumpy Paper" on page 351

NOTE: 

• In this section, some procedures use the Printer Setting Utility or the SimpleMonitor. Some procedures that 
use the Printer Setting Utility can also be performed using the operator panel.

See also: 
• "Understanding the Printer Menus" on page 274

• "Printer Setting Utility (Windows Only)" on page 58

• "SimpleMonitor (Windows Only)" on page 59
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The Output Is Too Light

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The output is too light. The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge. 

1 Check the toner level in the Consumables tab in the Printer 
Status window of the SimpleMonitor.

2 Replace the toner cartridges as necessary.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 131

Try changing the paper type setting in the print driver. The following 
procedure uses the Microsoft® Windows® print driver as an example.

1 On the Paper/Output tab in Printing Preferences of the print 
driver, change the Paper Type setting.

2 Load dry (not damp) and correct size print media, and then click 
Print Test Page in the Properties window of the print driver.

Disable the toner saving feature in the print driver.

See also: 
• "Conserving Supplies" on page 401
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Toner smears or print comes off.
The output has stain on the back 
side.

The print media surface may be uneven. Try changing the paper type 
setting in the print driver. For example, change Plain to Lightweight 
Cardstock. The following procedure uses the Windows print driver as 
an example.

1 On the Paper/Output tab in Printing Preferences of the print 
driver, change the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 131

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 
the Printer Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your 
printing media.

3 Click the Apply New Settings button.
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Random Spots/Blurred Images

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

The Entire Output Is Blank

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Problem Action

The printed result has random 
spots or is blurred.

Make sure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 393

If you use non-genuine brand toner cartridges, install genuine brand 
toner cartridges.

Clean up the fusing unit.

1 Load one sheet of paper on the MPF, and then print a solid image 
all over paper.

2 Load the printed sheet with the printed side facing down, and then 
print a blank sheet of paper.
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Streaks Appear on the Output

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Pitched Color Dots

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Vertical Blanks

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has vertical 
blanks.

Clean inside the printer and perform a test print.

1 Clean inside the printer by using the print head cleaning rod. 

2 Click Print Test Page in the Properties window of the print driver.

See also: 
• "Cleaning Inside the Printer" on page 386
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Mottle

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has mottled 
appearance.

Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Adjust BTR on the 
Printer Maintenance tab.

2 Adjust the setting for the type of print media being used.

3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Ghosting

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has ghosting. Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Chart Print on the 
Diagnosis tab.

2 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

3 Click BTR Refresh Mode on the Printer Maintenance tab.

4 Select the check box next to On, and then click the Apply New 
Settings button.

5 Click Chart Print on the Diagnosis tab.

6 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

The print media surface may be uneven. Try changing the paper type 
setting in the print driver. For example, change Plain to Lightweight 
Cardstock. The following procedure uses the Windows print driver as 
an example.

1 On the Paper/Output tab in Printing Preferences of the print 
driver, change the Paper Type setting.

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 
the Printer Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your 
printing media.

3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Fog

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Bead-Carry-Out (BCO)

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result is foggy. When the whole is printed light, contact the Fuji Xerox local 
representative office or an authorized dealer.

When the printed page is partly light, start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on 
the Diagnosis tab.

2 Click the Start button.

Problem Action

Bead-Carry-Out (BCO) is 
happening.

If the printer is installed in a high altitude location, set the altitude of 
the location.

1 Launch the Printer Setting Utility, and click Adjust Altitude on the 
Printer Maintenance tab.

2 Select the value close to the altitude of the location where the 
printer is installed.

3 Click the Apply New Settings button.
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Auger Mark

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The printed result has auger 
mark.

The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge.

1 Check the toner level in the Consumables tab in the Printer 
Status window of the SimpleMonitor.

2 Replace the toner cartridges as necessary.

Start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on 
the Diagnosis tab.

2 Click the Start button.
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Wrinkled/Stained Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

If excessive wrinkles occur, use paper or other media from a new 
package.

See also: 
• "Usable Print Media" on page 131

• "About Print Media" on page 128

If you use the envelope, check whether the crease is within 30 mm of 
the four edges of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is 
considered normal. Your printer is not at fault.

If not, take the following actions:

• If the envelope is Com 10, which is 220 mm or longer and has a 
flap on the long edge, use a different size envelope.

• If the envelope is C5, which is 220 mm or longer and has a flap on 
the short edge, load it in the MPF with the flap open and facing up.

• If the envelope is Monarch or DL, which is shorter than 220 mm, 
load it long edge feed in the MPF with the flap open and facing up.
If the problem continues, use a different size envelope.
348 Troubleshooting



The Top Margin Is Incorrect

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

The top margin is incorrect. Make sure that the margins are set correctly on the application being 
used.
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Color Registration Is Out of Alignment

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Color registration is out of 
alignment.

Execute an auto color registration adjustment.

1 Launch the Printer Setting Utility, and click Registration 
Adjustment on the Printer Maintenance tab.

2 Deselect the check box next to On.

3 Click the Start button next to Auto Correct.

Clean the CTD sensor.

1 Clean the CTD sensor. 

2 Launch the Printer Setting Utility, and click Registration 
Adjustment on the Printer Maintenance tab.

3 Deselect the check box next to On.

4 Click the Start button next to Auto Correct.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 389

Print the color registration chart and manually correct the color 
registration. 

1 Launch the Printer Setting Utility, and click Registration 
Adjustment on the Printer Maintenance tab.

2 Deselect the check box next to On.

3 Click the Start button next to Print Color Regi Chart.

The color registration chart is printed.

4 Check the values with the straight lines on the chart.

5 Select the value for each color on the Printer Setting Utility.

6 Click the Apply New Settings button.

7 Click the Start button next to Print Color Regi Chart to print the 
color registration chart again.

8 Adjust until all straight lines are at the value of 0.

See also: 
• "Adjusting Color Registration" on page 354
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Protrudent/Bumpy Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.

1 Load one sheet of paper on the MPF, and then print a solid image 
all over the paper.

2 Load the printed sheet with the printed side facing down, and then 
print a blank sheet of paper.
Troubleshooting 351



Copy Problem

Problem Action

(DocuPrint CM215 f/CM215 fw 
only)

A document loaded in the ADF 
cannot be copied.

Make sure that the ADF cover is firmly closed. 
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Copy Quality Problems

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji 
Xerox local representative office or an authorized dealer.

Problem Action

(DocuPrint CM215 f/CM215 fw 
only)

There are lines or streaks in 
copies made from the ADF.

There is debris on the ADF glass. When scanning, the paper from the 
ADF passes over the debris creating lines or streaks. 

Clean the ADF glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 383

There are spots in copies taken 
from the document glass.

There is debris on the document glass. When scanning, the debris 
creates a spot on the image.

Clean the document glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 383

The reverse side of the original is 
showing on the copy.

On the Copy menu, enable Auto Exposure.

For information on turning Auto Exposure on and off, see "Auto 
Exposure" on page 184.

Light colors are washed out or 
white on the copy.

On the Copy menu, disable Auto Exposure.

For information on turning Auto Exposure on and off, see "Auto 
Exposure" on page 184.

Image is too light or dark. Use the Lighten/Darken option on the Copy menu.

For information on making the image lighter or darker, see 
"Lighten/Darken" on page 182.
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Adjusting Color Registration

This section describes how to adjust the color registration when you first install the printer or after 
moving it to a new location.

This section includes:

• "Performing Auto Correct" on page 354

• "Printing the Color Registration Chart" on page 355

• "Determining Values" on page 356

• "Entering Values" on page 357

Performing Auto Correct
Auto Correct allows you to correct the color registration automatically.

Using the Operator Panel

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Auto Adjust, and then press the  button.

6 Select Yes, and then press the  button.

Auto Correct is performed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Auto Correct.

The color registration is corrected automatically.
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Printing the Color Registration Chart

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Print Color Regi Chart.

The color registration chart is printed.
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Determining Values
On the color registration chart printed, find the straightest lines where the two black lines and the 
colored line are most closely aligned for each color (Y, M, and C).

If you find the straightest line, make a note of the value (-5 – +5) indicated by the straightest line for 
each color.

When the value is 0 for each color, you do not need to adjust the color registration.

When the value is not 0, enter the value according to the procedure in "Entering Values" on page 357.
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Entering Values

Using the Printer Setting Utility (Windows Only)
Using the Printer Setting Utility, enter the values that you found in the color registration chart to make 
adjustments.

The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Select the value you checked in the color registration chart, and then click the Apply New 
Settings button.

6 Click the Start button next to Print Color Regi Chart.

The color registration chart is printed with the new values.

7 Adjust until all straight lines are at the value of 0. Viewing the images before and after will help.

IMPORTANT: 

• After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.
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Fax Problems (DocuPrint CM215 f/CM215 fw Only)

Problem Action

The printer is not working, there 
is no display and the buttons are 
not working.

Unplug the power cord and plug it in again. 

Make sure that there is power to the electrical receptacle. 

No dial tone sounds. Check that the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 236

Check that the phone socket in the wall is working by plugging in 
another phone. 

The numbers stored in the 
memory do not dial correctly.

Make sure that the numbers are stored in the memory correctly. Print 
the Address Book List. 

The document does not feed into 
the printer.

Make sure that the document is not wrinkled and you are putting it in 
correctly. Check that the document is of the right size, not too thick or 
thin. 

Make sure that the ADF cover is firmly closed. 

Faxes are not received 
automatically.

Select FAX Mode for Ans Select. 

Make sure that there is paper in the PSI or the MPF. 

Check if the LCD panel shows Memory Full.

Check the Junk Fax Filter setting.

The printer does not send faxes. Check the other fax machine you are sending to, to see if it can 
receive your fax. 

The incoming fax has blank 
spaces or is received in poor-
quality.

The fax machine sending you the fax may be faulty. Ask the sender to 
sort out the problem and resend the fax.

A noisy phone line can cause line errors. Ask the sender to resend 
the fax.

Check your printer by making a copy. 

The toner cartridge may be empty. Replace the toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 390

Some of the words on an 
incoming fax are stretched.

The fax machine sending you the fax had a temporary document jam. 
Ask the sender to clear the document jam and resend the fax.

There are lines on the documents 
you send.

Check your ADF glass for marks and clean it.

See also: 
• "Cleaning the Scanner" on page 383

The printer dials a number, but 
the connection with another fax 
machine fails.

The other fax machine may be turned off, out of paper, or cannot 
answer incoming calls. Ask the sender to sort out the problem and 
retry. 

Documents are not stored in the 
memory.

There may not be enough memory to store the document. If the LCD 
panel shows Memory Full, delete any documents you no longer 
need from the memory and then restore the document, or wait for the 
job in progress (e.g., a fax transmission or reception) to complete.
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Blank areas appear at the bottom 
of each page or on other pages, 
with a small strip of text at the 
top.

You may have chosen the wrong paper settings in the user option 
setting. Correct the paper settings.

See also: 
• "Tray Settings" on page 313

The printer will not send or 
receive faxes.

Check if the region is set correctly.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Region, and then press the  button.

5 When the setting is correct, press the  (Back) button to return 
to the previous screen.

To change the setting, select the correct region and then press the 
 button. Select Yes to reboot the printer.

Check that the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 236

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed.

1 Press the System button.

2 Select Admin Menu, and then press the  button.

3 Select Fax Settings, and then press the  button.

4 Select Modem Speed, and then press the  button.

5 Select the desired menu item, and then press the  button. 

Problem Action
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Scanning Problems

Problem Action

The scanner does not work. Make sure that you place the document to be scanned facing down 
on the document glass, or facing up in the ADF. (ADF is available only 
for the DocuPrint CM215 f/CM215 fw.)

There may not be enough available memory to hold the document 
you want to scan. Try the Preview function to see if that works. Try 
lowering the scan resolution rate. 

Check that the Ethernet or USB cable is connected properly. 

Make sure that the Ethernet or USB cable is not defective. Switch the 
cable with a known good cable. If necessary, replace the cable.

Check that the scanner is configured correctly. Check the application 
you want to use to make certain that the scanner job is being sent to 
the correct port. 

The printer scans very slowly. For the DocuPrint CM215 f/CM215 fw, graphics are scanned more 
slowly than text when using the Scan to E-Mail or Scan to Network 
feature. 

Communication speed becomes slow in scan mode because of the 
large amount of memory required to analyze and reproduce the 
scanned image. 

Scanning images at a high resolution takes more time than scanning 
at a low resolution.

(DocuPrint CM215 f/CM215 fw 
only)

Document misfeeds or multiple 
feeds occur in the ADF.

Make sure that the document’s paper type meets the specifications 
for the printer.

See also: 
• "Preparing a Document" on page 171

• "Making Copies From the ADF (DocuPrint CM215 f/CM215 fw 
Only)" on page 174

Check whether the document is properly loaded in the ADF.

Make sure that the document guides are adjusted properly.

Make sure that the number of document sheets do not exceed the 
maximum capacity of the ADF.

Make sure that the document is not curled.

Fan the document well before loading it in the ADF.

(DocuPrint CM215 f/CM215 fw 
only)

Vertical stripes appear on the 
output when scanned using the 
ADF.

Clean the ADF glass.

See also: 
• "Cleaning the Scanner" on page 383

A smear appears at the same 
location on the output when 
scanned using the document 
glass.

Clean the document glass.

See also: 
• "Cleaning the Scanner" on page 383

Images are skewed. Make sure that you place the document to be scanned facing down 
on the document glass, or facing up in the ADF. (ADF is available only 
for DocuPrint CM215 f/CM215 fw.)
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(DocuPrint CM215 f/CM215 fw 
only)

Diagonal lines appear jagged 
when scanned using the ADF.

If the document uses thick media, try scanning it from the document 
glass.

(DocuPrint CM215 f/CM215 fw 
only)

The printer does not properly 
transfer scan data to a specified 
destination via the Scan to E-Mail 
or Scan to Network feature. 

Check if the following settings have been set correctly on the 
CentreWare Internet Services.

Scan to E-Mail

Check the following setting under Address Book → Personal 
Address:

• Address

Scan to Network

Check the following settings under Address Book → 
Computer/Server Address Book:

• Name (Displayed on Printer)

• Network Type

• Host Address (IP Address or DNS Name)

• Port Number

• Login Name (if required by host)

• Login Password

• Name of Shared Directory

• Subdirectory Path (optional)

Cannot scan using Windows 
Image Acquisition (WIA) on a 
Windows Server® 2003 
computer.

Enable WIA on the computer.

To enable WIA: 

1 Click Start, point to Administrative Tools, and then click 
Services.

2 Right-click Windows Image Acquisition (WIA), and then click 
Properties to make sure that Startup type is set to Manual or 
Automatic.

3 Click OK.

4 Right-click Windows Image Acquisition (WIA), and then click 
Start.

Problem Action
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Cannot scan using TWAIN or 
WIA on a Windows Server 2008, 
Windows Server 2008 R2, or 
Windows Server 2012 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:

For Windows Server 2008 and Windows Server 2008 R2:

1 Click Start, point to Administrative Tools, and then click Server 
Manager.

2 Under Features Summary, click Add Features.

3 Select the Desktop Experience check box.

4 If a window appears, follow the on-screen instructions.

5 Click Next, and then click Install.

6 Restart the computer.

For Windows Server 2012:

1 On the Start screen, click Server Manager.

2 Click Add roles and features to start Add Roles and Features 
Wizard.

3 On the Before you begin screen, click Next.

4 On the Select installation type screen, confirm that Role-based 
or feature-based installation is selected, and then click Next.

5 On the Select destination server screen, select an appropriate 
server and then click Next.

6 On the Select server roles screen, click Next.

7 On the Select features screen, select the Desktop Experience 
check box under User Interfaces and Infrastructure (Installed) 
in the Features list.

8 On the pop-up window, click Add Features.

9 On the Select features screen, click Next.

10On the Confirm installation selections screen, click Install.

11 Restart the computer.

Problem Action
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Scan Driver/Printer Utility Problems

Problem Action

(DocuPrint CM215 f/CM215 fw 
only)

Unable to retrieve the Address 
Book data from the printer on the 
Address Book Editor.

Make sure that your computer and the printer is properly connected 
with the USB cable or Ethernet cable.

Make sure that the printer is turned on.

Make sure that the print driver is installed on your computer. (The 
Address Book Editor retrieves the Address Book data via the print 
driver.) 

The TWAIN driver cannot 
connect to the printer.

Make sure that your computer and the printer is properly connected 
with the USB cable.

Check whether the printer is turned on. If the printer is turned on, 
reboot it by turning the power switch off and then on again.

If a scan application is running, close the application once, restart the 
application, and then try scanning again. 

The scan driver has not been 
registered on your computer and 
cannot be accessed from the 
Express Scan Manager. 

Install the scan driver. If the driver is already installed, uninstall it and 
then reinstall it.

Failed to scan your document on 
the printer via the Express Scan 
Manager.

Make sure that your computer and the printer is properly connected 
with the USB cable.

Check whether the printer is turned on. If the printer is turned on, 
reboot it by turning the power switch off and then on again.

If a scan application is running, close the application once, restart the 
application, and then try scanning again. 

Failed to create an image file via 
the Express Scan Manager.

Make sure that there is sufficient space in your hard disk.

Uninstall the Express Scan Manager on your computer and then 
reinstall it.

Failed to initialize the Express 
Scan Manager.

Uninstall the Express Scan Manager on your computer and then 
reinstall it.

Failed to execute the Express 
Scan Manager.

Uninstall the Express Scan Manager on your computer and then 
reinstall it.

An unexpected error occurred on 
the Express Scan Manager. 

Uninstall the Express Scan Manager on your computer and then 
reinstall it.
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Wireless Problems (DocuPrint CM215 fw Only)

Problem Action

Cannot setup wireless 
connection.

Make sure that the Ethernet cable is disconnected from the printer.

Make sure that Wi-Fi is set to On.

See also: 
• "Wi-Fi (DocuPrint CM215 fw Only)" on page 282

Try disabling the firewall on your computer. The firewall on your 
computer may be blocking communication with your printer.

Cannot setup wireless connection 
with WPS (Wi-Fi Protected 
Setup®).

Make sure that the security setting of the wireless LAN access point 
or router is WPA or WPA2. (WEP is not supported on WPS.)

Cannot setup wireless connection 
with the WPS-PBC (Wi-Fi 
Protected Setup-Push Button 
Configuration).

Press the WPS button on the wireless LAN access point or router 
within two minutes after starting the WPS operation on the printer. For 
details about the wireless LAN access point or router, refer to the 
manual supplied with the wireless LAN access point or router.

Cannot setup wireless connection 
with WPS-PIN (Wi-Fi Protected 
Setup-Personal Identification 
Number).

Check if the PIN you have entered on the computer is correct.
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Other Problem

Problem Action

Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.
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Understanding Printer Messages

The printer LCD panel displays messages describing the current state of the printer and indicates 
possible printer problems you must resolve. This section describes error codes included in the 
messages, their meanings, and how to clear the messages.

IMPORTANT: 

• When an error message is displayed, the print data remaining on the printer and the information accumulated 
in the memory of the printer are not secured.

Error Code What You Can Do

005-121 Open the ADF cover. Remove the jammed paper and then close the ADF cover.

See also: 
• "Clearing Paper Jams From the ADF (DocuPrint CM215 f/CM215 fw Only)" on 

page 324

005-301

009-950 Replace the specified toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 390

009-951

009-952

009-953

010-397 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

016-315

016-317

016-372

016-501

016-502

016-503 Press the  button to clear the message. Check if the SMTP server setting is correct 
by contacting your server administrator.

016-504 Press the  button to clear the message. Check if the user name and password for the 
POP3 server are set correctly by contacting your server administrator.

016-506 Press the  button to clear the message. Check if the SMTP server address and e-
mail destination are set correctly.

016-507 Press the  button to clear the message. Check if the user name and password used 
for the SMTP server are set correctly by contacting your server administrator.

016-718 Press the  button to clear the message. Retry when the printer does not process any 
job.

016-719 Press the  button to cancel the current job. Retry when the printer does not process 
any job.016-720

016-744 Press the  button to clear the message. If this does not solve the problem, contact the 
Fuji Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

016-745

016-749 Press the  button to cancel the current job. Retry when the printer does not process 
any job.

016-764 Press the  button to clear the message. Check if the Ethernet cable is properly 
connected. If this does not solve the problem, contact SMTP server administrator.
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016-766 Press the  button to clear the message. Ping the IP address of the SMTP server and 
check if the server is available. If this does not solve the problem, contact SMTP server 
administrator.

016-767 Press the  button to clear the message. Check if the recipient address is correct, and 
try scanning again.

016-791 Insert the USB memory device and press the  button to clear the message.

016-920 Press the  button to clear the message. Check the wireless setting for the access 
point and the printer.

016-930 Remove the device from the USB drive and press the  button to clear the message.

016-931

016-981 Press the  button to cancel the current job. Try copying fewer documents.

016-985 Attached file size is larger than you defined. Press the  button to clear the message. 
Try the following:

• Enlarge Max E-Mail Size. 

• Lower the resolution setting. 

• Change the file format of the scanned image.

017-970 Memory is likely to be full. Press the  button to clear the message. Try the following:

• Delete the data stored in the memory. 

• Lower the resolution setting.

• Reduce the number of pages.

017-980 Press the  button to clear the message. Retry when the printer does not process any 
job.017-981

017-988 Press the  button to clear the message. Check if the interface cable is securely 
connected or your computer does not have any problem.

018-338 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

024-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

024-360

024-371

024-958 Load the specified paper and press the  button to clear the message.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

024-963 Press the  button to clear the message and load the specified paper. Follow the on-
screen instruction if one appears.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 134

• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 142

026-720 Press the  button to clear the message. Check if the USB memory device has 
enough memory.

Error Code What You Can Do
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026-721 Press the  button to clear the message. Check if the USB memory device is write-
protected or gets any disk problem.026-722

026-723 Press the  button to clear the message. Check if the path and file name to save the 
data is too long.

026-750 Press the  button to clear the message. Check if the interface cable is securely 
connected, or restart the application you use.

026-751 Press the  button to clear the message. Check if the interface cable is securely 
connected.026-752

027-446 Change the IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

031-521 Press the  button to clear the message. Check if the access setting to the SMB server 
is correct by contacting your server administrator.

031-526 Press the  button to clear the message. Check if the domain name of the SMB server 
is correct. Check DNS connection, or check if the name of the forwarding destination 
server is registered with DNS.

031-529 Press the  button to clear the message. Check if the Ethernet cable is properly 
connected and if the password for the SMB server is correct.

031-530 Press the  button to clear the message. Check if the working path setting to the SMB 
server is correct.

031-533 Press the  button to clear the message. Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

• If the SMB server encounters any write-protection or disk problem.

031-534 Press the  button to clear the message. Check if the SMB server encounters any 
write-protection or disk problem.031-535

031-536

031-537 Press the  button to clear the message. Check if the storage location has free space.

031-555 Press the  button to clear the message. Check if the network is properly connected.

031-556 Press the  button to clear the message. Check if the SMB server encounters any 
write-protection or disk problem.

031-557 Press the  button to clear the message. Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

031-558 Press the  button to clear the message. Check if the access setting to the SMB server 
is correct by contacting your server administrator.

031-571 Press the  button to clear the message. Check if the printer is properly connected to a 
network.

031-574 Press the  button to clear the message. Check if the domain name of the FTP server 
is correct. 

031-575 Press the  button to clear the message. Check if the host name setting to the FTP 
server is correct.

031-576 Press the  button to clear the message. Check if the FTP server encounters any 
write-protection or disk problem.

031-578 Press the  button to clear the message. Check if the Ethernet cable is properly 
connected and if login name (user name) and password for the FTP server are correct.

Error Code What You Can Do
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031-579 Press the  button to clear the message. Check if the working path setting to the FTP 
server is correct.

031-582 Press the  button to clear the message. Check if the FTP server encounters any 
write-protection or disk problem.

031-584 Press the  button to clear the message. Check the following:

• If the file name you specified is not used by other users. 

• If file or folder that has the same name as the one you specified already exists. 

• If the FTP server encounters any write-protection or disk problem.

031-585 Press the  button to clear the message. Check if the FTP server encounters any 
delete/write-protection or disk problem.031-587

031-588 Press the  button to clear the message. Check if the FTP server encounters any 
write-protection or disk problem.

031-589 Press the  button to clear the message. Check if the storage location has free space.

031-594 Press the  button to clear the message. Contact your server administrator to check if 
the scanned file has wrong setting while being stored to FTP server. If this does not 
solve the problem, contact the Fuji Xerox local representative office or an authorized 
dealer.

See also: 
• "Online Services" on page 409

031-598 Press the  button to clear the message. Check if the FTP server encounters any 
write-protection or disk problem.

033-503 Press the  button to clear the message. Check the report. Delete the unnecessary 
data stored in the memory.

033-513

033-517 Press the  button to clear the message. Check if the password of the fax lock is 
correct.

033-518 Press the  button to clear the message. Check if your region is set correctly.

033-519 Fax service is locked. To continue, press the  button and disable the fax lock. 

See also: 
• "Limiting Access to Printer Operations" on page 317

033-787 Press the  button to clear the message. The job is cancelled.

033-788 Press the  button to clear the message. Remove the received fax, or wait for a while 
until sending a fax is completed.

034-700 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Check if the phone line is connected properly.

• Check if the destination number is correct.

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

See also: 
• "Connecting the Telephone Line" on page 236

034-701

034-702

Error Code What You Can Do
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034-703 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Check if the phone line is connected properly.

• Check if the destination number is available and correct.

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

See also: 
• "Connecting the Telephone Line" on page 236

034-704

034-705

034-706

034-707 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-708 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Check if the destination number is available.

• Lower Modem Speed.

034-709 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

034-710

034-711 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-712

034-713

034-714 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Check if the destination number is available.

034-715 Press the  button to clear the message. If the error continues to appear after the 
redial for the specified number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-716 Press the  button to clear the message. If the error continues to appear after the retry 
for the specified number of times, it will be cancelled. When retrying sending the fax, 
lower Modem Speed.

034-717 Press the  button to clear the message. If the error continues to appear after the retry 
for the specified number of times, it will be cancelled. Retry sending the fax.

034-718 Press the  button to clear the message. If the error continues to appear after the retry 
for the specified number of times, it will be cancelled. When retrying sending the fax, 
lower Modem Speed.

034-719

Error Code What You Can Do
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034-720 Press the  button to clear the message. If the error continues to appear after the retry 
for the specified number of times, it will be cancelled. When retrying sending the fax, try 
the following:

• Lower Modem Speed.

• Enable ECM.

034-721 Press the  button to clear the message. If the error continues to appear after the retry 
for the specified number of times, it will be cancelled. When retrying sending the fax, 
lower Modem Speed.

034-722

034-723

034-724

034-725

034-726

034-727 Press the  button to clear the message. Check if the destination number is available. 
If the error continues to appear after the retry for the specified number of times, it will be 
cancelled. 

034-750 Press the  button to clear the message. Check if the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 236

034-751 Press the  button to clear the message. Check if the destination machine blocks your 
fax as the junk fax. If it does, ask the receiver to disable the setting.

034-752 Press the  button to clear the message. Check if the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 236

034-753

034-754 Press the  button to clear the message. Lower Modem Speed. 

034-755

034-756

034-757

034-758 Press the  button to clear the message. Check if the phone line is connected properly. 
Or, lower Modem Speed. 

See also: 
• "Connecting the Telephone Line" on page 236

034-759 Press the  button to clear the message. Lower Modem Speed.

034-760

034-761 Press the  button to clear the message. Check if the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 236

034-762 Press the  button to clear the message. Try the following:

• Lower Modem Speed.

• Enable ECM. 

034-763 Press the  button to clear the message. Lower Modem Speed.

034-764

034-765

034-766
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034-767 Press the  button to clear the message. Check if the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 236

034-768 Press the  button to clear the message. Lower Modem Speed.

041-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

042-358

042-372

061-370

062-321

062-360

062-790 Press the  button to clear the message. The scanned data is deleted. Retry scanning 
the document.

075-100 Check and clear the paper path, load the paper, and then press the  button to clear 
the message.

See also: 
• "Clearing Paper Jams From the Front of the Printer" on page 328

075-921 Load paper for the second side (odd) pages, and press the  button.

See also: 
• "Manual Duplex Printing" on page 147

077-100 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Rear of the Printer" on page 329

077-104

077-106

077-108

077-109

077-304 Close the rear cover.

077-900 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Center Output Tray" on page 331

077-901 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Rear of the Printer" on page 329

091-402 The service life of your printer is coming to an end and the printer will soon stop 
running.

If you want to keep using the printer, change the Machine Life setting to Continue 
Print. However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 299

091-441 The printer has exceeded its service life or the settings have been changed to continue 
using it. The quality of printouts will degrade if the printer continues to be used.

See also: 
• "Machine Life" on page 299

Error Code What You Can Do
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092-310 Clean the CTD sensor.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 389

092-651 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

092-661

092-910 Clean the CTD sensor.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 389

093-423 Replace the specified toner cartridge soon. 

See also: 
• "Replacing Toner Cartridges" on page 390

093-424

093-425

093-426

093-919 Re-install or replace the specified toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 390

093-920

093-921

093-922

093-930 Remove the specified toner cartridge and install a new one. If you do not replace the 
toner cartridge, print quality problems may occur. 

See also: 
• "Replacing Toner Cartridges" on page 390

093-931

093-932

093-933

093-926 Replace the specified toner cartridge with the supported one. 

See also: 
• "Replacing Toner Cartridges" on page 390

093-960

093-961

093-962

093-970 Re-install the specified toner cartridge.

See also: 
• "Installing a Toner Cartridge" on page 393

093-971

093-972

093-973

Error Code What You Can Do
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NOTE: 

• As for the following message, which does not include an error code, refer to the table below for the solution.

116-210 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

116-314

116-323

116-325

116-326

116-335

116-355

116-395

117-331

117-332

117-333

117-334

117-342

117-346

117-348 Retry, and check the report. Turn off the printer, and then on. If this does not solve the 
problem, contact the Fuji Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

117-350 Open the rear cover and close to continue. If this does not solve the problem, contact 
the Fuji Xerox local representative office or an authorized dealer.

117-366 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 409

124-333

134-211

191-310 Although the service life of your printer has been over and the printer stopped running, 
you can still use the printer by pressing the  (Back) button and the  button at the 
same time. However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 299

191-311 The life of your printer has been over and you can no longer use the printer.

193-700 This message indicates the printer is in the Non-Genuine Mode.

Error Message What You Can Do

USB Memory Error
Cannot Mount File System
Remove from USB Port

Remove the USB memory device and check if it is usable. Press the 
 button to clear the message.

Error Code What You Can Do
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Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the 
error message on the LCD panel.

You need to know the model of your printer and serial number. See the label on the rear cover of your 
printer.
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Getting Help

This section includes:

• "LCD Panel Messages" on page 376

• "SimpleMonitor Alerts (Windows Only)" on page 376

• "Obtaining the Product Information" on page 377

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 366

SimpleMonitor Alerts (Windows Only)
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks 
the printer status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

The following procedure uses the Windows print driver as an example.

NOTE: 

• The communication fee shall be borne by users. 

1 In your print driver's Properties window, click the Configuration tab and then click About.

2 Click Fuji Xerox Web Site. 

Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 

• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/

• For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.

The latest firmware and updating tool can be downloaded from the following URL.

Follow the instructions on the web site and download the correct firmware update.

http://www.fujixeroxprinters.com/

NOTE: 

• The communication fee shall be borne by users.
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Non-Genuine Mode

When toner within a toner cartridge is empty, the XXXX Cartridge is Close to Life or 
Replace XXXX Cartridge (XXXX: Yellow, Magenta, Cyan, or Black) message appears.

When you want to use the printer in the Non-Genuine Mode, enable the Non-Genuine Mode and 
replace the toner cartridge.

IMPORTANT: 

• If you use the printer in the Non-Genuine Mode, the performance of the printer may not be at its optimum. Any 
problems that may arise from the use of the Non-Genuine Mode are not covered by our quality guarantee. 
The continuous use of the Non-Genuine Mode can also cause the printer to break down, and any repair 
charges for such break down will be incurred by users.

NOTE: 

• To disable the Non-Genuine Mode, select Off for Non-Genuine Mode on the operator panel or deselect the 
check box next to On on the Non-Genuine Mode page on the Printer Maintenance tab in the Printer Setting 
Utility.

Using the Operator Panel

NOTE: 

• Before starting the operation described below, confirm that the Select Function screen is displayed on the 
LCD panel.

1 Press the System button.

2 Select Admin Menu and then press the  button.

3 Select Maintenance and then press the  button.

4 Select Non-Genuine Mode and then press the  button.

5 Select On and then press the  button.

6 Press the  button until the top page is displayed.

The printer switches to the Non-Genuine Mode.
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Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your 
computer. In this case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Non-Genuine Mode from the list at the left side of the page.

The Non-Genuine Mode page is displayed.

4 Select the check box next to On, and then click the Apply New Settings button.
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Maintenance

This chapter includes:

• "Cleaning the Printer" on page 382

• "Replacing Toner Cartridges" on page 390

• "Ordering Supplies" on page 395

• "Storing Consumables" on page 397

• "Managing the Printer" on page 398

• "Conserving Supplies" on page 401

• "Checking Page Counts" on page 402

• "Moving the Printer" on page 403
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Cleaning the Printer

This section describes how to clean the printer in order to maintain it in good condition and print clean 
printouts all the time.

This section includes:

• "Cleaning the Scanner" on page 383

• "Cleaning the ADF Feed Roller (DocuPrint CM215 f/CM215 fw Only)" on page 385

• "Cleaning Inside the Printer" on page 386

• "Cleaning the Color Toner Density (CTD) Sensor" on page 389

WARNING:

• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 
materials may result in poor performance of the product. Never use aerosol cleaners to avoid 
catching fire and explosion.

CAUTION:

• When cleaning this product, always switch off and unplug it. Access to a live machine interior may 
cause electric shock.
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Cleaning the Scanner
Keep the scanner clean to ensure the best possible copies. Clean the scanner at the start of each day 
and during the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.

3 For the DocuPrint CM215 f/CM215 fw, wipe the surface of the document glass and ADF glass 
until they are clean and dry.

For the DocuPrint CM215 b, wipe the surface of the document glass until it is clean and dry.

1* Film

2 White Document Cover

3 Document Glass

4* ADF Glass

*: Available only on the DocuPrint CM215 f/CM215 fw.

1*

2

3

4*
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4 For the DocuPrint CM215 f/CM215 fw, wipe the underside of the white document cover and film 
until they are clean and dry.

For the DocuPrint CM215 b, wipe the underside of the white document cover until it is clean and 
dry.

5 Close the document cover.
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Cleaning the ADF Feed Roller (DocuPrint CM215 f/CM215 
fw Only)

Keep the ADF feed roller clean to ensure the best possible copies. Clean the ADF feed roller at 
regular intervals.

1 Open the ADF cover.

2 Wipe the ADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the ADF feed roller gets soiled with ink stains, paper from the ADF may also be soiled. In this 
case, slightly dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and 
then remove the contamination from the ADF feed roller until it is clean and dry.
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Cleaning Inside the Printer

1 Turn off the printer and disconnect the power cord.

2 Open the toner access cover.

3 Pinch the toner cartridge firmly as shown in the illustration.

4 Pull the toner cartridge out.

IMPORTANT: 

• Always pull the toner cartridge out slowly so you do not spill any toner. 

5 Pull the other three toner cartridges out as well.
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6 Pull the print head cleaning rod out.

7 Insert the print head cleaning rod fully into the hole beside the arrow on the printer until its tip 
reaches the interior of the printer as illustrated below, and then pull it out.

8 Repeat the same procedure for the other three holes.

9 Insert the print head cleaning rod back to its original location.
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10 Replace the black toner cartridge by adjusting it to the associated cartridge holder, and then 
insert it firmly by pressing near the center of the label until the toner cartridge clicks.

11 Replace the other three toner cartridges as well.

12 Close the toner access cover.
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Cleaning the Color Toner Density (CTD) Sensor
Clean the CTD sensor only when an alert for the CTD sensor is shown on the Printer Status window 
or operator panel.

1 Turn off the printer and disconnect the power cord.

2 Push the rear cover handle and open the rear cover.

3 Clean the CTD sensor inside the printer with a clean dry cotton swab.

4 Close the rear cover.

5 Connect the power cord and turn on the printer.
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Replacing Toner Cartridges

Fuji Xerox toner cartridges are available only through Fuji Xerox.

It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using consumables not supplied by Fuji Xerox.

IMPORTANT: 

• Do not shake the used toner cartridge to avoid spilling of the toner.

• Be sure to use the starter toner cartridge shipped with the printer until it gets empty, and then replace it with a 
purchased one.

This section includes:

• "Overview" on page 391

• "Removing the Toner Cartridges" on page 392

• "Installing a Toner Cartridge" on page 393

WARNING:

• Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge or 
toner bottle.
It may catch fire by electric sparks inside a vacuum cleaner and cause explosion.
Use a broom or a wet cloth to wipe off the spills.  If you spill a large volume of toner, contact your 
local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:

• Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water and 
consult a physician immediately.

• When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not 
to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well 
as inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. 
If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).

When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

IMPORTANT: 

• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 
cartridge to catch any toner that may spill.

• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.

• Do not shake or pound the used toner cartridges. The remaining toner may spill.

• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Message (Example) Action

093-426 Printer

Black Cartridge

is Close to Life*

The specified toner cartridge has become low. Prepare a new one.

The error code differs depending on the color of the toner cartridge.

• 093-426: Black

• 093-425: Cyan

• 093-424: Magenta

• 093-423: Yellow

Replace Cart.

093-933 Printer

Replace

Black Cartridge

The specified toner cartridge has become empty. Replace the old toner 
cartridge with a new one.

The error code differs depending on the color of the toner cartridge.

• 093-933: Black

• 093-932: Cyan

• 093-931: Magenta

• 093-930: Yellow

*: This warning appears only when Fuji Xerox toner cartridges are used (Non-Genuine Mode is set to 
Off.)
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Removing the Toner Cartridges

1 Turn off the printer.

2 Open the toner access cover.

3 Spread a few sheets of paper on the floor or table where the removed toner cartridge is to be 
placed.

4 Pinch the toner cartridge firmly as shown in the illustration.

5 Pull the toner cartridge out.

IMPORTANT: 

• Always pull the toner cartridge out slowly so you do not spill any toner.

6 Place the toner cartridge slowly on the sheets of paper spread in step 3.
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 Installing a Toner Cartridge

1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the 
toner evenly.

NOTE: 

• Confirm that the color of the new toner cartridge matches that on the handle before replacing it.

• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Remove the tape from the toner cartridge.

3 Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing 
near the center of the label until the toner cartridge clicks.
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4 Close the toner access cover.

5 Turn on the printer.

6 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

7 Take care not to contact with the spilled toner and remove the sheets of paper spread under the 
removed toner cartridge.
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Ordering Supplies

This section includes:

• "Consumables" on page 395

• "When to Order Toner Cartridges" on page 396

• "Recycling Supplies" on page 396

The toner cartridges need to be ordered occasionally. Each toner cartridge includes installation 
instructions on the box.

Consumables

IMPORTANT: 

• Use of consumables not recommended by Fuji Xerox can impair machine quality and performance. Use only 
consumables recommended by Fuji Xerox.

• Average standard pages. Declared yield in accordance with JIS X6932 (ISO/IEC 19798). These values are 
estimates and vary depending on conditions such as the content being printed, paper size, paper type, the 
machine’s operating environment, initializing process done when you turn on or off the printer, and 
adjustments to maintain print quality.

NOTE: 

• The printable number of pages for the starter toner cartridges shipped with the printer are approximately 1000 
pages for black toner cartridge and 700 pages for yellow, magenta, and cyan toner cartridges.

• Each toner cartridge includes installation instructions on the box.

Product Name Product Code Printable number of pages

Toner Cartridge [Black] High capacity CT201591

CT201595 (for China)

Approx. 2000 pages

Toner Cartridge [Yellow] Standard capacity CT202133

CT202136 (for China)

Approx. 700 pages

Toner Cartridge [Yellow] High capacity CT201594

CT201598 (for China)

Approx. 1400 pages

Toner Cartridge [Magenta] Standard capacity CT202132

CT202135 (for China)

Approx. 700 pages

Toner Cartridge [Magenta] High capacity CT201593

CT201597 (for China)

Approx. 1400 pages

Toner Cartridge [Cyan] Standard capacity CT202131

CT202134 (for China)

Approx. 700 pages

Toner Cartridge [Cyan] High capacity CT201592

CT201596 (for China)

Approx. 1400 pages
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When to Order Toner Cartridges
The LCD panel displays a warning when the toner cartridge nears its replacement time. Verify that you 
have replacements on hand. It is important to order a toner cartridge when the messages first appear 
to avoid interruptions to your printing. The LCD panel displays an error message when the toner 
cartridge must be replaced.

To order toner cartridges, contact the Fuji Xerox local representative office or an authorized dealer.

IMPORTANT: 

• This printer is designed to provide the most stable performance and print quality when used with the 
recommended toner cartridges. Not using toner cartridges recommended for this machine degrades the 
performance and printing quality of the printer. You could also incur charges if the machine breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use recommended 
toner cartridges.

Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges and drums (photoreceptors) to make recycle parts, recycle materials or energy 
recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. 
Return them to your local Fuji Xerox representative.
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Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 40 °C (140 °F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• An environment with salty air.
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Managing the Printer

This section includes:

• "Checking or Managing the Printer with the CentreWare Internet Services (DocuPrint CM215 
f/CM215 fw Only)" on page 398

• "Checking Printer Status with the SimpleMonitor (Windows Only)" on page 399

• "Checking Printer Status Through E-mail (DocuPrint CM215 f/CM215 fw Only)" on page 400

Checking or Managing the Printer with the CentreWare 
Internet Services (DocuPrint CM215 f/CM215 fw Only)

When the printer is installed in a TCP/IP environment, you can check printer status and configure 
settings using a web browser on a network computer. You can also use the CentreWare Internet 
Services to check the remaining volume of consumables and the paper loaded in this printer.

NOTE: 

• When using the printer as a local printer, you cannot use the CentreWare Internet Services. For details about 
checking the status of a local printer, refer to "Checking Printer Status with the SimpleMonitor (Windows 
Only)" on page 399.

Starting the CentreWare Internet Services
Use the following procedure to start the CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The CentreWare Internet Services page appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services page, click the 
Help button to display the online Help.
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Checking Printer Status with the SimpleMonitor 
(Windows Only)

The SimpleMonitor is a tool that is installed with your print driver. It automatically checks the printer 
status when you send a print job. The SimpleMonitor can also check the status of the tray and 
remaining amount of toner cartridges.

Starting The SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Printer 
Selection.

If the SimpleMonitor icon is not displayed on the taskbar, open the SimpleMonitor from the start menu.

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
your printer → SimpleMonitor-Btype for Asia-Pacific.

The Printer Selection window appears.

2 Click the name of the desired printer from the list.

The Printer Status Window appears.

For details about the functions of the SimpleMonitor, refer to the Help of the SimpleMonitor.

See also: 
• "SimpleMonitor (Windows Only)" on page 59
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Checking Printer Status Through E-mail (DocuPrint 
CM215 f/CM215 fw Only)

When connected in a network environment where sending and receiving of e-mail is possible, the 
printer can send an e-mail report to specified e-mail addresses containing the error status which has 
occurred on the printer.

Setting the E-mail Environment
Activate the CentreWare Internet Services. On the Properties tab, configure the following settings 
according to your e-mail environment. After configuring the settings on each screen, always click 
Apply and then turn off/on the printer to reboot. For details about each item, refer to the Help on the 
CentreWare Internet Services.

Item Item to be configured Description

General Setup > 
StatusMessenger

Recipient's E-mail 
Address 1

Recipient's E-mail 
Address 2

Set the e-mail address to which notices about 
errors are sent.

Notification Items Set the contents of the notices to send in the e-mail.

Port Status StatusMessenger Select Enabled.

Protocol Settings > 
E-mail

SMTP Server Settings

• Machine's E-mail 
Address

• SMTP Server Address

• SMTP Server Port 
Number

Send Authentication

• E-mail Send 
Authentication

• Login Name

• Password

• Re-enter Password

POP3 Server Settings

• POP3 Server Address

• POP3 Server Port 
Number

• Login Name

• Password

• Re-enter Password

Select appropriate settings for sending and 
receiving e-mail.
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Conserving Supplies

You can change several settings in your print driver to conserve toner cartridge and paper.

Supply Setting Function

Toner cartridge Windows print driver:

Toner Saving Mode in 
the Graphics tab

Mac OS X print driver:

Toner Saving Mode on 
Feature Sets: Detailed 
Settings in the Printer 
Features pane

This feature allows the users to select a print mode that 
uses less toner. When this feature is used, the image 
quality will be lower than when it is not used.

Print media Windows print driver:

Multiple Up in the Layout 
tab

Mac OS X print driver:

Pages per Sheet in the 
Layout pane

The printer prints two or more pages on one side of a 
sheet. The available numbers that each print driver can 
print one sheet of paper are as follows:

• Windows print driver: 2, 4, 8, or 16 pages

• Mac OS X print driver: 2, 4, 6, 9, or 16 pages

Combined with the duplex setting, Pages per Sheet 
allows you to print up to 32 pages on one sheet of 
paper. (16 images on the front and 16 on the back)

Combined with the duplex setting, feature allows you to 
print up to 32 pages on one sheet of paper. (16 images 
on the front and 16 on the back)
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Checking Page Counts

The total number of printed pages can be checked at the operator panel. Three meters are available: 
Meter 1 (color prints), Meter 2 (monochrome prints), and Meter 4 (Meter 1 + Meter 2). Meter 
3 always shows 0 on your printer.

The Meter Readings counts the number of pages printed properly. Single side print (including 
Multiple Up) is counted as one page, and 2-sided print (including Multiple Up) is counted as two. 
During 2-sided printing, if an error occurs after one side is printed properly, it is counted as one page.

When printing color data, which has been converted by using ICC profile on an application, with the 
Color setting, the data is printed by color even if it seems to be black and white data on the monitor. In 
that case, Meter 1 and Meter 4 are increased.

When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of 
the application. In this case, the blank page is counted as one page. However, when doing 2-sided 
printing for odd number of pages, the blank page inserted to the rear side of the last odd page is not 
counted.

See also: 
• "Meter Readings" on page 275

Use the following procedure to check a meter:

1 Press the System button.

2 Select Meter Readings, and then press the  button.

3 Check the values for each meter.
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Moving the Printer

1 Turn off the printer.

2 For the DocuPrint CM215 f/CM215 fw, disconnect the power cord, interface cable, and any other 
cables.

For the DocuPrint CM215 b, disconnect the power cord and USB cable, and go to step 4.

3 Remove any paper in the document output tray.
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4 Remove any paper in the center output tray if there is. Close the output tray extension if it is 
extended.

5 Remove any paper in the priority sheet inserter (PSI) or multipurpose feeder (MPF). Keep the 
paper wrapped and away from humidity and dirt.

6 Push the PSI in.
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7 Slide the slide bar backward until it stops.

8 Close the front cover.

9 Lift the printer and move it gently.

10 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 354
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Contacting Fuji Xerox

This chapter includes:

• "Technical Support" on page 408

• "Online Services" on page 409
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Technical Support

Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and email support. If unsuccessful, to obtain service 
under product warranty the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of Fuji Xerox supplied products, replacement of customer replaceable units, clearing 
paper misfeeds and cleaning the unit and other prescribed routine and preventative maintenance.

If the Customer’s product contains features that enable Fuji Xerox or its authorized service 
representative to diagnose and repair problems with the product remotely, Fuji Xerox may request that 
the Customer allow such remote access to the product.
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Online Services

You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our website at http://www.fujixerox.com/support/docuprint/

Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/
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